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Working with Actuate BIRT Viewers provides users with information about using
Actuate BIRT Viewer and Actuate BIRT Interactive Viewer. This document
explains how to generate, view, and customize reports.

m  About Working with Actuate BIRT Viewers. This chapter provides an overview of
this document.

m  Part 1. Using Actuate BIRT Viewers. This part contains information about using
Actuate BIRT Viewer and Actuate BIRT Interactive Viewer.

m  Chapter 1. Introducing Actuate BIRT Viewers. This chapter introduces the
viewing environments for BIRT reports, and lists the modification capabilities
each environment provides. The chapter also compares Actuate BIRT Viewer
and Actuate BIRT Interactive Viewer.

m  Chapter 2. Navigating a report. This chapter describes how you can begin
working with reports by navigating a report page using the paging tool. The
chapter also explains how to use a table of contents, display parameter values,
work with hyperlinks, save a report, and print a report.

m  Chapter 3. Editing and formatting a report. This chapter describes the formatting
options in Interactive Viewer: formatting data columns and static text,
formatting various types of data, and applying conditional formatting.

n  Chapter 4. Exporting report data and content. This chapter describes the
exporting options in Interactive Viewer: exporting report data to various
flat-file formats, and exporting report content to various formats such as AFP,
Word, PowerPoint, Excel, Postscript, PDF or Extensible HTML.

m  Chapter 5. Organizing data in a report. This chapter discusses the functionality
Interactive Viewer provides for organizing data, such as sorting data, moving
columns, removing duplicate values, creating data groups, and so on. The
chapter also describes how you can perform aggregate calculations, and set
page breaks in a report.
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m  Chapter 6. Performing calculations in a report. This chapter describes how you
can insert calculated columns in a report and explains how to write
expressions to create calculations.

m  Chapter 7. Filtering report data. This chapter discusses how you can use
Interactive Viewer to specify viewing parameter values, and create filters for
data in a report.

m  Chapter 8. Modifying charts. This chapter describes the types of charts in a
report and explains how you can modify them using Interactive Viewer. The
chapter provides procedures for changing the subtype and formatting of a
chart, and also explains how to drill up and down through data hierarchies,
drill-through hyperlinks, and switch views between a chart and table or cross
tab view of data. The chapter also describes Flash charts and Flash gadgets
and explains how you can modify them.

m  Chapter 9. Modifying cross tabs. This chapter describes cross tabs and explains
how you can use Interactive Viewer to modify the formatting properties of
data in a cross tab. The chapter also describes how you can analyze cross-tab
data, modify charts in a cross tab, and export, print, and save a cross tab.

m  Chapter 10. Modifying summary tables. This chapter describes summary tables,
and explains how you can use Interactive Viewer to modify data in a
summary table. The chapter also describes modifying a chart in a summary
table, and saving a summary table.

m  Chapter 11. Functions and operators. This chapter is a reference for all the
functions available in Interactive Viewer. The chapter also describes the
operators you can use when creating expressions for calculations.

m  Part 2. Actuate BIRT Viewer Reference. This part contains information about
configuring the Actuate BIRT viewers and accessing a BIRT viewer using a
URL

m  Chapter 12. Configuring Actuate BIRT Viewer. This chapter describes how to
configure the Actuate BIRT viewers.

m  Chapter 13. Actuate BIRT Viewer URIs. This chapter describes how to access a
BIRT viewer using a URIL
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Introducing
Actuate BIRT Viewers

This chapter contains the following topics:

m Introduction to the viewing environments
m Using Actuate BIRT Viewer

m Using Interactive Viewer

m Comparing the viewers
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Introduction to the viewing environments

You can view BIRT (Business Intelligence Reporting Tools) reports using two
web-based viewing environments - Actuate BIRT Viewer and Actuate BIRT
Interactive Viewer. In this document, the term viewers, refers to both Actuate
BIRT Viewer and Actuate BIRT Interactive Viewer (Interactive Viewer). A report
is a category of documents that presents formatted and structured content from
one or more data sources, such as a database, a spreadsheet, or a text file.

Figure 1-1 shows a simple listing report displaying credit limit information for
customers, sorted by country.

/Report column label Report column

gme  City  Zip Code Credit Limit

= Australia
Australian Collectars, Co Ferguson Peter Melbourne 3004 117300
Anna's Decorations, Ltd O'Hara Anna Marth Sydney 2060 107300
Souveniers And Things Co Huxley Adrian Chatswood 2067 93300
Australian Gift Metwork, Co Calaghan Ben South Brisbhane 4101 51600
Australian Collectables, Ltd Clenahan Sean Glen WWaverly 3150 BO300

= Austria
Salzburg Collectables Pipps Georg Salzhury 5020 71700
Mini Auto YWerke Wendel Roland Graz go10 45300

= Belgium
Petit Auto Dewey Catherine Bruxelles B-1180 79900
Royale Belge Cartrain Pascale Charleroi B-5000 23500

Figure 1-1 An example report

This section describes the viewers and highlights the capabilities and functions of
Actuate BIRT Viewer and Interactive Viewer. You use the viewers to navigate a
report, print report data, and export the report and report data to several other
formats. In addition, Interactive Viewer as its name suggests, provides a high
degree of interactivity. Users can easily modify the layout and formatting of
reports, organize report data by sorting, filtering and grouping, perform
calculations and compute report data, and edit graphical representations of
report data by modifying charts in a report. In addition, you can modify cross
tabs, and summary tables in a report. You can then save the modified reports
using Interactive Viewer. Detailed information about performing each of these
tasks is available in later sections of this document. In cases where you do not see
a specific option that is described, upgrade to Interactive Viewer in order to
access additional functionality.

A BIRT report can consist of several report components. At the very least, a BIRT
report contains a table which holds data. In addition, a report can contain other
elements such as charts, Flash charts and gadgets, a cross tab or a summary table.
Working with each of these components is described in later sections of this
document.

Users working with BIRT dashboards to interact with gadgets such as report
gadgets, chart gadgets, Flash gadgets, cross-tab gadgets or summary-table
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gadgets can access most menu options described in this document by first
maximizing each gadget. For more information on working with dashboards, see
Building BIRT Dashboards.

Using Actuate BIRT Viewer

To begin using Actuate BIRT Viewer, you must first generate a report. The
primary interface in which you view the report is Actuate BIRT Viewer. You can
launch Actuate BIRT Viewer from any of the following applications:

m  Actuate Information Console

m Actuate BIRT iServer

m Actuate BIRT Studio

m  Actuate BIRT Designer Professional
m  Actuate Deployment Kit

The Actuate BIRT Viewer interface consists of a main toolbar with several icons
that include the main menu with options, and the page navigation tool. The report
itself occupies the remaining portion of the Viewer, as shown in Figure 1-2.

E- 14 [ |
Australia

Australian Collectors, Co.  Ferguson Peter 03 9520 4555
Anna's Decorations, Ltd O'Hara Anna 02 9936 5555
Souveniers And Things +51 2 9495
Co. Huxley Adrian 8555

Australian Gift Metwork,
Co Calaghan BenB1-7-3844-6555

Australian Collectables,
Ltd  Clenahan SeanB61-9-3844-6555

Austria
Salzburg Collectables Pipps Geory B5E2-9555
Mini Auto Werke  Mendel Roland 7E75-3555
Figure 1-2 Viewing a report in Actuate BIRT Viewer

You use Actuate BIRT Viewer to perform the following tasks:
m View the table of contents

m Navigate pages in a multipage report

m Export data to several flat-file formats

m  Export content to AFP, Excel, Postscript, PDF, Word, PowerPoint, or Extensible
HTML formats

m Link to the report page
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m Print reports

m Show or Hide report margins in the browser

m Specify viewing parameters

m Drill through hyperlinks in a report to view data in other reports

m Drill up and down hierarchical data to view summary or detail information

Using Interactive Viewer

This section describes the additional functions available using Interactive Viewer.
Interactive Viewer provides users with complete access to the features available
in Actuate BIRT Viewer. In addition, Interactive Viewer enables users to easily
customize reports based on individual needs and preferences. Using Interactive
Viewer, users can modify the layout of the report, compute data, move or delete
columns, create aggregate data, modify tables displaying summary information,
modify charts and graphs, modify data in cross tabs, and rearrange data using
simple menu options. You can view and modify a report containing up to 200
pages in Interactive Viewer.

When you purchase the Actuate viewers, you have immediate access to Actuate
BIRT Viewer. To access Interactive Viewer, your system administrator must
enable this option on your system, for which you must purchase the Interactive
Viewer license from Actuate Corporation.

To view a BIRT report in Interactive Viewer, first view the report using Actuate
BIRT Viewer. From the main menu, choose Enable Interactivity to launch
Interactive Viewer.

(i The change in the name of the viewing pane to Actuate Interactive Viewer
indicates that you are in Interactive Viewer mode. Also, notice the appearance of
the undo and redo buttons on the Viewer toolbar, as shown in Figure 1-3.

Undo
Redo

1}
4

114 | ey

-l Awustralia

Australian Collectors, Co. Ferguson Peter 03 9520 4555

Anna's Decorations, Ltd O'Hara Anna 02 9936 8555
Souveniers And Things Co. Huxley Adnan +51 2 9495 8555
Australian Gift Metwork, Co Calaghan Ben  B1-7-3844-6555
Australian Collectables, Lid Clenahan Sean  61-9-3844-6555
Figure 1-3 Viewing a report in Interactive Viewer
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When you choose Disable Interactivity from the main menu, the undo and redo
buttons disappear, and the name of the viewing pane changes to Actuate Viewer.

After launching Interactive Viewer, you can select any column in the report to
highlight it. Notice the appearance of a toolbar on the top of the selected column
providing a column menu, sort, and filter buttons, as shown in Figure 1-4.

=~ it 47
Figure 1-4 Column toolbar

To modify the column, select the column menu, then choose an option from the
menu that appears. You can also display the options that appear in the column
menu by right-clicking the selected column to display a context menu. This
document uses the context menu to select modification options. The example
shown in Figure 1-5 displays a typical context menu.

Header 3
Group 3

Colurnn 3

|:| Aggregation
Filter ]
Sort 3
Alignment »

Format 3

E Export Content

Figure 1-5 Column menu

You can use Interactive Viewer to perform the following additional tasks:
m»  Undo and redo the most recent action

m  Modify font properties of report data and report elements

m  Apply conditional formatting and format data strings

m Sort, group, and filter report data

m Perform calculations and compute data

m  Modify graphs and charts

m  Modify Flash charts and Flash gadgets

m Rearrange, move, hide, and delete columns

m Create aggregate data

m Add page breaks in a multipage report

m  Save a modified BIRT report design or document file

m  Modify cross tabs and analyze cross-tab data in Actuate BIRT Data Analyzer
m  Modify summary tables
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More information about using Actuate BIRT Viewer and Interactive Viewer is
available in later sections of this document.

Comparing the viewers

In this section, Table 1-1 compares tasks you can perform using the viewers and
highlights tasks you can exclusively perform using Interactive Viewer.

Table 1-1 Comparing the Actuate BIRT Viewers

Actuate BIRT Interactive
Task Viewer Viewer

\

Add computed columns

Add page breaks in a report

Apply conditions and format data strings
Create aggregate data in a report table
Display the table of contents

Display viewing parameters

Export content

NN NS

Export data

Hide or show report items

\

Link to the report page

Modify charts and graphs

Modify cross tabs

Modify Flash charts and gadgets
Modify summary tables

Modify text attributes and alignment

SN NSNS SSSNSNSSAANS

Move, hide, show, and delete report
columns

Navigate a multipage report 4
Print a report 4
Save a modified report

Save a BIRT report design

Sort, group, and filter report data

Undo and redo tasks

Use hyperlinks present in the report v

NSNS SN
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Table 1-1 Comparing the Actuate BIRT Viewers

Actuate BIRT Interactive

Task Viewer Viewer
View Flash charts and gadgets 4 4
View summary tables v v
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Navigating a report

This chapter contains the following topics:

m About navigation options

m Paging through a report

m  Opening the table of contents
m Displaying parameter values
m Displaying margins

m  Working with hyperlinks

m Saving a report

m Printing a report

Chapter 2, Navigating a report
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About navigation options

The previous section introduced the viewers, and described the tasks you can
perform using them. You can use Actuate BIRT Viewer to open and view the table
of contents, navigate to specific sections in the report using the table of contents,
view each page of the report, go directly to a specific page, and specify parameter
values to view specific content in large reports. You can also obtain a unique URL
for the report to link to it from other documents. In addition to these navigation
options, you can use Interactive Viewer to save a modified report, and print
reports. The following section describes how to navigate a generated report in the
viewers, to enable you to modify or customize the report.

Paging through a report

The viewer toolbar consists of a main menu with additional options and a page

navigation tool, as shown in Figure 2-1. You can view pages in a multipage report
using the paging tool. The tool consists of a set of arrows that enable users to view
the first or last page in a report, and to move forward or backward, page by page,

through the report.
Main menu
Page number
= 1] 4 > ]
Last page
Next page
Previous page
First page
Figure 2-1 Actuate BIRT Viewer toolbar

To navigate directly to a specific page type the page number in the Page number
field, then press Enter. In Actuate 11 and later releases, Actuate BIRT Viewer
supports progressive viewing for multipage reports. The progressive viewing
feature provides efficiency by enabling users to view each page of the report as it
is generated, without requiring the user to wait until the entire report is
generated.

Opening the table of contents

A table of contents can be defined as a list of sections, that provides you with
information about where each section begins. In the viewers, you can open a table
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of contents to view the report structure and navigate to specific sections of the
report. To view the table of contents, choose TOC from the main menu. If the
report contains a table of contents, the TOC panel displaying the entries appears
on the left of the Viewer, as shown in Figure 2-2.

E- 114 > )
TOC »
" Austalc = couy  Customer ContactName|
& Austria -l Australia
. Australian Collectors, Co. Ferguson Peter
° Belgium Anna's Decarations, Ltd O'Hara Anna
o d Souveniers And Things Co. Huxley Adrian
anaca Australian Gift Network, Co Calaghan Ben
= Denmark Australian Collectables, Ltd Clenahan Sean
) =l Austria
° Finland Salzbury Collectables Pipps Georg
o France Mini Auto Werke Mendel Roland
- Belgium
° Germany Petit Auto Dewey Cathering
Figure 2-2 Displaying the table of contents

Because each entry in the table of contents is a link to a section in the report,
selecting an entry in the table of contents displays the related section in the report.
If you have a multipage report containing sections and subsections, you can
expand the entries in the table of contents panel to navigate directly to the
appropriate subsection.

To close the table of contents, choose Close from the top corner of the TOC panel.

Displaying parameter values

A parameter value is a way of limiting the report data retrieved when you run a
report. For example, in a report that displays customer information, you can use
parameter values to display sales history for a specific customer, or view the
details of specific orders. If a report requires you to enter parameter values, you
are prompted to type the value when you generate the report. Specifying
parameter values enables you to navigate a report more effectively, and display
only the information you need.

If the report requires you to enter parameter values to determine what data to
display, you can modify these values to view other data, by choosing Parameters
from the main menu. If you choose this option, and parameter values are not
needed, a message appears informing you that the report contains no parameters.
You learn more about using parameters later in this document.
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Displaying margins

The viewers also provide the option to display or hide margins for any report
design you are viewing. Selecting or deselecting this option displays or hides
margins in the browser window, and does not impact page margins when
printing a report design or exporting a report design to other formats.

To display a margin, select Show Margin from the main menu.

To hide a margin, select Hide Margin from the main menu.

Working with hyperlinks

If the report you are viewing contains hyperlinks, choose the link to view the
associated content. For example, in a report listing customers and their web sites,
choose a URL in the report to visit the corresponding web site. The content the
link references, opens in a new browser tab or window. If the hyperlink is
associated with an e-mail address, your default e-mail client opens a new
message window. The linked address, appears in the To field. For example, to
contact the customer, choose the e-mail address in the report to send the customer
an e-mail.

You can also use the Link To This Page option to share the currently viewed
report with other users. When you share the report, the viewer generates a link to
the report and makes this available to other designated users.

How to link to the current report page

Choose Link To This Page from the main menu. On Link To This Page, you can
either copy the absolute link and paste it in an e-mail, or instant messenger
window, or you can copy the HTML code, as shown in Figure 2-3, and paste it in
the required location. Choose OK to close the window.

Link To This Page x
Paste link in email or IM:
hittpf flocalhost: 5900 iportal/executereport.do? _locale=en_US&closex=trued_
Paste HTML ko embed in website:
<script bype="text{javascript’ language="lavaScript' sre="http: {flocalhast: 3900/
,
Figure 2-3 Linking to the current report
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Saving a report

Many of the tasks you can perform in Interactive Viewer, such as sorting data,
using conditional formatting, creating aggregate data, and inserting computed
columns, are similar to tasks a report developer performs in the report design
environment. Sometimes you need to modify the report and save it, so you can
use it later, or make it available for other users to view and modify.

In Interactive Viewer, you can save a modified report as a BIRT report design or a
BIRT report document file. To enable users to open the modified report in Actuate
BIRT Studio, or Actuate BIRT Designer Professional, and to provide them with
the ability to modify the report extensively, save the report as a BIRT report
design (.rptdesign) file. To enable users to open the modified report in the
viewers, and to limit the extent of the changes they can make to the report, save
the report as a BIRT report document (.rptdocument) file. You cannot open a
report document file using Actuate BIRT Studio or Actuate BIRT Designer
Professional. To edit a BIRT report document (.rptdocument) file in either report
design tool, you must first save the file as a BIRT report design (.rptdesign) file
using Interactive Viewer. The following section describes how to save a report
using Interactive Viewer.

How to save a BIRT report design

You can save a modified BIRT report design file, or BIRT report document file, as
a BIRT report design.

1 From the main menu, choose Enable Interactivity. You are now in Interactive
Viewer.

2 Choose Save Design from the main menu. Save displays the default location
where the report is saved, as shown in Figure 2-4. You have the following
options:

= You can choose to save the report in the default location, which is the user’s
home directory (/Home/username), where username is the name of the
user logged in to the application.

m Tosave the file in a different directory, select (/) to display a list of available
directories from the path in Choose a Folder. Navigate to a new location
from the path.

3 Choose a file name for the report design.

To overwrite an older version of the report, choose the file name from the
menu that appears.

To save the new report without overwriting an older version, type a new name
in File name.
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Save x

Choose a Folder:
| = Home

———Home folder

Customer Dashboard . rpkdesign
Custamer Order History. rptdesign
Monthly Revenue Analysis.rptdesign
MyCustomers. rpkdesign

Rewvenue History by Praduct Line. rpkdesign =
Sales by Territory. rpkdesign LI

|*

File name:

——Type a file name
Save as type:

BIRT report design {*.rptdesign) w | Choose a file type

g
Figure 2-4 Saving a BIRT report design

Choose OK. You save the report design as a BIRT report design (.rptdesign)
file. To verify that your report has been saved, start your application server
and navigate to the directory containing the report design file.

How to save a BIRT report document

1 From the main menu, choose Enable Interactivity, then choose Save
Document. Save displays the default location where the report is saved, as
shown in Figure 2-5. You have the following options:

2 You can save the file in the default location, which is the user’s home
directory (/Home/username), where username is the name of the user
logged in to the application.

®  You can save the file in a different directory. To save the file in a different
directory, select (/) to display a list of available directories from the path in
Choose a Folder. Navigate to a new location from the path.

2 Choose a file name for the report.

Save x

Choose a Folder:

! = Home

File name:

Save as bype:

Report document  {*,rptdocument) v

€
Figure 2-5 Saving a modified report
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To overwrite an older version of the report, choose the file name from the
menu that appears.

To save the new report without overwriting an older version, type a new name
in File name. Choose OK.

The report is saved as a BIRT report document (.rptdocument) file. To verify
that your report has been saved, start your application server and navigate to
the directory containing the report document file.

Printing a report

After viewing a report, you can print it in HTML or PDF format. In Interactive
Viewer, you can print either the original report or the modified report. You can
print a maximum of 200 pages.

How to print a report

1 From the main menu, choose Print.

2 On Print, complete the following tasks:
1 In Format, select HTML or PDF.

a

[

If you select HTML, the report is formatted for printing as a continuous
document in the browser window. Any page headers and footers
appear in the body of the document, often multiple times, depending
on how many pages the report contains. A multipage report does not
retain its pagination properties when you choose to print it in HTML
format.

If you select PDF, you can specify page style options for a multipage
report. Select a page format from the list, as shown in Figure 2-6.

a

[m]

Auto is the default option. When you choose Auto, Interactive
Viewer lays out the data such that the report content fits the width of
the PDF page. If the report uses headers and footers, each header
and footer are displayed in the appropriate location. Because the
content is optimized in terms of font, and space, a single page in the
report often displays on multiple pages in the PDF file. When you
use the Auto option, existing pagination properties in the report are
not retained in the PDF file, but the PDF output is paginated.

Choosing Actual Size retains existing pagination properties from the
original report. When you choose this option, the font size in the
printed report is often significantly smaller than in the original
report, to allow the content to fit within specified page boundaries.
After you send the document to a printer, further modify options on
the printer dialog box as needed, so that the printed report is legible.
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o Choosing Scale to page size retains the existing pagination
properties from the original report in the PDF output. Interactive
Viewer shrinks report content such as fonts, and images, to fit each
current report page on each page in the PDF output.

2 In Pages, indicate which pages to print. You can print all the pages in the
report, only the current page, or a specific set of pages. To print specific
pages, use commas to separate the page numbers. To print a range of
pages, enter the start and end page, separating the two entries with a
hyphen. To print from a specific page to the end of the document, enter the
start page followed by a hyphen.

Choose OK.

Print X

Format
(2 HTML
@ POF |Auko -
Auko

Actual size
Pages Scale ko page size

O al
@ Current page

) Pages:
(eq.1,3,5-12)
Print Limit: first 200 Pages.

)
Figure 2-6 Printing a report

3 Depending on your format selection in Print, you have the following options:

m If you selected HTML format, Print appears. Specify your printer options
on Print.

m If you selected PDF format, the report appears in your web browser using a
PDF viewer plug—in. You can preview the report, then choose Print to
specify printer options. Review the options on the printer dialog box to
make sure that the report content is legible.

Your report is sent to the printer you specify.
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Editing and formatting
a report

This chapter contains the following topics:

About editing and formatting options
Changing font properties and alignment
Formatting report data based on conditions
Formatting data strings

Reverting to default formats

Copying a format to other columns

Editing column and group headers

Chapter 3, Editing and formatting a report
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About editing and formatting options

Interactive Viewer provides you with the flexibility to modify the presentation
properties of reports. This section discusses the editing and formatting options
available to you.

How to select an element for formatting

In a report table, you can format column headers as well as data in the columns.
Select the element, then choose the formatting option from the menu that
appears.

Choose a column header to highlight it. To select data for formatting, select the
entire column by clicking in the column area. A box appears, highlighting the
selected element.

Formatting a column

You can use Interactive Viewer to define new font properties and change text
alignment for a selected report column, or for the report table. You can also
specify these style properties for one column, and copy the style to other
columns. You can highlight report data based on certain defined conditions and
format data strings depending on the type of data in a column. For example, you
can format data strings into currency, telephone number, postal code,
date-and-time, or decimal formats.

Formatting data in a merged column

Sometimes reports contain data that can be presented more effectively when you
merge one or more report columns. For example, a report listing customers and
their addresses is easier to read when the address, city, state, and postal code
items are merged to present this information in a single column. Interactive
Viewer does not allow you to merge columns, but you can modify data in existing
merged columns using Interactive Viewer. You can change font properties, create
conditional formatting rules, and format data in merged columns.

When working with a merged column, if you choose Format>Font, or
Format>Conditional Formatting, from the context menu, Select Data Item
appears, providing a list of data items, or columns, in the merged column, as
shown in Figure 3-1.

Select Data Item x

CITY |

2
Figure 3-1 Selecting a data item
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From the list, select a data item on which to perform an action. Choose OK.

You can now modify font properties, format data strings, and so on, for the
selected column, as described in the following sections of this document.

To modify all the data rows in the merged column, you must repeat this step for
each data item, and implement the change in format, font, and so on, each time.

Changing font properties and alignment

In Interactive Viewer, you can change the font properties and alignment of
editable labels, column headers, and data in a report column. The properties you
can modify include the font type, size, color, and background color. You can also
display the font in bold, italic, or underlined style. As you modify these
properties, you can view the appearance of the data in the column, in the Preview
field.

You can choose to apply these properties to a single column, the entire table, or
share the properties with a few other columns, without having to reapply the
style to each individual column.

How to change font properties

1 Select the item, such as table label, column header, or column to highlight it.
Choose Format>Font from the context menu. Font displays the current font
property values, as shown in Figure 3-2. A value of Auto indicates that the
default value is used.

Font x

Font: Size:

Arial v |8 ~

Background

Color:
Color:

BLACK B
Auto i

Bl|7]|u

1 Apply ko table
@ Apply to calumn

‘ AaBhCoyyiz |

O Cancel 2

Figure 3-2 Defining font properties

2 Use the drop-down lists to change the font properties for the selected element.
1 Select a font type and size.
2 GSelect a font color.

3 To set a color, complete the following steps:
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o Accept the default value of Auto, or select a different color in Basic
Colors, as shown in Figure 3-3.

Font
Fonk:

Caolor:
BLACE ¥

Arial il ¥

X
Size:

EBackground
Color:

M| st
Biasic Colors

‘# | Custom Colors

kel | 2

Figure 3-3

Selecting an available color

o Select Custom Colors, and use the spectrum bar to specify a color
group. Then, select a shade in the gradient square, and choose Pick
Color, as shown in Figure 3-4.

M| oo
Basic Colars
EEEEEEN
EEEAEEEN
EEEEEER
EEEEEEN
HEEE

‘3 | [Custom Colors

Rigy
G z04
EB: z04

# 33CCCC

N s |

Gradient selector
——Color preview box

—Red, green, blue values

——Hexadecimal value
——Spectrum bar

——Gradient box

Figure 3-4

Selecting a custom color

The RGB value of the selected color appears in Color.

4 To apply the selected properties to the entire report table, select Apply to

table.

5 To apply the selected properties to the selected column, select Apply to

column.
Choose OK.

How to change the alignment of text

In Interactive Viewer, select the table label, column header, or column to highlight
the element. From the context menu, choose Alignment, then choose Left, Center,

or Right.
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How to copy font and alignment properties to other columns

1 Select the column containing the font and alignment you want to apply to
another column. From the context menu, choose Format>Copy Style.

Copy Style appears, as shown in Figure 3-5.

Copy Style x

Counkry
Customer
Phone
City

Zip Code
Credit Limit

al—n

Figure 3-5 Sharing font and alignment properties with other columns

2 Select a column to which you want to copy the current font and alignment
properties. To select multiple columns, press Ctrl, then select each column.

Choose OK. The report displays the copied style properties in the specified
columns.

Formatting report data based on conditions

When you format data in a selected column, the format applies to all the values.
Often, it is useful to change the format of data when a certain condition is true.
For example, you can display sales numbers in red if the value is a negative
number and in black if the value is a positive number. Conditional formatting is
the formatting of data according to defined conditions.

You also can change the format of data in a column according to the values in
another column. For example, in a report showing customer names and the
number of days each customer’s invoice is past due, you can highlight in blue
any customer name that has an invoice past-due value between 60 and 90 days.
Then, you can highlight in red and bold any customer name that has an invoice
past-due value greater than 90 days.

To apply conditional formatting, you create a rule defining when and how to
change the appearance of data. You can apply conditional formats only to data in
columns. The rule consists of the condition that must be true, and the text
attributes to apply to column entries that satisfy the condition. You can define up
to three conditions or rules for a single column and remove or modify conditional
formatting for a column.
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You can also influence the formatting of one column based on values in another
column. For example, in a sales inventory report, when you apply conditional
formatting to the Product column, you can define the condition based on the
Quantity in Stock column, such that conditional formatting is applied to the
Product column if the quantity in stock is below a specified value. After you
create the condition, you define the format in which to display data that satisfies
the condition. The formatting appears on the selected column and not on the

column on which you based the condition.

How to set conditional formats

1 To define the condition, select the data column on which to display

conditional formatting. From the context menu, choose Format>Conditional
Formatting. Conditional Formatting appears, as shown in Figure 3-6. The
example shown in Figure 3-6, highlights all customers with a credit limit of
less than $100,000. The report in Figure 3-7 displays conditional formatting for
the data fields in the Credit Limit column that satisfy the defined conditions.

Conditional Formatting x Select formattin tion
Selected Colury/t CREDITLIMIT elect formatting options
Delete Rule
Format Previem I Preview of the selected format
Column Mame: CREDITLIMIT v
Condition: Less Than or Equal to ~ The condition to meet to apply
Value: 100000 Change Value the format
Add Rule
g
Figure 3-6 Defining conditional formatting
] Australia
Australian Collectors, Co. 117,300 Ferguson Peter
Anna's Decorations, Ltd $107 8O0 O'Hara Anna
Souveniers And Things Co. [INFEEE00 Huxley Adrian
Aunstralian Gift Metwaork, Co [IIIINFSETT Calaghan Ben
Australian Collectables, Ltd [GEHENT Clenahan Sean
] Austria
Salzburg Collectables G0 Pipps Georg
Mini Auto YWerke [ FAEE00 Mendel Raland
Figure 3-7 Customers with Credit limits below $100,000

On Conditional Formatting, create a rule specifying the following information,
then choose OK:

m  The format to apply, such as, bold style. Choose Format to select formatting
options.

m  The condition that must be true to apply the format, such as, Credit Limit
Less than or Equal to 100000. For more information about specifying a
condition, see “Specifying a condition,” later in this chapter.
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Specifying a format for the data

To define text attributes for the selected data column, complete the following
steps:

1 Choose Format>Conditional Formatting from the context menu. On
Conditional Formatting the Selected Column field contains the name of the
column that displays the conditional format.

2 Choose Format and select the text attributes to display for the Credit Limit
column. As you define the format, you can view how the data in the column
appears in the Preview field, as shown in Figure 3-8. Choose OK.

Font x
Font: Size:
Auta w | Buto v
Calor: Background Caolor:
Auto w | Auto v
B I u

| Preview |

,
Figure 3-8 Defining the format

Specifying a condition

The condition in a conditional formatting rule is an If expression that must
evaluate to true. For example:

If the order total is less than 1000

If the customer credit limit is between 100000 and 200000
If the sales office is Tokyo

If the order date is 7/2

1/2008

The Conditional Formatting dialog box helps you construct the If expression by
breaking it down into its logical parts. In Figure 3-6, the expression consists of
three parts. In Figure 3-9, the expression has four parts.

In Column Name, select a column. This column contains the value that
determines when conditional formatting takes effect. The column you select here
does not have to be the same as the column that you selected for formatting in the
report. For example, if Product Name is the column selected for formatting, you
can select Profit in this field to indicate that for a certain profit amount,
conditional formatting applies to the product name.
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Conditional Formatting x
Selected Column: CREDITLIMIT
Delete Rule

Format Previev

Colurmn Mame: CREDITLIMIT oA
Condition: Estween .
Walue! 100000 Chanoe Valug
Walue! 200000 Channe Value
Add Rule
,
Figure 3-9 Selecting data fields between two values

In Condition, select the comparison test, or operator, to apply to the column you
selected. You can select Equal to, Less than, Less than or Equal to, and so on. If
you select Is Null, Is Not Null, Is True, or Is False, the If expression does not
require additional information.

If you select an operator that requires a comparison to one or more values, one or
more additional fields appear. For example, if you select Less than or Equal to, a
third field appears. In this field, type the comparison value. If you select Between
or Not Between, a third and fourth field appear. In these fields, type the lower
and upper values, respectively, as shown in Figure 3-9.

Comparing to a literal value

The conditional expression shown in Figure 3-9 in the previous section evaluates
the Credit Limit column and compares each value to determine if it matches a
value between 100000 and 200000. The 100000 and 200000 values are literal values
that you type.

Alternatively, you can select a value from the list of values in the Credit Limit
column. Selecting from a list of values is useful if the comparison value is a
customer name and you do not know the exact customer names, or if the
comparison value is a date and you do not know the date format to type. If the
comparison value is a date, Interactive Viewer also provides a calendar tool,
which you can use to select a date.

How to select a comparison value from a list of values
1 On Conditional Formatting, choose Change Value, below the Condition field.

Select values appears. Choose Specify literal value, then select Select Values.
The values in the selected column appear. Figure 3-10 shows an example of the
values in the credit limit column.
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Select Values x

@) Specify literal value () Use value from data Field

Yalue: 100000 Select Values

° 2
11000

21000
23000
23500

34800 x|

’
Figure 3-10 Selecting Values

2 GSelect a value from the list, then choose OK. The value appears in the
comparison value field on Conditional Formatting.

Comparing to a value in another column

In a conditional expression, you can compare the values of one column with the
values of another column. For example, in a report that displays products, sales
prices, and MSRP (Manufacturer Suggested Retail Price), you can create a
conditional formatting rule that compares the sale price and MSRP of each
product, and highlight the names of the products whose sales price is greater than
MSRP.

How to compare to a value in another column
1 On Conditional Formatting, choose Change Value, below the Condition field.

2 On Select values, select Use value from data field. A list of columns used in the
report appears.

3 Select a column from the list, then choose OK. The column name appears in
the comparison value field on Conditional Formatting.

Figure 3-11 shows a condition that compares the sales price with the MSRP
value. If the sale price value is greater, the product name displays in bold.

Conditional Formatting x
Selected Colurmn: Price of each
Delete Rule
Farmat Presviess
Column Marne: Price of sach .
Condition: Greater Than ar Equal ko e
Yalue: [MSRP] Change Yalue
Add Rule
,
Figure 3-11 Comparing data to a value in another column
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You can now define up to two additional rules for the report column on
Conditional Formatting. Choose OK. Figure 3-12 shows the conditional
formatting applied to the report column.

Product Price List
Product Line Product Name Sale Price
- B
1945 Porsche 356-A Roadster $66.99 $69.30
1948 Porsche 356-A Roadster $73.15 $69.30
1948 Porsche 356-A Roadster $70.54 $69.30
1948 Porsche 356-A Roadster $70.84 $69.30
1948 Porsche 356-A Roadster $70.84 $69.30
1948 Porsche 356-A Roadster $73.92 $69.30
1948 Porsche 356-A Roadster $66.22 $69.30
1945 Porsche 356-A Roadster $62.57 $69.30
1948 Porsche 356-A Roadster $73.15 $69.30
1948 Porsche 356-A Roadster $64 .65 $69.30
1948 Porsche 356-A Roadster $72.38 $69.30
1948 Porsche 356-A Roadster $67.76 $69.30
1948 Porsche 356-A Roadster $77.00 $69.30
1948 Porsche 356-A Roadster $70.07 $69.30
1948 Porsche 356-A Roadster $71.61 $69.30
1945 Porsche 356-A Roadster $61.60 $69.30
1948 Porsche 356-A Roadster $67.76 $69.30
1948 Porsche 356-A Roadster $63.14 $69.30
1948 Porsche 356-A Roadster $76.23 $69.30
1948 Porsche 356-A Roadster $61.60 $69.30
1948 Porsche 356-A Roadster $67.76 $69.30
1948 Porsche 356-A Roadster $70.07 $69.30

Figure 3-12 Report displaying conditional formatting

Specifying multiple conditional formatting rules

IZE’I You can create up to three conditional formatting rules for a single column. You
can, for example, create three rules to set the values of a profit column to one of
three colors, depending on its value. Figure 3-13 shows this example.

Product Profitability Analysis
Product
Classic Cars

1945 Porsche 356-A Roadster $1,541.84

1945 Porsche 356-4A Roadster $3,187.80

1948 Porsche 356-4 Roadster $2,735.04

1948 Porsche Type 356 Roadster $5,658.30 $z2,861.10
1948 Porsche Type 356 Roadster $3,676.60 $2,136.12
1949 Jaguar %K 120 £3,971 .15 £1,797 68
1949 Jaguar %K 120 $2,235,30

1952 Alpine Renault 1300 £6,214,70 3,355,858
1952 Alpine Renault 1300 $4,140,23 $1,672.89
1952 Alpine Renault 1300 $7,995 41 $3,953.63
1952 Alpine Renault 1300 §7,200 40 $3,757.20
1952 Citroen-15CW $2,593.02

1956 Porsche 3564 Coupe $z,642.34

1956 Porsche 3564 Coupe $5,055.30

1956 Porsche 3564 Coupe $3,576.12 $1,022.32
1957 Corvette Convertible $5,785.44 $2428.80
1957 Corvette Convertible $2,499.80 $1,101.20

Figure 3-13 A report with multiple conditional formatting rules

For each row of data in the report, Interactive Viewer evaluates the rules in the
order in which they appear in the list of rules. As it evaluates each rule,
Interactive Viewer applies the specified format properties if the condition is met.
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When creating multiple rules for a column, be careful that the conditions do not
cover overlapping values. Consider the following scenario:

m The first rule sets a profit value to blue if the value exceeds 5000.
m The second rule sets the profit value to green if the value exceeds 1000.

If the profit value is 6000, the value appears in green, not blue as you expect,
because the condition in both rules is true (6000 exceeds 5000 and 1000), and the
second rule supersedes the first rule. For the rules to make sense, the second rule
should set the profit value to green if the value is between 1001 and 5000.

Deleting conditional formatting from a report column

This section describes how you can delete conditional formatting rules from a
report column.

How to delete conditional formats

1 Select the column, then from the context menu, choose Format>Conditional
Formatting.

2 On Conditional Formatting, choose Delete Rule for each conditional
formatting rule that you want to remove. Choose OK.

Formatting data strings

Interactive Viewer provides common formats to change how numbers appear.
You can, for example, display numbers with or without decimal values, in
scientific notation, as a percentage, or as currency with the appropriate symbol.
Sometimes, even though a column displays numbers, the data can have a string
data type. Postal codes, for example, are frequently stored as string data. Numeric
formats do not apply to numbers of string type. To help you understand what
format you can apply to a report column, when you select a column for
formatting the title of the formatting dialog box identifies the type of data in the
column. This section discusses numeric data formats, date-and-time formats, and
string data formats, and describes how you can apply these formats to data in a
report. When you work with merged columns, select each column from the
drop-down list of columns in the merged column, and define a new format each
time, based on the column’s data type.

When working with multiple columns containing the same data type, you can
use Interactive Viewer to specify a format for the data in one column, and copy
the format to other columns. This section also explains how to copy formatting
properties.
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About data formats

Data types are types of values—numbers, strings, and Booleans, for
example—that you can manipulate in any programming language. Every element
of report data has a certain data type, and every expression that you create
returns a value of a particular data type.

This concept is important because, if the expression you type does not handle
data types properly, you do not obtain the expected results. For example, you
cannot perform mathematical calculations on numbers if they are of string type,
and you cannot convert values in a date field to uppercase characters.

If you type an expression to manipulate a data field, make sure you verify its
type, particularly if the data consists of numbers. Numbers can be of string type
or numeric type. For example, databases typically store postal codes and
telephone numbers as strings. [tem quantities or prices are always of numeric
type so that you can manipulate the data mathematically. IDs such as customer
IDs, or order IDs are usually of numeric type so that the application can store
them in numeric order, such as 1, 2, 3, 10, 11, rather than in alphanumeric order,
such as1, 10,11, 2, 3.

To view the data type of a column, select the column and choose Format>Format
Data from the context menu. The name of the dialog box that appears tells you
the type of data in the column. For example, if you select the credit limit column,
the dialog box that appears is called Number column format.

Applying a number format

This section describes how to apply a standard number format or a custom
number format to format numeric data.

How to apply a humber format
1 Select a column that contains numeric data.

2 From the context menu, choose Format>Format Data. Number column
format appears, as shown in Figure 3-14.

Number column format X
Farrnat Mumber as: Currency 3
Syrnbol: $ v
Symbal Position: Before =
Decimal Places: 2 w
Use 1000s Separator: v
Megative Numbers: -1234.56 po
Locale: Auta -

.

Figure 3-14 Setting number column format
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3 On Number column format, select a format from the Format Number as list.
For example, you can format the credit limit column as currency in dollars ($)
as shown in Figure 3-14. Select the appropriate options from the remaining
drop-down lists on Number column format. Choose OK.

You can select a standard format or define a custom format. Standard and
custom formats are described in the next sections.

Selecting a standard number format

Table 3-1 shows the standard number formats that Interactive Viewer supports.
The examples in the table reflect the English (United States) locale. If you work in
a different locale, the data displays differently. For example, a number that
appears as 1352.45 in the English (United States) locale appears as 1352,45 in the
French (France) locale.

Table 3-1 Standard number formats

Format Example of data display

General Number 6066.45 or 6066.5 or 6067, depending on the original
value. This format displays up to two decimal places.
Whole numbers and numbers with one or two decimal
places appear in their original format.

Currency $6,067.45 or ¥6067 or 6067€, depending on the symbol,
symbol position, decimal place, and thousands separator
values that you set.

Fixed 6067 or 6067.5 or 6,067.45, depending on the decimal
place and thousands separator values that you set.

Percent 45% or 45.8% or %45, depending on the symbol position
and decimal place values that you set. This format
multiplies the original value by 100 and adds the percent
(%) symbol.

Scientific 2E04 or 2.67E04, depending on the decimal place value
you set. The number after the E represents the exponent
of 10. For example, 2.67E04 means 2.67 multiplied by 10
raised to the fourth power.

Defining a custom number format

You can define a custom number format using special symbols to construct a
format pattern. A format pattern shows where to place currency symbols,
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thousands separators, decimal points, or commas. Table 3-2 shows examples of
custom format patterns and their effects on numeric data.

Table 3-2 Results of custom number formats
Format pattern Data in the database Result of formatting
0000.00 12.5 0012.50
124.5 0124.50
1240.553 1240.55
#.000 100 100.000
100.25 100.250
100.2567 100.257
S it 2000.00 $2,000
20000.00 $20,000
ID # 15 ID 15

Applying a date-and-time format

You can choose from several common formats to display date-and-time data. You
can, for example, display dates as January 19, 2008 11:00:00 AM PST; Jan 19, 2008;
or 1/19/08, and so on. This section describes how to select standard and custom
date-and-time formats.

How to apply a date-and-time format
1 Select a column that contains date-and-time data.
2 From the context menu, choose Format>Format Data.

3 On Date column format, select one of the formats from the list. You can select a
standard format or define a custom format. The standard and custom formats
are described in the next sections.

m If you select a standard format, proceed to step 4.

m If you select a custom format, specify a format code in the next drop-down
list, then proceed to step 4.

4 Select a locale from the next drop-down list.

Choose OK.

Selecting a standard date-and-time format

Table 3-3 shows the supported standard date-and-time formats. The examples in
the table reflect the English (United States) locale. If you work in a different
locale, the date displays differently. For example, a date that appears as March 5,
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2008 in the English (United States) locale appears as 5 mars 2008 in the French

(France) locale.

Table 3-3 Standard date-and-time formats

Format Example of data display
General Date March 5, 2008 4:42:00 PM PDT
Long Date March 5, 2008

Medium Date Mar 5, 2008

Short Date 3/5/08

Long Time 4:42:00 PM PDT

Medium Time 4:42:00 PM

Short Time 16:42

Defining a custom date-and-time format

You can define a custom date-and-time format using special symbols, shown in
Table 3-4, to construct a format pattern. Use custom date formatting only for
reports viewed in a single locale. Custom formats always display dates in the
format you set, which can be inappropriate in other locales. For example, if you
use the format MM-dd-yy, the date January 10, 2006 always appears as 01-10-06,
regardless of the locale in which you view the report. For locales that customarily
display dates in date-month-year format, Interactive Viewer interprets the date
01-10-06 as October 1, 2006.

Table 3-4 Symbols for defining custom date-and-time formats
Symbol Description Example
VY Short year 08
yyyy Long year 2008
MM Month as a number 07
MMM Short month name Jul
MMMM Full month name July
d Day in month 10
W Week in month 2
w Week in year 28
DD Day in year 192
E Short day of week Thu
EEEE Long day of week Thursday

(continues)
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Table 3-4 Symbols for defining custom date-and-time formats (continued)

Symbol Description Example

H Hour in day (0 - 23) 0

k Hour in day (1 - 24) 24

K Hour in AM/PM (0 - 11) 0

h Hour in AM/PM (1 - 12) 12

a AM/PM 12:00:00AM
mm Minutes 30

ss Seconds 55

Table 3-5 shows examples of custom formats and their effects on a date stored as
April 15, 2006 12:15:30 PM in the database.

Table 3-5 Results of custom date formats

Format pattern Result of formatting
MM-dd-yy 04-15-06

E, M/d/yyyy Fri, 4/15/2006

MMM d Apr15

MMMM April

yyyy 2006

w 3 (the week in the month)
w 15 (the week in the year)
DD 105 (the day in the year)
h:mm:ss 12:15:30

Applying a Boolean format

A Boolean expression evaluates to True or False. For example, consider a
calculated column displaying values for the following expression:

ActualShipDate <= TargetShipDate

If the actual ship date is before or on the target ship date, the expression evaluates
to True. If the actual ship date is after the target ship date, the expression
evaluates to False.

If you do not format a column of Boolean data type, the column displays the
values True and False. To specify different labels, select the column, and from the
context menu, choose Format>Format Data. Type the new labels on Boolean
column format, as shown in Figure 3-15.
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Boolean column format %

For "True", show: On Time

For "False”, show: Delayed

)
Figure 3-15 Specifying display values for True and False

Applying a string format

You can format string data to correct text that contains inconsistent capitalization,
or to include characters, such as a space or a punctuation mark, at a specific place
in the string. For example, you can display United States telephone numbers in
one of the following formats:

(415) 555-2121
415.555.2121
415-555-2121

This section describes how you can select a standard string format, and how you
can define a custom string format for data in a report.

How to apply a string format
1 Select a column that contains string data.
2 From the context menu, choose Format>Format Data.

3 On String column format, select one of the formats from the list. You can select
a standard format or define a custom format. Standard and custom formats
are described in the next sections.

Choose OK.

Selecting a standard string format

Table 3-6 describes the string formats that you can choose and illustrates how the
formatted data appears.

Table 3-6 Standard string formats

Format Description

Lowercase The string displays in all lowercase, for example:
john smith

Uppercase The string displays in all uppercase, for example:
JOHN SMITH
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Defining a custom string format

You can define a custom string format using special symbols to construct a format
pattern. Table 3-7 describes these symbols.

Table 3-7 Symbols for defining custom string formats
Symbol Description
@ Character placeholder. Each @ character displays a character in

the string. If the string has fewer characters than the number of
@ symbols that appear in the format pattern, spaces appear.
Placeholders are filled from right to left, unless you specify an
exclamation point (!) at the beginning of the format pattern.
See Table 3-8 for examples.

& Same as @, except that if the string has fewer characters, spaces
do not appear. See Table 3-8 for examples.

! Specifies that placeholders are to be filled from left to right. See
Table 3-8 for examples.

Converts string characters to uppercase.

Converts string characters to lowercase.

Table 3-8 shows examples of custom string format patterns and their effects on

string data.
Table 3-8 Results of custom string formats
Format pattern Data in the data source Results of formatting
(@) 0eR-eeee@ 6175551007 (617) 555-1007
5551007 () 555-1007
(&&&) &&&-&&&& 6175551007 (617) 555-1007
5551007 () 555-1007
(@eR) ee-eee@ 6175551007 (617) 555-1007
5551007 (555) 100-7
((&&&) &&&-&&&& 6175551007 (617) 555-1007
5551007 (555) 100-7
(@eR) @R@-@RA@ + ext9 5551007 (555) 100-7 +ext9
(&&&) &&&-&&&& + ext9 5551007 (555) 100-7 + ext 9
>&&&-&& & & &-&& D1234567xy D12-34567-XY
<&&&-&&&&&-&& D1234567xy d12-34567-xy
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Reverting to default formats

To revert a data column back to its default font formats, select the column. From
the context menu, choose Format>Font. Select Auto from each drop-down list.
To reset text alignment, select the element, and choose the appropriate alignment
option.

If you applied a number, date-and-time, or string format to a column of data, you
can restore these formats to those in the original report. Select the column. From
the context menu choose Format>Format Data. Then, select Unformatted from
the drop-down list.

Copying a format to other columns

>
",
£,

When working with columns of similar data types, you can apply a format to
data in one column, and copy the format to data in other columns. For example,
consider a simple report that lists Price of each (sale price), Profit, and Revenue
for products sold in a region. If you format the Price of each column as currency
in US dollars, you can copy this format for data in the Profit and Revenue
columns, so that all amounts are formatted as currency in US dollars, in one
simple step.

How to copy a data format

1 Select the column containing the formatting properties you want to share.
From the context menu, choose Format>Copy Format.

Copy Format appears, as shown in Figure 3-16.

Copy Format x
Customer
Phone
City
Zip Code

Co (o] a

Figure 3-16 Sharing font and alignment properties with other columns

2 Select the column to which you want to copy the current formatting
properties. To select multiple columns, press Ctrl, then select each column.

Choose OK. The report displays the copied formatting properties in the
specified columns.
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Editing column and group headers

Column and group headers are label elements that contain static text. In a typical
report, some labels are editable, while others are not. Examples of labels you can
edit include report titles or author names. Examples of non-editable labels
include standard copyright or confidentiality statements.

You can change the content of the column header by choosing the Header option
from the context menu. You can modify properties such as the font, the font size,
the background color, and so on. You can also edit the text of the label.

How to edit a header

1 Select the column. To delete existing text, choose Header>Change Text from
the column menu, as shown in Figure 3-17. Type the text to display and press
Enter. The edited text appears on the header.

4 change Text
Alignment »
A Font

Figure 3-17 Modifying column labels

2 Select the column. From the column menu, choose Header>Alignment, or
Header>Font and modify the properties as needed.
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Exporting report data and
content

This chapter contains the following topics:
m About exporting options
m Exporting report data

m  Exporting content
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About exporting options

Interactive Viewer enables you to export report data, report content, and
elements, such as charts, cross tabs, or summary tables, to various formats. You
can export data to several flat-file formats that can be read by Excel. In addition,
Interactive Viewer uses various emitters to enable you to export content, as well
as elements to formats such as Excel, Word, PowerPoint, Postscript, PDF, and
Extensible HTML.

When you export content, or elements to other formats, each emitter such as the
PDF emitter or the Excel emitter provide several options that you can select to
maintain the existing properties of the exported content, enabling users to easily
perform additional analysis on the exported output. For example, when you
export an element such as a cross tab to Excel, the Excel emitter supports
exporting the content as a pivot table. This feature is specifically useful for
sharing content with users without access to Interactive Viewer, who can still
analyze the output in Excel. You can also export a Flash chart to PDF format. The
PDF emitter embeds the chart in the output file, thereby retaining any existing
animation properties. You can further modify the output file, based on the
options available in that application. This section discusses the exporting options
available when exporting report data or report content using Interactive Viewer.

Exporting report data

You export report data to extract some or all of the data from a report, to use this
data in another document, or format. For example, you can export customer sales
data from a previous quarter, then use the numbers in a spreadsheet to create a
forecast for an upcoming quarter.

IE' The viewers support the ability to export report data as a comma-separated
values (.csv) file, a pipe-separated values (.psv) file, a tab-separated values (.tsv)
file, or a semicolon-separated values (.ssv) file. These files store data in a flat file
format, which Excel can read. The difference between these formats is the
character used as the data delimiter, which can be a comma, pipe, tab, or
semicolon. You choose a format to export report data based on the requirements
of the application to which you export the data, and the purpose for which you
plan to use the exported data. You can also export data from BIRT Dashboard
gadgets to these flat-file formats.

Once you choose a format to export the data, Excel displays the exported data ina
spreadsheet. You can now resize columns and format the data as you would do
for any other spreadsheet.

When you export data, you cannot export a table or chart element, but you can
export the data displayed in both these elements.
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How to export data in comma-separated values file (.csv) format

1 From the main menu, shown in Figure 4-1, choose Export Data.

(| Enable Interactivicy

Save Design
Save Document
(=1 Print
[ Export Content

| = Expart: Data

|=| Parameters
& roc
HideShaw Itemn

£ Show Margin

,j’ Link to this page

(2] Help

Figure 4-1 Exporting report data

2 On Export Data, Available ResultSets lists the report elements, such as tables,
charts, cross tabs, Flash charts and gadgets, and so on, that contain data. Select
an element from which to export data. The names on the list are internal
names. For example, a report table element begins with the prefix ELEMENT,
and is listed as ELEMENT 50, ELEMENT_65, and so on.

3 Available Columns lists the columns you can export from the specified table.
You can export any of the data the report uses, including the data in aggregate
rows and calculated columns. In Available Columns, select the columns to
export one by one and choose the single right arrow after each selection, as
shown in Figure 4-2. To select all columns, choose the double right arrow.

To deselect a column, choose a column from Selected Columns, then choose
the single left arrow. To deselect all the selected columns, choose the double
left arrow.

4 In Encoding Style, select UTF-S8, or specify a style in Other. If you do not
specify a style, Actuate BIRT Viewer uses the local encoding style.

5 In Miscellaneous, specify the following information:

= In Maximum Rows, type the maximum number of data rows to export. To
export all the data rows in the report, accept the default value of No Limit.

m In Values Separator, choose the Comma (CSV) delimiter.

m In Localize Column Name, select an option from the following:
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o Select Export Column Name to export the column name specified in the
data source.

o Select Export Column Display Name to export the column name
specified in the report design.

o Select Export Column Name and Display Name to export the column
names specified in the data source as well as the one specified in the
report design.

Export Data X
Awvailable ResultSets:

Table hd

Available Columns: Selected Columns:
ADDRESSLIMEL =

ADDRESSLIMEZ »

CITY

>

Ciky_State

COUNTRY

CUSTOMERMAME

Empty_Col

STATF ;I

Encoding Style
©) UTF-3
(0 Other

{if blank, use the local encoding)

Miscellaneous

Maximurm W Lirit
Rows
Walues

.
Separeter Comma { C5Y )

Localize

Export Column Name ¥
Colurn Hame —F

Export Column Data Type Export Locale Meutral Format

V| Export Calumn Header Export Data With Carriage Return

’
Figure 4-2 Exporting report data

6 You can select the following additional options to export column data type,
export the data in locale neutral format, and export the column header.

m  When you export report data to a flat file format, such as comma-separated
values (.csv) format, tab-separated values (.tsv) format, pipe-separated
values (.psv) format, or semicolon—separated values format, select Export
Column Data Type to include the data type information in the flat file. In
the following example, the second line identifies the type of data in the file:

FirstName, LastName, AccountID
STRING, STRING, INT
"Doe", Jane", 1234 ..

m  When you export report data that contains date-and-time values, the
Actuate BIRT viewers format these values according to the syntax in the
current locale, by default. If no locale is configured, then the viewers use
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the US locale as the default. For example, if you export the date
01/10/2009 in the original format, it can be interpreted as January 10, 2009
or October 1, 2009, depending on whether the locale is US or France. On
Export Data, select Export Locale Neutral Format to export report data
without considering locale information, so that the date is interpreted
correctly in every locale.

m  When you select Export Column Header, Actuate BIRT Viewer exports the
column header in addition to the data in the column. The spreadsheet
displays each exported column below the corresponding column header.

m  When you select Export Data With Carriage Return, Interactive Viewer
exports the data using a Carriage Return (CR) character for each line break.

Choose OK.

On File Download, the default name and the file extension of the spreadsheet
file appear.

Choose Save.
On Save As, complete the following tasks:
1 In Save in, navigate to the folder in which you want to save the file.

2 In File name, change the name of the file. Choose Save. The
comma-separated values (.csv) file appears in the new location.

When you open the file, the output data appears as an editable Microsoft Excel
worksheet. You can expand the columns to view all the data.

Use the same process to export data to pipe-separated values (.psv) files,
tab-separated values (.tsv) files, and semicolon-separated values (.ssv) files.

Exporting content

You can export an entire report, as well as each individual report element such as
a chart, summary table, or cross tab, to several different formats. Exporting
content to one of these formats creates a file that can be used by applications other
than the viewers.

In Interactive Viewer, you can export report content to the following file formats:

Advanced Function Printing (.afp)
Microsoft Excel (.xIs)

Microsoft Excel (.xIsx)

PDF (.pdf)

Postscript (.ps)
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m  Microsoft Word (.doc)

m  Microsoft Word (.docx)

m  Microsoft PowerPoint (.ppt)
m  Microsoft PowerPoint (.pptx)
m Extensible HTML (.xhtml)

The following sections describe the available formats, as well as the options
available when exporting content to each format.

Exporting content to AFP format

You can use Interactive Viewer to export a BIRT report, selected pages of a BIRT
report, or a specific report element such as a chart, or cross tab, to Advanced
Function Printing (AFP) format. AFP is a print stream technology that supports
high-volume printing on high-capacity, and high-speed printers. If your
enterprise generates large reports that require hard-copy printing, using AFP is a
significantly more efficient option than exporting the report to PDF, or Word
format, and then printing the report.

The AFP emitter enables you to specify several layout options as well as image
rendering options for the exported content using the Export Content dialog box.
You can set the following layout and resolution options:
m Pagerange
Specify the number of pages to export if you are working with a multipage
report design or document file.
m Chart DPI
Specify the DPI at which the chart engine exports the chart component.

m Plex Mode
Enables you to specify the sides of the page on which to print.
= Simplex
Selecting this option prints on a single side of the page

m  Duplex
Selecting this option prints on both sides of a page.

m Tumble

Selecting this option prints the file as a continuous document. To navigate a
printed document that uses this option, flip each page over longitudinally
such that the end of the previous page becomes the top of the next page.

The AFP emitter provides several color options to optimize the quality of the
exported images based on the native image format supported by the printer in
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use. You can select any of the following color options depending on the native
image format supported by the printer you are using:

m  Allow black and white images
Selecting this option, exports existing black and white images.

m Allow single color images
Selecting this option, exports existing images single-color images.

m  Allow grayscale images
Selecting this option, exports existing grayscale images.

m  Allow full color RGB images
Selecting this option, exports existing full-color RGB images.

m  Allow full color CMYK images
Selecting this option exports existing full-color CMYK images.

The AFP emitter’s available image format options enable users to closely control
how images are rendered in the exported output. All images are transcoded to the
closest format that corresponds to the user's selected options. To preview the
exported output before it is sent to a printer, download the AFP Viewer plug-in
and view the resulting output in your web browser.

How to export a report or report element to AFP format

1 To export a report, or report element, such as a cross tab, or a chart, choose
Export Content from the main menu, as shown in Figure 4-3. Export Content
appears.

(| Enable Interactivicy

Save Design
Save Document
(=1 Print
. Export Content

| = Expart Data

=) Parameters
& roc

HideShaw Itern

£ Show Margin

,j’ Link to this page

7] Help

Figure 4-3 Exporting a report

On Export Content, in Export Format, select Advanced Function Printing
(AFP) from the list, as shown in Figure 4-4.
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Ezport Content

Export Farmat: Adwanced Function Printing (AF

Page Settings
Page range

Chart DPT 192

Page DPI 240

Flex Made Sirnples:

Allow black and
white images

Allow single calar
images

v

Allow grayscale
images

Allaws Full color RGE 157
images

Allow calor CMYK
images

v

v

:

Figure 4-4

Selecting the AFP option

In Page Settings, specify which of the following options to apply to the

exported AFP file:

Page range

If you do not specify a value in this field, Interactive Viewer exports all the
pages in the current report design. If you are exporting a report
component, leaving this field blank exports only the selected component.
Chart DPI

If exporting a chart, specify the export resolution DPL If you do not specify
a value, Interactive Viewer exports the chart using the value 192 DPL
Page DPI

Select an option from the list. if you do not specify a value, Interactive
Viewer uses the value 240 DPL.

Plex Mode

Specify one of the following plex modes for the exported file:

o Simplex

o Duplex
o Tumble

Allow Black and white images
Allow single color images

Allow grayscale images
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m  Allow full color RGB images
m  Allow color CMYK images
Choose OK.

3 File Download appears. The default name assigned to the file and file

extension are visible, as shown in Figure 4-5.

File Download - Security ¥arning x|

Do you want to open or save this file?

@ Mame: Sales by Tenitoy.afp

Type:  Unknown File Tupe
From: 192.168.206.110

Open Save | Cancel I

== ‘while files from the Internet can be useful, this file twpe can
@ patentially harm your computer. IF you do not trust the source, do not
open of gave this software. What's the risk ?

Figure 4-5 Downloading the exported file

Choose Open or Save.

When you open the file, the content is displayed in your web browser using the

AFP viewer plug-in, with the options you specified, as shown in Figure 4-6.

R a2 BP% & =

= Classic Models, Inc
=i 7207 Bridgepointe Parkway
San Mateo, CA 94404

Sales by Territory
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P current vear
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Territory  Country State Customer Prior Current %
Year Year Change
NA $589,801 $501,516  -15% o/
Canada $22,997  $29,070 26% W
Québec $22,997 429,070 26% LT
Guébec Home Shopping $22,997 429,070 26% LT
Metwork
Figure 4-6 Previewing the exported report design in a web browser
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Exporting content to Microsoft Excel

You can use Interactive Viewer to export a BIRT report, selected pages of a BIRT
report, or a specific report element such as a chart, or cross tab, to Microsoft Excel,
Excel 2007, and Excel 2010. When exporting content to Excel 2010, we recommend
that you use the XLSX format in order to avail several features supported only in
XLSX format, and to avoid compatibility issues that occur when using Microsoft
Oftfice 2010. The exported content in either version of Excel has exactly the same
layout as the HTML page. In addition, all versions of Excel support the following
properties:

m Formulas used in computed columns and aggregations in the existing report
or report element are maintained in Excel format. When exporting a BIRT
report created in Actuate BIRT Designer Professional that contains expressions
that use EasyScript, you can also export live formulas for the expressions to
Excel.

m  Regular charts and Flash charts are exported to Excel as editable Excel charts.
m Exported images are displayed in Excel.
m Cross tabs are exported to pivot tables in Excel.

Each output Excel document contains one content sheet, and one or more data
sheets. If you are exporting a report containing a table view, and a chart view of
data, exporting the chart view of the report to Excel results in the exported output
displaying the chart. Similarly if you export the table view to Excel, Excel
displays tabular data.

You can set the following additional options:

m Export any chart in the report as an image. If you select this option the Excel
emitter does not allow you to edit the chart in Excel. To allow users to edit the
chart as needed, deselect this option. When deselected, the chart appears in
Excel as shown in Figure 4-7, and can be edited.

m Specify the output DPI for charts, to view the exported image in higher
resolution. Increasing the DPI value can result in a larger output file size. If
you do not modify this field, Interactive Viewer exports the chart at 192 DPL

m Specify exporting live formulas for BIRT reports containing expressions
created using EasyScript.

m To hide grid lines in the resulting spreadsheet, select hide grid lines. Hiding
grid lines modifies the appearance of the output data in such a way that it
resembles the report viewed in Interactive Viewer more than it does a
spreadsheet.

m To view report output on multiple sheets, select this option. Selecting this
option does not maintain pagination properties when you export a multipage
report.
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A |B C D E F G H J KL[MN B QR| S
1 g Classic Models, Inc
2 2207 Bridgepointe Parkway .
3 San Mateo, CA 94404 Sales by Territory
4
$350000K r
$300000K
$250000K
$200000K
O Current..
$150000K
$100000K
$50000K
$0K
5 Austria Belgium Denmark Finland France Ttaly Spain  Sweden UK
[§ Territory Country State Customer Prior Current %  Trend
7 EMEA ##E### $808,717 —21%0
8 Austria $49,234 552,420 6%
9 $49,234 552,420 6% W
10 Salzburg Collectables $49,234  $52,420 6% k'
Figure 4-7 Exporting a chart to Excel

Select Enable Pivot table, when you export a cross tab to Excel. When selected,
this option enables Excel to display cross-tab data as a pivot table providing

the user with the ability to further analyze the
tab exported to Excel.

data. Figure 4-8 shows a cross

—
[ 4] A B Cc D E F G H | J K
1 [revenue PRODUCT=JE
2 [vear |~ |Quarter B Month B Classic Car: Motorcycles Planes Ships Trains Trucks and Vintage Can_
30 =2004 =l Qtrd Jan $109,563 §39,987 531,159 526,310 36,387 $42,909| 5256315
4 Feb $108,232 $45,694 534,000 524,804 34,763 335,749 548,688 8302021
5 War 399,512 515,559 $9,879  §32,193 45252 5202,395
6 Dar2z  |Apr $89,998  S32,229  $33882 510,808 $33,352) 5200,269
7 May $70,698 S47,873 $35898  $3.440  S$4,862 S31,729  $38,536| 5233036
8 Jun 346,025 316,472 341,967 $48,110| §152,574
9 =ars  |Jul $139,040 565,156 543256  S20,260 58,985 536,987 572,418 5386,082
10 Aug $140,458  S55,640 S32,083 S23485 57,132 $32,147  S65,019| $355064
ihl Sep $140,177  $6515 S30,634 S23114  S5611  S37,720  $62,084| $306755
12 = Qtr4 Oct 210,010 569,147 331,081 340,881 313,731 368620 $§107,121| 5540642
13 Nov $397,83¢  $121,93¢  S97B07  S43535  $12,148 575,998 5183857 S935713
14 Dec $131,433 543,069 S68654 S43.838  §13,350 S52612  S75,882| 5428838
15/ (2004 Total $1682,0980 $527,244 S438256 S292,505 86,807 $443,703  $823,928| 54,300,603
16 [Grand Total [ 51,682,980 §527,244 $438256 5292,595 $86,807 $448,703 85823928 54,300,603
M 4 » M| Report -~ DataSheetl_29 %1 [ m 1
Figure 4-8 Excel displaying an exported cross tab

This feature is useful when you need to share the cross tab with users using
applications other than Interactive Viewer. More information about cross tabs

is available in later sections of this document.
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How to export a report or report element to Excel

1 To export a report, or report element, such as a cross tab, or a chart, choose
Export Content from the main menu, as shown in Figure 4-9. Export Content
appears.

1] Enable Interactivity

Save Design
Save Document
(= Print
I Export Content

| = Expart Data

|=| Parameters
& Toc
HideShow Item

| show Margin

# Link to this page

(2] Help

Figure 4-9 Exporting a report
2 On Export Content in Export Format, select Excel, as shown in Figure 4-10.

Export Content X

Expart Format: Excel (¥L5) ™

Page Settings
Page range
Texk wrapping ki

Enable pivot table |V

Auto adjustment 7
For pivot table

Chart DPT 192

Expart charts as
images

Enable live formulas (¥
Hide grid lines

Dutput to multiple
sheets

’
Figure 4-10 Exporting content to Excel

3 In Page Settings, provide the following information:

1 Select the page range, or specify the page numbers that you want to export.

50 Working with Actuate BIRT Viewers



2 Select Text wrapping to eliminate the need for horizontal scrolling in the
exported report.

3 Select Enable pivot table to export the report as a pivot table, to facilitate
data analysis in Excel.

4 Select Auto adjustment for pivot table, to enable Interactive Viewer to
automatically adjust the content for display in a pivot table.

5 If exporting a chart:

Specify the DPI at which the chart is exported. If you do not specify a
value, Interactive Viewer exports the chart at 192 DPL

To export each chart as an image, select this option.

6 Select Enable live formulas, to export live formulas when exporting content
from a BIRT report that contains expressions created using EasyScript.

7 Select Hide grid lines.
8 To export the output to multiple sheets, select this option.
Choose OK.

4 File Download appears. The default name assigned to the file and file
extension are visible. Choose Open or Save.

When you open the file, the report displays in Excel, and can be edited as
needed.

Exporting content to PDF format

You can export report content, or report elements such as charts, or cross tabs, to
PDF format. The PDF emitter in Interactive Viewer provides consistent layout,
and pagination properties between PDF and HTML output formats. The PDF
emitter also produces a high quality PDF file, with a small file size. In addition it
provides high quality images for charts, and SVG (scalable vector graphics)
format in PDF output. The available customization options are described in the
following section.

You can also export Flash charts and Flash gadgets to PDF format. When you
export Flash charts and gadgets to PDF format, Interactive Viewer supports
embedding the exported element in the PDF file, enabling you to easily interact
with the Flash elements. Flash charts and gadgets retain their animation
properties when exported to PDF format.

When you print an exported Flash chart or gadget, the embedded file in the PDF
document, must be viewed in order for it to appear on the printed page. In a
multipage report with Flash content on several pages, view each page, so that the
embedded Flash elements are loaded, and then print the required pages for the
Flash content to be visible in the printed output. If you do not view the pages
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before printing the file, the Flash content is not visible in the printed output, for
pages that were not viewed.

More information about charts, Flash charts and Flash gadgets is available in later
sections of this document.

How to export a report or report element to PDF format

1 Choose Export Content from the main menu. Export Content appears.

2 On Export Content in Export Format, select PDF.

Export content appears, as shown in Figure 4-11.

Figure 4-11

Export Content xX

Export Format: POF it

Page Settings
Page range
Page style Auta >

BIDI processing v

Text wrapping v

Text hyphenation

Font substitution [/

Embedded Font v

Chart DPI 192

Render chart in
vectar graphics

Selecting options to export a report

A few more options appear on Export Content. Complete the following steps:

1
2
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Select the page range, or specify the page numbers that you want to export.

Select a layout for the exported file from the Page style menu. For more
information about Page Style options, see “Printing a report,” in Chapter 2,
“Navigating a report.”

When a report contains languages that are read from left to right, such as
English or French, and those that are read from right to left, such as
Hebrew or Arabic, the text from both languages can be presented in the
same report in the appropriate direction. This text is called bidirectional
(BIDI) text. Select BIDI processing if you have a report in two or more such
languages and need the data to be correctly presented in the PDF or
Postscript output.

Select Text Wrapping to eliminate the need for horizontal scrolling in the
exported report.

Select Text hyphenation, if necessary.

Select Font substitution to substitute any fonts that the application cannot
interpret. Font substitution is the process of using one font in place of
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/wiki/Computer_font
/wiki/Computer_font
/wiki/Computer_font
/wiki/Computer_font

another when the original font is not available. The classification of fonts
into families enables the process of font substitution. For example, it
ensures that only a sans serif font replaces another sans serif font.

7 Select Embedded font to embed a font currently being used, in the
exported output.

8 Enter a value in Chart DP], specifying the resolution at which to display
the chart, if the report you are exporting contains one or more charts. A
higher DPI results in a larger file size. If you do not specify a DPI, the chart
engine exports the image with a DPI value of 192.

9 Select Render chart as vector graphics for existing charts in SVG (scalable
vector graphic) format. This option for SVG images improves the
resolution of the exported image, while maintaining a smaller file size.

Choose OK.

File Download appears, as shown in Figure 4-12. The default name assigned to
the file and the file extension are visible. Choose Open or Save.

File Download x|

Do you want to open or save this file?

T‘ Mame: Example_1.pdf
k| Type: Adobe Acrobat Document

From: hitp: #localhast 2300

Open Save | Cancel I

|-"‘-] ‘while files from the Internet can be useful, some files can patentially
\d haimn yaur computer. IF pou do not tust the source, da not apen or
= zave this file. ‘what's the risk?

Figure 4-12 Exporting data
When you open the file, the report displays as a PDF document.

Exporting content to Postscript format

When you export content to Postscript format, the Postscript emitter displays the
content in the output file, almost exactly the same way as it will appear when
printed. The Postscript emitter provides the same options as the PDF emitter,
with two exceptions:

m The option to export SVG images as vector graphics is not supported.

m  The option to embed fonts from the report being exported is not supported.
How to export a report or report element to Postscript format

1 Choose Export Content from the main menu. Export Content appears.

2 On Export Content in Export Format, select Postscript.
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3 In Page Settings, specify the following information:
1 Pagerange.

Page style.

Enable BIDI processing.

Enable Text wrapping.

Enable Font substitution.

o a A WD

If exporting a chart, specify the export DPL If you do not specify a value,
Interactive Viewer exports the chart at 192 DPL.

7 Select Fit to Paper to enable the PostScript emitter to format the report
according to the size of the paper in use.

Choose OK.

4 File Download appears. The default name assigned to the file and file
extension are visible. Choose Open or Save.

When you open the file, the report displays in the format you specified.

Exporting content to Microsoft Word

Interactive Viewer supports exporting content to Microsoft Word, Word 2007, and
Word 2010. When exporting content to Word 2010, we recommend that you use
the DOCX format in order to avail several features supported only in DOCX
format, and to avoid compatibility issues that occur when using Microsoft Office
2010. To export content to either version of Word, on Export Content, specify the
following information:

m Page range for the content you want to export
m If exporting a chart element, the DPI or resolution
How to export a report or report element to Word format
1 Choose Export Content from the main menu. Export Content appears.
2 On Export Content in Export Format, select Word or Word 2007.
3 In Page Settings, specify the following options:
1 A pagerange.

2 If exporting a chart, specify the export DPL If you do not specify a value,
Interactive Viewer exports the chart at 192 DPL

Choose OK.

4 File Download appears. The default name assigned to the file and file
extension are visible. Choose Open or Save.
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When you open the file, the report displays in the Word format you specified.

Exporting content to Microsoft PowerPoint

Interactive Viewer supports exporting content to PowerPoint, PowerPoint 2007,
and PowerPoint 2010 formats. When exporting content to PowerPoint 2010, we
recommend that you use the PPTX format in order to avail several features
supported only in PPTX format, and to avoid compatibility issues that occur
when using Microsoft Office 2010. To export content, or a report element to either
PowerPoint version, specify the following information on Export Content:

Page range

Page style

BIDI processing
Text Wrapping
Font substitution
Chart DPI

How to export a report or report element to PowerPoint format

1

Choose Export Content from the main menu. Export Content appears.

2 On Export Content in Export Format, select PowerPoint or Powerpoint 2007.

3 In Page Settings, specify the following information:

1 Pagerange.

Page style.

Enable BIDI processing.
Enable Text Wrapping.

Enable Font substitution.

O g A WD

If exporting a chart, specify the export DPL. If you do not specify a value,
Interactive Viewer exports the chart at 192 DPL

Choose OK.

File Download appears. The default name assigned to the file and file
extension are visible. Choose Open or Save.

When you open the file, the report displays in the PowerPoint format you
specified.
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Exporting content to Extensible HTML format

Extensible HTML (XHTML) is the next generation of HTML, compliant with
XML (Extensible Markup Language) standards. The XHTML emitter is
specifically useful when users need to provide accessibility options for the
exported content. XHTML (Extensible Hypertext Markup Language) format
enables users to access the content from a wide range of applications, other than a
desktop or browser, and is extremely easy to update and maintain.

How to export a report or report element to Extensible HTML format
1 Choose Export Content from the main menu. Export Content appears.
2 On Export Content in Export Format, select XHTML.
3 In Page Settings, specify the page range, then choose OK.
4

File Download appears. The default name assigned to the file and file
extension are visible. Choose Open or Save.

When you open the file, the report displays in a browser window.
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Organizing data
in a report

This chapter contains the following topics:

About displaying and organizing report data
Modifying the width of a column

Managing a column

Sorting data

Organizing data in groups

Aggregating data

Hiding and displaying report elements
Specifying page breaks

Chapter 5, Organizing data in a report
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About displaying and organizing report data

Interactive Viewer enables you to organize report data in several ways. You can
change the width of columns, and move and remove columns to improve
presentation or change the order of data in a report.

You can sort data in a column in ascending or descending order, organize data
columns into groups, and create aggregate data values. You can create aggregate
data, at the end of a customer group, for example, by displaying the total amount
of a customer’s purchases or the average amount of each order. You can also
create calculations, such as sums, standard deviations, rankings, and differences.

You can also use Interactive Viewer to change group and column headers, and to
customize pagination in a multipage report by defining page breaks before or
after groups. A group displays all the information about an item category in one
place. For example, you can display all the information about one customer, then
all the information about the next customer, and so on. You can display the
information for customers and their orders by grouping the information by
product, or you can display a company’s sales by geographical region.

You can hide columns, as well as report elements based on your needs. You can
also hide duplicate data rows in a column, or a group. This document describes
these tasks in more detail.

Modifying the width of a column

58

In addition to modifying the alignment and text properties of column data, you
can optimize the layout of a report by adjusting the width of report columns
according to the space occupied by column data.

For example, Figure 5-1 shows two reports. The report on the left uses the default
column width. The same report on the right is modified to optimize its column
width. As the example shows, the report on the right looks neater, and eliminates
wasted space when you print, or export the content to other formats.

Australia - Australia

Austrahan Collectors, Co. Ferguson Peler Auslrahan Collectors, Co. Ferguson Peler
Anna's Decorations, Lid OHara Anna Anna’s Decorstions, Lid OHara Anna
Sowveniers Ard Things Co Huzley Adrisn Huzley Adeian
Augtralian Gift Natwork, Co Calaghan Ben alaghan Ben
Austrakian Collectables, L1d Clenahan Sean Clenahan Sean
Aystria = Aystria
Salzburg Collectables Bipps Georg Salzburg Collectables Pipps Guoey
Mini Ao Werke Mundel Riokand Mirs Auto Werke Mundel Frotand
Bieligian - Belgum
Pelit Auto Deway Catherse Pelil Auto Diewey Catherne
Royale Belge Cartrain Pascale Reyale Belge Cartrain Pascale
Figure 5-1 Comparing reports with the original and modified column width
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How to modify column width

Select the column. Place the cursor on the right or left border of the highlighted
column. Using the cursor, drag the border inwards or outwards to increase or
decrease the width of the selected column.

Managing a column

This section describes how to use Interactive Viewer to change the order of
columns in a report, delete report columns that are not necessary, hide existing
columns, and display hidden columns. When you delete a column from the
report, you cannot insert it back into the report design at a later time. If you might
have a need for data in the column later on, you can hide the column, and display
it whenever necessary.

How to reorder columns

You can move columns to change the order of columns in a report table in one of
the following ways:

m  Choose the column to select it, then drag the column from its original location,
and drop it in a new location, whose position is indicated by an arrow that
appears on the top of the column label.

m  Choose Column>Move To Left from the context menu to move the column to
the left of the previous column.

m  Choose Column>Move To Right from the context menu to move the column
to the right of the column next to it.

m Alternatively, complete the following steps to move a column.

1 Select the column. From the context menu on the column toolbar, choose
Column~>Reorder Columns. Arrange Columns appears, as shown in

Figure 5-2.
Arrange Columns x
#Available Columns:
Country -
Cuskamer J
Conkact Mame
Phone |
City
7D Code j
.
Figure 5-2 Arranging columns in Interactive Viewer

2 In Available Columns, select the column to move. Choose the up or down
arrow on the right until the column is in the correct position. Moving a
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column up in the list, moves it to the left in the report. Moving a column
down in the list, moves it to the right in the report. Choose OK.

How to remove one or more columns from the report

To remove a column, select the column and press Delete. You can also select the
column, then choose Column->Delete Column from the context menu.

To remove multiple columns, press Ctrl when selecting columns. Then, use the
previously described method to delete the columns from the report.

How to hide a column

Select a column. From the context menu choose Column~>Hide Column.
Interactive Viewer displays the report without the selected column.

How to display a hidden column

Select a column. From the context menu, choose Column~>Show Column. Show
columns appears listing the hidden columns. In Pick Hidden Column, select the
column to display. Choose OK. The column appears in the report.

Sorting

data

Sorting data is an important task in creating a useful report. A customer phone
list, for example, is easier to use if it is in alphabetical order. A sales report is more
useful if it presents sales figures from highest to lowest, or the reverse, if you
want to see lowest to highest performers.

You use sorting to display report content in a more meaningful order. For
example, reports often display data in a seemingly random order depending on
the report design. You can sort data in ascending or descending order, and you
can sort by as many fields as needed. For example, you can sort a list of customers
by credit rank, then by customer name.

Compare the reports in Figure 5-3. The report on the left displays data as in the
original report. The report on the right displays the same data, sorted by country.

Australia stralian Collectors, Co.
Australia Decorations, Lid

Aucstralia Souveniers And Things

Australia

Austria

Austria
Balgium
v Belgium Royale Belge
Land of Toys Inc 149000 Canada Canadian Gift Exchange Network
Figure 5-3 Comparing reports with sorted and unsorted data

You can sort data in ascending or descending order, and you can sort data by
multiple columns. For example, you can sort the data in a report by country, and
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then by customer name. Figure 5-4 shows a sample of the results of this sort
action. Countries appear in ascending alphabetical order. For each country, the
customer names appear in alphabetical order.

Australia Anna's Decorations, Ltd 107200.0
Australia Australian Collectables, Ltd 503000
Australia Australian Collectors, Co. 1173000
Australia Australian Gift Network, Co 516000
Australia Souveniers And Things Co. 93300.0
Austria Mini Auto Werke 45300.0
Austria Salzburg Collectables 717000
Belgium Petit Auto 79900.0
Belgium Rovale Belge 23500.0
Canada Canadian Gift Exchange Metwork 20300.0
Figure 5-4 Customer names sorted in alphabetical order

Sorting on a single column

To sort data on a single column, select the column. Choose the appropriate arrows
to Sort Ascending or Sort Descending from the column toolbar. You can also
choose Sort>Sort Ascending or Sort Descending from the context menu.

Sorting on multiple columns

You can sort data by up to three columns. When you sort by multiple columns,
you use the Advanced Sort option, shown in Figure 5-5. It is important to
understand the order of precedence for a multiple sort action. On Advanced Sort,
select the columns on which to sort, in the order in which you want to sort the
data. For example, to sort data by country first, and then by customer name
within each country, select the columns in that order on Advanced Sort.

How to sort data on multiple columns
1 Select a column. From the context menu, choose Sort>Advanced Sort.

2 On Advanced Sort, in Sort By, select a column from the list, then choose either
Ascending or Descending, as shown in Figure 5-5.

Advanced Sort x
Sort By:
Product Line w @ Ascending
Descending
Then By:
Select a Column A @ Ascending
Descending
Then By:
Select a Column ~ @ Ascending
Descending
’
Figure 5-5 Sorting data on multiple columns
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3 Select a second column from the next drop-down list. Choose the sort order.

You can also select a third column on which to sort. Choose OK.

Sorting data in a merged column

When working with merged columns, if you choose Sort from the context menu,
Select Data Item appears, as shown in Figure 5-6, providing a drop-down list of
data items in the merged column.

Select Data Item x

CITY e

Lo )(cma) @

Figure 5-6 Selecting a data item

From the drop-down list, select the item on which to sort data. Choose OK.

You can now sort data in each of the columns, as described in the previous
sections of this document. To modify each line of data in the merged column, you
must repeat this step for each data item, then define the sort order, each time.

Reverting data to its original order

IZ' To revert data to its original unsorted order, select a column. From the context
menu, choose Sort>Advanced Sort. On Advanced Sort, for each column specified
for a sort action, choose Select a Column from the drop-down list. Choose OK.

Organizing data in groups

Sorting data makes a report more readable and useful. Sorting is typically only
one of the tasks you perform when organizing data in a report. It is common for
reports to present data that is organized into meaningful groups, especially
reports that contain large amounts of data. Consider the task of listing every item
a corporation owns, along with information such as the category, purchase price,
purchase date, inventory code, location, and supplier. If a report presents all these
items in an unorganized list or sorted list, it is not possible to determine how
much the corporation spends, for example, on office furniture or computer
hardware because this information cannot be easily calculated. The report cannot
provide information such as which year had the most purchases, or which items
are located in a field office and which items are in the warehouse.

To organize all this information into a useful inventory report, you create data
groups. Data groups contain related data rows. For example, you can create a
report that lists items by category—all office furniture in one group, all computer
hardware in another group, all computer software in a third group, and so on. For
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each group, you can calculate aggregate data, such as the total purchase price or
count of items in a group. Organizing data in groups makes it easier to compare
and analyze information.

Compare the reports in Figure 5-7 and Figure 5-8. The report in Figure 5-7
displays customer information in a simple list. The data rows are sorted by
country. Notice the repeated country names in the first column.

Pustralia Pustralian Collectors, Co Ferguson 03 8520 4555
Auztralia #Aona‘s Decorations, Ltd O'Hara 032 0036 2555
Australia Souveniers And Things Co Huxley +i1 2 9495 8555
Pustralia Pustralian Gift Network, Co Calaghan G1-7-3344-6555)
Australia Australian Collectables, Ltd Clenahan 61-0-3844-6555)

Fustria Salzburg Collectables Pipps B562-9555

Austria hni Auto Warke hizndel TETH-3555]
Belgium Petit Auto Dewey (02 5554 67
Belgium Royale Belge Cartrain (071323 67 2655

Figure 5-7 Report with data sorted by country

The report in Figure 5-8 shows the same data. Unlike the previous report, this
report groups the rows by country, removing the repeated entries.

[ Gty Customer ContactMeme  Phone|
= Pustralia
Australian Collectors, Co. Ferguson 02 0520 4555
Anna's Decorations, Ltd 0'Hara 02 Q936 8555
Souveniers And Things Co. Huxley +i1 2 0495 3555
Australian Gitt Metwork, Co Calaghan B1-7-2844-6555
Fustralian Collectables, td Clenahan i1-0-3844-A55S
Pustria
Salzburg Collectables Pipps 65620555
hiini Auta Were hiendel TE7S-3555
Belgium
Petit Auto Dewey (025554 67
Royale Belge Cartrain (071) 23 67 2555

Figure 5-8 Report with data grouped by country

A report that groups data provides a more effective way to view data. When you
group data, you can:

m Add subtotals, counts, averages, or other aggregate information at the
beginning or end of each group.

m Insert a page break before or after each group to start each data group on a
new page.

m Hide the details of each group to view a summary report.

In addition, Interactive Viewer performs the following actions when you group
data:

m  Removes duplicate values for each group.

m Sorts the values of each group. For example, a country group displays the
countries in alphabetical order, as shown in Figure 5-8.

m  Generates a table of contents that displays the values of every group when you
view the finished report in the viewers. The table of contents allows you to
navigate to specific locations in the report. This feature is particularly useful
when a report contains many pages.
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How to group data

Select the column that contains the values to group. From the context menu

choose Group>Add Group.

If the column you selected contains string or numeric data, Interactive Viewer
groups the data by each unique value in the column. If the column you selected

contains date-and-time data, additional grouping options appear.

Grouping data on a date-and-time column

When you group data on a date-and-time column, you have two options. You can
show every individual date or time value, or you can group the data by a specific
time interval, which is the typical option. You can organize a shipping report, for
example, showing shipment data by month or by quarter, rather than by date.

Figure 5-9 shows three reports that contain the same data.

Shipment Date
Jan 10, 2003

Order

10100

Shipped To

Cnline Digcast Creations Co

Jan11, 2003 10101 Blauetr See Auta, Co.

Jan 14, 2003 10102 Witachrome Inc.

Feb 2, 2003 10103 Baane Mini Imports

Feb 1, 2003 10104 Euro+ Shopping Channel

Fek 12, 2003 10105 Danish Wholesale nports

Feb 21,2003 10106 Roveli Gifts

Feb 26, 2003 10107 Land of Tays Inc
Figure 5-9
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Shipment Date

=] Jan 10, 2003

=l Jan 11, 2003

=] Jan 14, 2003

= Feb1,2003

=/ Feb 2, 2003

=l Feb 12, 2003

= Feb 21, 2003

= Feh 26, 2003

Order

10100

1001

10102

10104

10103

10105

10106

107

Shipped To

Online Diecast Creations Co.

Blauer See Auto, Co

Witachrome Inc:

Euro+ Shopping Channel

Baane Mini Imports

Danish Wholesale Imports

Rovell Gifts

Land of Toys Inc.

Shipment Date

= January 2003

= Fehrusry 2003

Order

10100
10101
10102

10103
10104
10105
10106
10107

Shipped To

Cnline Diecast Crestions Co
Blauer See Auto, Co
Witachrome Inc.

Baane Mini Iinports

Euro+ Shopping Channel
Danish YWholessle Impotts
Rovelli Gifts

Land of Toys Inc.

Comparing reports with grouped and ungrouped data

The report on the left displays data that has not been grouped, the second report
groups shipment dates using individual date values, and the third report groups
shipment dates by month.

How to group date-and-time data

1

Select the column that contains the date-and-time data. From the context
menu, choose Group>Add Group.

On Group Detail, select one of the group options. If you opt to group by

interval:

m Select an interval type, such as weeks, months, or quarters, from the
drop-down list.

m  Type a number to indicate the grouping for the selected interval type. For
example, if you selected Weeks, type 2 to group data in two-week periods.




Figure 5-10 shows grouping the Shipped Date column by month.

Group Detail x
faroup On: SHIPPEDDATE
Group Options:

Group using individual values
@ Group every 1 Months w

5
Figure 5-10 Grouping by Shipping date

Grouping on multiple columns

When you group data on multiple columns, consider the order of precedence
before you create the groups. To group customer data by state, then by city, create
the groups in that order. The order in which grouped columns appear in a report
indicates the order in which the groups were created. The first group appears as
the leftmost column in the table, the second group appears next to it, and so on.

Changing the grouping order

After you create groups, you can change their order. Evaluate the effect of
changing the grouping order. For example, changing the order of the state or
province and city groups to city and state or province produces a report that
organizes data illogically. On the other hand, changing the order of the sales office
and product line groups to product line and sales office provides you with a
different perspective on the sales data. The focus shifts from sales office
performance to product line performance.

How to change the grouping order

1 Select a column. From the context menu, choose Column~>Reorder Columns.
Arrange Columns, as shown in Figure 5-11, shows the columns in the order in
which the report currently displays the data.

Arrange Columns b 4

Available Columns:

Product Line
Product Mame
Tokal

Profit

[o ) [oma) @

Figure 5-11 Reordering grouped columns

2 On Arrange Columns, select the grouped column from Available Columns.
Use the up or down arrow buttons to move the column up or down the list.
Choose OK.
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Aggregating data

One of the useful features in a report is the ability to display summary, or
aggregate, data. Many example reports in the previous sections of this document
contain aggregate data. For example, a sales report can show the overall sales
total; sales subtotals by product type, region, or sales representatives; average
sales figures; or the highest and lowest sales figures.

Aggregating data involves performing a calculation on a set of values. For a
simple listing report that does not organize data in groups, you can perform
aggregate calculations on values in a selected column, across all the data rows in a
table.

For example, consider a report that has a column calculating price*quantity. You
can use the sum of the calculations in this column to obtain the total price of all
items. You can create up to three aggregations for each report column.

When you aggregate data, you choose whether the aggregation appears in the
table header or footer. If the column is grouped, you can display the aggregate
value in the group header or footer.

The report in Figure 5-12 displays aggregate data for the Total and the Profit
columns at the end, or footer, of the table.

Product Name Total Profit
19359 Cadillac Limousine $2,163.50 $1,006.50
1940 Ford Pickup Truck $4,373.50 $2,115.33
1945 Porsche 356-A Roadster $3,215.52 $626.32
1956 Porsche 356A Coupe $6,554 41 $1,914.31
1957 Corvette Convertible $4,151.52 $1,983.69
1957 Wespa 35150 §2,238.30 §755.55
1958 Setra Bus §2,554 44 $918.54
1961 Chevrolet Impala $1,766.40 $1,022.81
1965 Dodge Charger $5,298.72 $1,691.04
1968 Ford Mustang §7,273.14 $3,268.86
1969 Dodge Charger $3,005.56 $1,302.39
1969 Dodge Super Bee $2,967.30 $760.05
1970 Plyrouth Hemi Cuda $1,742.88 $976.80
1971 Alpine Renault 16005 §1,405.35 §363.69
1974 Ducati 350 Mk3 Desmo §2,755.50 $1,071.60
1976 Ford Gran Torino $5,564.88 $2,778.30
1962 Ducati 900 Maonster $1,945.22 $582.32
1962 Ducati 996 R $1,274 46 $477.84
1982 Lambarghini Diabla $667.20 $362.40
1996 Peterbilt 379 Stake Bed with Cutrigger $1,352.86 $579.53

Aggregate data

Figure 5-12 Report displaying aggregate data

In a report that organizes data into groups, you can display aggregate data for a
selected column or columns. You can also perform aggregations for each group of
data rows, and for all the data rows in the table. In the example report shown in
Figure 5-13, the aggregate data appears at the footer of each group.
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B Product Line Classic Cars

Product Name: ic: Quantity Ordered
- - "

Aggregate data for the product line
group, Classic Cars

Matorcycles
Price of each  Quantity Ordered

Aggregate data for the product line

Maximum Motorcycies 5 '
Total orcycies 1,503 group, Motorcycles

Figure 5-13 Aggregate data by product line group

Adding and removing an aggregate value

When you aggregate data in a column, you specify the following information:

The type of aggregate calculation. The report in Figure 5-13 displays, for the
Total column, the sum of the values, the highest (max) value, and the average
value. Interactive Viewer supports other types of aggregate functions,
described later in this document. Each aggregation appears on a separate row.

Whether to perform the aggregate calculation across all the data rows in the
table, or across the data rows in each group, or both. Aggregating data for
groups applies only to reports that organize data in groups.

Whether to display the aggregate data in the footer or header of the table or
the groups. The previous examples show aggregate data in the footers, which
is typical. Choose header to display the aggregate data at the beginning of the
table or group.

How to aggregate data

1

Select the column containing the data to aggregate. From the context menu,
choose Aggregation. Aggregation appears. The syntax of the selected function
appears in the lower part of Aggregation, as shown in Figure 5-14. From the
Select Function menu, select the aggregate function to use.

Specify a sort direction for the resulting aggregation. If you select Ascending
or Descending from the Sort direction list, the groups appear, in ascending or
descending order in the report. Select none if you do not want to sort the
groups in any order.
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Column name

Aggregation X

Selected Column: Total
Delete Aogregation

Select Function; Average v | | Sort direction:

Agaregate on:
| table level (7 header @) footer

group level =)

AYE(Tokal) Enter Label: Average Farmat
Add Agaregation

O ; | ? .
s = Function syntax

Figure 5-14 Aggregating the Total column as an average

3 In Aggregate on:

m Select table level to aggregate data across all the rows in the table. Select
either header or footer as the location in which to display the aggregate
data.

m  Select a group from the next list to aggregate data at the group level. Select
either header or footer as the location in which to display the aggregate
data.

4 In Enter Label, enter a name for the Label. Optionally, set a font for the
aggregation label, by choosing Format.

5 To create a second aggregation, choose Add aggregation. In Select Function,
select a function from the list. Repeat step 2 to step 4 to define the aggregation.
Choose OK. Figure 5-15 shows the three aggregations defined for the report.

How to add additional aggregate rows to a column

1 After you create a single aggregate value for a column, you can add up to two
more aggregate values for the same column. For an order total column, for
example, you can create a sum of all the values, count all the values, and get
the average order total. To add an aggregate value, select a column that
contains an aggregate value. Choose Aggregation from the context menu.

2 On Aggregation, choose Add aggregation.
An additional section appears on Aggregation, as shown in Figure 5-15.

3 Create the second aggregate value and choose OK.
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Aggregation b4

Selected Colurn: — Total
Delete Aggreqation

Select Function: Average ~ | | Sort direction:
Agaregate on:
V| table level () header @ Footer
group level =)
AVE(Tatal) Enter Label: Average Farmat
Dielete Aggregation
- Create a new aggregate

Select Function: SUm w | | Sort direction:

row in this section

Aggregate on:
V| table level () header @ Footer

aroup level @

SUMITakal) Enter Label: SUM Format
Delete Aggregation

Select Function: v || Sort direction:

Aggregate ond
V] table level () header @ Footer

aroup level @

Enter Label: Format

Add Agaregation

,

Figure 5-15 Adding an aggregate row for a column

How to aggregate data in a merged column

1

When working with merged columns, if you choose Aggregation from the
context menu, Select Data Item appears.

Select the data item or column on which to perform an aggregation, from the
drop-down list. Choose OK.

You can now create aggregations for each of the columns, as described in the
previous sections of this document. To modify each line of data in the merged
column, you must repeat this step for each data item, then define the
aggregation, each time.

How to delete an aggregate value

1

Select the column that contains the aggregation to remove. From the context
menu, choose Aggregation.

Aggregation appears, displaying all the aggregations for the column. Choose
Delete Aggregation for the aggregation you want to remove. Choose OK.

Chapter 5, Organizing data in a report 69



Types of aggregate calculations

The aggregate calculations you can perform on a column depend on the type of
data in the column. You can perform functions only on numeric data, that enable
a mathematical calculation, such as SUM and AVERAGE. The most common
aggregate functions used for string data are Count and Count Value. Count
returns the number of values in a column, including duplicate values. Count
Value returns the number of distinct values in the column. You can use Count
Value, for example, on a customer name column to get a count of the number of
customers. For date-and-time data, you can use the MIN and MAX functions to
get the earliest and the latest date, respectively, from an order date column.

For a description of the aggregate functions available see Chapter 11,
“Functions and operators.”

Hiding and displaying report elements

This section describes how to use Interactive Viewer to hide or display elements
in a report, such as a column or table header, a report table, a chart, a Flash chart
or object, and an image in the report.

How to hide or display report items

1 Choose Hide/Show Items from the main menu. Hide or Show Items appears,
as shown in Figure 5-16.

2 Select the items to display. Deselect the items to hide. To hide all items, choose
Clear. Then, choose OK.

Hide/Show Items x

Check Item{s) to Show
V| Report Header
| Table Header

# || Table
Clear

)
Figure 5-16 Hiding or displaying report items

Hiding group details

In a report containing multiple groups, it is sometimes useful to hide the details
for a specific group if you do not want to display all the information at the same
time. For example, in a sales report that groups orders by state and product, you
can display only the state totals, by choosing the top-level group, state, and then
selecting the Hide Detail option. Hiding the details from the state group
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recursively hides all data within the state group; the report hides product groups
and the order details within each product group.

When you work with a report that organizes data in groups, you can change the
report to a summary report by hiding the group details. Hiding details,
particularly for a report that runs into hundreds of pages, helps you display key
information at a glance. Figure 5-17 shows two reports that contain the same data.
The report on the left shows all details. The report on the right hides the details
within each product line group.

B Product Line Clazsic Cars B Product Line Classic Cars

Product Name Price of gach  Quantity Ordered Product Name Price of each___ Quantity Orderad
52 Algine Renaut 1300 21430 43 310,266 =

B Product Line

Product Name Price of each  Quantity Crdered
Average  Molorcycies

Maximum: Molorcycies

Total

Matorcyclas Price of each  Quantity Ordered
Frice of each  Quantity Ordered &

Total Motorcycles

Figure 5-17 Comparing reports showing and hiding product details

How to hide group details

Select the grouped column whose details you want to hide. From the context
menu, choose Group>Hide Detail.

How to redisplay group details

Select the grouped column, then from the context menu choose Group>Show
Detail.

Suppressing duplicate values

Frequently, you find that you do not need to display all the data present in a
report. For example, sometimes a report column displays duplicate values in
consecutive data rows. When the duplication is unnecessary or makes the report
difficult to read, you can suppress consecutive duplicate values. In addition, as
you modify a report, you can collapse groups to display only the column
headings and summary data, such as aggregate data rows.

You can also use Interactive Viewer to suppress duplicate values that appear in a
grouped column. For example, a report that lists customer orders, grouped by
customer, shows some data values such as the address, contact information,
customer number, and so on, multiple times for every order placed by the
customer. You can prevent the duplicate occurrence of these values by moving
data rows from the column to the group header.
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Avoiding repeated values in a column

In the report shown in Figure 5-18, the Location column shows the city name each
time the name occurs.

Customer Location tative
Technical Systerns Inc. Boston MA 1401
Design Systemns Bostan M& 1401
Brittan Design Inc. Boston Ma 1401
TeleBoards Co. Boston Ma 1401
Design Engineering Corp. Bostan Ma 1401
TekniBoards Corp. Philadelphia Pa 1216
Design Solutions Philadelphia Pa 1216
Signal MicroSystems Philadelphia Pa 1216
SigniSpecialists Corp. MYC MY 12386
Technical MicroSystemns Inc, NYC MY 1286
InfoEngineering MNYC MY 1286
Advanced Design Inc. MY C MY 1286
Technical Design Inc. MWYC ['hg 1286
Design Solutions Corp, MY C T 1286

Figure 5-18 Duplicate values in columns

As Figure 5-19 shows, the report appears neater and more organized when
duplicate values are not repeated.

Using Interactive Viewer, you can suppress consecutive occurrences of duplicate
values. In the Location column in Figure 5-19, the Boston value is suppressed in
the second, third, fourth, and fifth rows. If Boston occurs again after the listing for
NYC, that occurrence of Boston is visible and subsequent consecutive occurrences
are suppressed. The values must be exact duplicates to be suppressed.

Technical Systemns Inc. Boston Ma 1401
Design Systerns

Brittan Design Inc.

TeleBoards Co,

Design Engineering Corp.

TelkniBoards Corp. Philadelphia Pa 1216
Design Solutions

Signal MicroSystems

Signispecialists Corp. NTC MY 1266
Technical MicroSystems Inc.

InfoEngineering

Advanced Design Inc.,

Technical Design Inc.

Figure 5-19 A report suppressing duplicate values

If a column extends across multiple pages, the first row on each page displays a
value, even if duplicate values are suppressed for that column.

How to suppress duplicate values in a column

Select the column containing duplicate values. From the context menu choose
Column~>Do Not Repeat Values.

How to show hidden duplicate values in a column

Select a column that does not repeat duplicate values. From the context menu,
choose Column~>Repeat Values.

E
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Avoiding repeated values in a group

The example report in Figure 5-20 displays the values for Customer Number,
E-mail, and Credit Limit multiple times for the same customer. By moving the
data row values to the group header, you limit the appearance of these fields of
data so that they only appear once.

Customer Name Customer Email Credit Limit Product Line Product Name
Number
= Australia
= Anria's
Decarations, Ltd
276 afider@classicmodelcars.com 107800 Clazsic Cars 1993 Mazda R¥-7
1965 Aston Martin
276 afixteri@clazsicmodelcars.com 107800 Clagsic Cars DBs
276 afider@classicmodelcars.com 107800 Classic Cars 1995 Honda Civic
1999 Indy S00 hMorte
276 afider@classicmodelcars.com 107800 Clazsic Cars Catlo 55
1992 Ferrari 360
276 afider@classicmodelcars.com 107800 Clazsic Cars Spider red
1943 Porsche Type
276 afider@classicmodelcars.com 107800 Clazsic Cars 356 Roadster
1932 Alfa Romeo
276 afider@classicmodelcars.com 107800 Virtage Cars BC2300 Spider Sport

Figure 5-20 A report displaying duplicate values in a group

How to suppress duplicate values in a grouped column

1 Select the column with the duplicate values. From the context menu choose
Column~>Move to Group Header.

2 On Move to Group Header as shown in Figure 5-21, perform the following
tasks:

m  Select the group to which you want to move the data values, if the report
contains more than one group.

m Select the header row to which Interactive Viewer can move the data

values.
Move to Group Header x
Mave ba group: CUSTOMERMAME B
Header rovi: 1 o

a
Figure 5-21 Selecting a group header

Repeat this step for each report column for which you want to move data rows
to the group header. Choose OK. The value from the first data row in each
group appears in each group header. The Credit Limit, E-mail, and Customer
Number columns display a single data row for each Customer Name group
header as shown in Figure 5-22.
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Customer

Country

Customer Email

Credit Limit

Product Line

Product Name

Name
= Australia

= &nna's

Ltdl

Number

Decorations,

276 afixter@classicmodelcars com

107800

Classic Cars

Clazsic Cars
Clazsic Cars

Clazsic Cars

Classic Cars

Clagsic Cars

1993 Mazda RX-7
1965 Aston Martin
oas

1985 Honda Civic
1999 Inchy 500
horte Catlo 55
1992 Ferrari 360
Spider red

1948 Porsche Type
356 Roadster
1932 Alta Romeo
GBC2300 Spider

Figure 5-22

Displaying a report showing suppressed duplicate values

Specifying page breaks

=.| Using Interactive Viewer, you can set page breaks after a preset number of rows
in a data column and you can start each group on a new page by specifying a
page break before or after grouped data.

How to set and remove a page break on a report column

1 Select a column. From the context menu, choose Group~>Page Break.

2 On Page Break, define an Interval by typing the number of rows you want to
display on each page, as shown in Figure 5-23. Choose OK.

Page Break x
Interval: 40
@
Figure 5-23 Setting a page break on a data column

3 To delete an existing page break, type 0 in the Interval field. Choose OK.

How to set and remove a page break on a grouped column

1 Select a grouped column. From the context menu, choose Group->-Page Break.
Page Break appears, as shown in Figure 5-24.

Page Break x
Before group: After group:
O always ) Always
() Ahways except () Always except
the first the last
@ Nore @ Mone
’
Figure 5-24 Setting a page break before or after groups
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2 You can set a page break for every group, or for every group except the first or
last groups. Choose OK.

3 To delete an existing page break, select None in Before group or After group.
Choose OK.
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Performing calculations in
a report

This chapter contains the following topics:
m  About calculated data

m Creating expressions

Chapter 6, Performing calculations in a report 77



About calculated data

Most BIRT reports require calculations to track sales, finances, inventory, and
other critical business activities. You can use Interactive Viewer to create
calculations to count items in a warehouse or provide more complex financial
data, such as tracking stock portfolio performance over time.

To display calculated data in a report, you create a computed column, such as the
Total column shown in the report in Figure 6-1. In the following example, you
need to calculate the Total because the original report does not provide this data.

Customer Order Price of Quantity Total
Name Number each Ordered
=l AV Stores,
Co. 10110
18.22 ar 54,374
153.0 42 56,426
5148 32 51,847
115.69 33 53,318
163.69 ]| 55,074
81.91 28 52,293
62.0 42 52,604
72.02 36 52,593
4327 29 $1,255
28.38 20 $578
4077 39 1,590
Figure 6-1 Report with computed column

Inserting calculated data in a report

When you create a computed column, you type an expression that indicates how
to calculate the data. In the example shown in Figure 6-2, you multiply each value
in the QUANTITYORDERED field with the corresponding value in the
PRICEEACH field, to obtain the value in the Total column. The following
expression calculates the Total:

[PRICEEACH] * [QUANTITYORDERED]

When you use a data field in an expression, you must enclose the field name
within brackets ([ ]).

Interactive Viewer supports typical mathematical operations, such as addition,
subtraction, multiplication, and division. In addition to mathematical
calculations, Interactive Viewer supports functions for processing date-and-time
and string data.

You can create a computed column to display data that is not displayed on the
report, or if you want to display data differently from its appearance in the report.
For example, if a customer name field contains values with leading or trailing
blank characters, you can remove the blank characters by using the TRIM( )
function as follows:

TRIM ( [CustomerName])
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Calculation x

Calurnin Label:
Total

*Enter Expression:

[FRICEEACHT'

[ORDERMUMEER] - Qrder Mumber

QUANTITYORDERED] - Quantity Ordered
[PRICEEACH] - Price of each
[Total]
[CUSTOMERMAME] - Customer Mame

Type the first letter of the function to select & function.

To learn more, click the link to operators or functions .

’
Figure 6-2 Performing a calculation

Creating and editing a computed column

This section describes how to create and edit computed columns in a report.

How to create a computed column

1 Select the column to the left of where you need the new computed column.
From the context menu, choose Column>New Computed Column.
Calculation appears.

2 In Column Label, type a name for the new computed column. The name you
specify appears in the column header.

3 In Enter Expression, type the expression that performs the calculation:

m To use a data field in the expression, type the left bracket ([), then select the
required field from the list that appears. The list displays only fields in the
report.

m To use a function, type the first letter of the function, then select the
function from the list that appears. The functions indicate the arguments, if
any, that you need to specify.

4 After you complete typing the expression, choose Validate. If the expression is
syntactically correct, Information appears informing you that the expression is
valid, as shown in Figure 6-3.

If the expression contains an error, Information displays an error message.
Choose OK.

5 On Calculation, choose OK. The computed column appears in the report.
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Information X

The expression is valid,

2
Figure 6-3 Expression valid confirmation message

How to edit a computed column

Select the computed column. From the context menu, choose Column~>Edit
Computed Column. Calculation appears. To modify the expression, continue as
described in the previous section.

Creating expressions

An expression is a statement that produces a value. An expression can be a literal
value, such as:

1.23
"Hello, World!"

An expression can contain any combination of literal values, operators, functions,
and references to data fields, as shown in the following examples. For detailed
descriptions of the functions that Interactive Viewer supports, refer to a later
section of this document.

The following expression displays a customer’s first and last names, which the
database entry stores in two fields. The & operator concatenates string values:

[FirstName] & [LastName]

The following expression displays a full address by concatenating values from
four data fields and adding commas as appropriate.

[Addressl] & ", " & [City] & ", " & [State] & " " & [Zipcode]

The following expression calculates a gain or loss percentage. The expression uses
the mathematical subtraction, division, and multiplication operators, -, /and *.

([SalePrice] - [UnitPrice])/[UnitPrice] * 100

The following expression uses the DIFF_DAY function to calculate the number of
days it took to process an order for shipping:

DIFF DAY ([OrderDate], [ShippedDate])

The following expression uses the ADD_DAY function to calculate a payment
due date when the payment term is net 30:

ADD DAY ( [InvoiceDate], 30)
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The following expression uses the IF function to evaluate if the value in the
country column is UK. If the condition is true, the function replaces the value
with United Kingdom. If the condition is false, the country values are displayed
as stored.

IF(([Country] ="UK"), "United Kingdom", [Country])
Using numbers and dates in an expression

When you create an expression that contains a literal number, type the number
according to the conventions of the US English locale. In other words, use a
period (.), not a comma (,) as the decimal separator, even if you are working in, for
example, the French locale. For example:

Correct: ([Quantity] * [Price]) * 1.5
Incorrect: ([Quantity] * [Price]) * 1,5

Similarly, when you create an expression that contains a literal date, type the date
according to the conventions of the US English locale. For example, if you are
working in the French locale, type 03/12/2007 to represent March 12, 2007. Do
not type 12/03/2007, which is the convention for the French locale. You must
enclose literal date values in double quotation marks(" "), as shown in the
following expression that calculates the number of days from the order date to
Christmas:

DIFF DAY ([OrderDate], "12/25/08")

How to add days to an existing date value

To create a column that displays date values that are greater than the date values
in another column, complete the following steps.

1 Select a column. From the context menu, choose Column>Choose New
Computed Column. Calculation appears.

2 In Column Label, type a name for the calculated column. For example, type
Forecast Shipping Date.

3 In Enter Expression, type the letter A. A list appears, displaying functions that
begin with A.

Choose ADD_DAY (date, daysToAdd).

5 For the first argument, type a left bracket ([) and select the date column from
the list. For example, select Order Date.

For the second argument, type the number of days to add. In this case, type 7.

Validate the expression and choose OK. The calculated column appears in the
report. For every value in the Order Date column, the calculated column
displays a date seven days later than the order date.

Chapter 6, Performing calculations in a report 81



How to subtract date values in a calculated column

The following section describes how to display the difference between two date
values.

1 Select a column. From the context menu, choose Column>Choose New
Computed Column. Calculation appears.

2 In Column Label, type a name for the calculated column. For example, for a
calculation that subtracts the actual shipping date from the date requested,
type Shipping Delay.

3 In Enter Expression, type the letter d. A list appears, displaying functions that
begin with d.

Choose DIFF_DAY (datel, date2).

5 For the first argument, type a left bracket ([) and select the first date column
from the list. For example, select Date Requested.

6 For the second argument, type a left bracket ([) and select the second date
column from the list. For example, select Actual Shipping Date.

7 Validate the expression and choose OK. The calculated column appears in the
report, displaying the difference between the two dates.

Using reserved characters in an expression

Some characters are reserved for internal use and have a special meaning. For
example, as described in the examples in previous sections, Interactive Viewer
uses brackets to denote a data field. The following characters are reserved in
Interactive Viewer:

[
]
?

' (single quotation mark)

If the name of a data field contains reserved characters, Interactive Viewer
removes the reserved characters when you select the data field to use in an
expression. For example, if the name of a data field is OBSOLETE?, Interactive
Viewer changes it to [OBSOLETE'?'] in the expression. If you type [OBSOLETE?]
in the expression, an error message appears. To avoid syntax errors, always select
the field and let the application construct the correct expression.

Figure 6-4 shows an example of a list of data fields, having reserved characters in
the names of three fields. The third, fourth, and fifth fields show both versions of
the names, the changed name, enclosed in brackets, and the original name
showing reserved characters, as follows:
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[ORDER''S STATUS] - ORDER'S STATUS
[PRODUCTCODE' ['4digit'] '] - PRODUCTCODE [4-digit]
[OBSOLETE'?'] - OBSOLETE?

Calculation

Colurmn Label:
Product Description

*Enter Expression:

[PRODLICTC

[PRODUCTNAME]
[PRODUCTCODET 4-digit'T]
[ORDER"S STATUS]
[OBSOLETE?]
[PRODUCTLINE]

Type the first letter of the function to select & function.

To learn more, click the link to operators or functions .

?

Figure 6-4 Data fields having reserved characters
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Filtering report data

This chapter contains the following topics:

About data filtering
Providing parameter values
Creating a filter

Defining multiple filter conditions

Chapter 7, Filtering report data
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About data filtering

A report or report element often provides more information than you need. You
can display specific rows of a report by using a filter. For example, instead of
listing all customer sales, you can create a filter to list only the sales data for a
particular week or a specific region.

Filtering data helps you work effectively with large amounts of data. It enables
you to present the information that answers specific business questions, such as
which sales representatives generated the top ten sales accounts, which products
generated the highest profit in the last quarter, which customers have not made a
purchase in the past 90 days, and so on.

Using Interactive Viewer, you can filter data at the report table level to narrow the
scope of data in a table, and also to remove unwanted fields of data that show too
much information. You can also filter data for report elements such as charts.

Sometimes when you view a report with existing filters, the report requires you to
enter parameter values to determine which data to display, each time you run the
report. You can view specific data in the report by modifying these parameter
values, as described in this document.

Providing parameter values

If a report design already uses filters, and requires you to enter values to display
data, you are prompted to enter these values before a report is run. The prompt
value is called a parameter. Parameters enable users to control displayed content,
without editing the report. You can modify the parameter values at any time by
choosing the parameter option from the main menu. For example, in a report that
displays sales data by sales office, you can use parameter values to select which
sales office data to view in the report. Even if you are the only person reading the
report, a parameter value enables you to view specific content in the report.

If you save a report design file containing parameters as a report document file,
the user can no longer specify parameter values to view specific data. The
viewers display data based on parameter values specified when the report design
was saved as a report document file.

Reports using dynamic filters, require you to first select an operator, and then
supply one or more parameter values for which the viewers display data.
Supplying specific parameter values in such reports is often optional, and you
can select the No Condition operator to view all the data in the report. You cannot
create dynamic filters using the viewers.

How to enter parameter values at runtime

This procedure uses the Customer Order History example report design.
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1 Run the report from the list of available reports. If the report contains filters,

and requires parameter values, the Parameters dialog box appears requiring
you to enter or choose specific values, based on which data is retrieved and
displayed.

Choose the field for which you want to view data, or enter a value. For
example, in a report containing customer order history data, to view a specific
customer’s order history, choose the Customer’s name from the list as shown
in Figure 7-1.

Choose Finish to view the report. The report in the example, displays the order
history for the Boards & Toys Co.

Parameters ©

Customer

* Required.

[ B3ck J NERt)

Figure 7-1 Entering parameter values

How to modify parameter values in the viewers
This procedure uses the Customer Order History example report design.

1 From the main menu, choose Parameters.

2 A Parameters section appears in the lower pane of the viewer. The example in

Figure 7-2 shows the details for the Boards & Toys Co. Choose another
Customer from the list. Then choose Run Report from the Parameters toolbar.

Customer Order History
EE— Report

ode Dascription Qt unit Price Order Totol

Order sumber: 10154 Order Date Oct 2, 2003

- 1912 31 $75.23 $2,332.13

Run report
- (
parsmeters i x——Close
[Bearss& Tays o =——— Parameters section

el =
Figure 7-2 Viewer displaying report and the parameters section

The report showing new data for the selected Customer appears in the upper
part of the Viewer. To view all the data on the current page, use the scroll bar
in the report section, or close the Parameters section.

You can only modify parameter values for reports that already contain filters and
require the use of parameter values to view data. If the report you generate does
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not use parameters, when you choose the Parameters option from the main
menu, a message appears informing you that the report contains no parameters.

How to select an operator and specify one or more parameter values

1 Run the report from the list of available reports. If the report contains filters,
and requires parameter values to display data, Parameters appears as shown
in Figure 7-3.

Parameters

—
(-

Customer IND Condition
City |In
Credit Limit |Greater than or Equal =] |IDDDDD

[ —at® J et [ Finish |
Figure 7-3 Specifying operators and parameter values

2 Select an operator in the first field, Customer. To view data for all customers,
select No Condition, as shown in Figure 7-3.

3 Select an operator from the drop-down list in the next field, City, and specify
one or more values from the list of values that appears. To select more than
one value, press Ctrl while selecting each additional value. To select a range of
values select the first value, press Ctrl+Shift and select the last value in the
range.

4 Select an operator from the drop-down list in the next field, Credit Limit, and
type a value in the associated field that appears. To view all credit limits, select
No Condition.

Choose Finish. The report displays data for the parameter values you
specified.

Creating a filter

To create a filter, you define a condition specifying which data rows to display. A
filter condition is an If expression that must evaluate to true for a data row to be
included. The following list shows examples of possible filter conditions:

If the credit limit is greater than 100000
If the sales office is San Francisco
If the order date is between 4/1/2008 and 6/30/2008
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Figure 7-4 shows an example of a filter condition. When defining a filter
condition, you can break it down into the following parts as shown in Figure 7-4:

The column to evaluate, such as credit limit

The comparison operator specifying the type of comparison test, such as Equal
To

The value to which all values in the column are compared, such as 100000

The column to evaluate
The comparison operator
The value to which to compare

Filter X
Filker By: CREDITLIMIT
Candition: Equal Ta v
Yalue: 100000 Select values
Advanced Fiker | Clear Filker
.
Figure 7-4 Creating a filter

How to create a filter

1

2
3

Select the column containing the data values to evaluate. For example, to
create a filter that displays data rows based on specific values in the credit
limit column, select the credit limit column.

From the column toolbar, choose Filter. Filter appears.

In Condition, select the comparison test, or operator, to apply to the selected
column. Depending on the operator you select, Filter displays either one or
two additional fields, or a completed filter condition.

If you select an operator that requires a comparison value, you can specify the
value in one of the following ways:

m  Type the value.

m  Choose Select Values to select from a list of existing data values. Figure 7-5
shows how you can select a credit limit value of 11000 from the list of
possible credit limit values. Use the previous and next buttons to navigate
the list of values that appears.

Choose OK to apply the filter. If the report or report element such as chart,
contains no data that matches the filter condition, Interactive Viewer does not
display any data. Make sure you test the filter by applying it and viewing the
resulting report.
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Filter b4

Filker By: CREDITLIMIT
Condition: Equal To .
Yalue: 11000 Select Yalues

0 2
11000

21000
23000
23500

34800 LI

previous | next

Advanced Filker | Clear Filker

2
Figure 7-5 Selecting a value for the filter condition

Selecting multiple values for a filter condition

Sometimes you need to view a wider range of data, such as, sales details for
several sales offices, not only for a single office. To select more than one
comparison value, select the In operator, choose List Values, then select each
value. Use the previous and next buttons to navigate the list of values that
appears in the Find area. Figure 7-6 shows the selection of London and Paris from
a list of sales office values. Choose OK.

Filter x
Filker By: SALES COFFICE
Condition: Aany OF v
Boston
Value: Paris
MYC
List Yalues | Delete Yalues
Find Yalue:
Boston
ELondon

MY

EParis

San Francisco
Sydney

previous | pext

Advanced Filter | Clear Filker

?
Figure 7-6 Selecting multiple values for a filter condition

Excluding data

When formulating a filter condition, you can use comparison operators, such as
Equal to, Greater Than, or Less Than, to determine which data rows to view.
Sometimes it is more efficient to specify a condition that excludes a small set of
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data. For example, you need sales data for all countries except USA. Instead of
selecting all the available countries except USA, and listing them in the filter
condition, it is simpler to use the Not Equal To operator. Similarly, use the Not
Between operator to exclude data in a specific range, and the Not Like operator to
exclude data that matches a string pattern.

For example, the following filter condition excludes orders with amounts that are
between 1000 and 5000:

OrderAmount Not Between 1000 and 5000

The filter condition in the next example excludes products with codes that start
with MS:

ProductCode Not Like MS%

Filtering empty or null values

Sometimes report columns have blank data rows. Consider a customer database
that contains an e-mail field. For customers who did not supply an e-mail
address, the e-mail field in the column is empty or blank. An empty value, also
called a null value, means that no value is available. Null values apply to all data
types.

You can create a filter to exclude data rows when a specific column has null
values. When filtering to exclude rows containing null values, use the Is Not Null
operator. If you want to only view rows with null values in a particular column,
use the Is Null operator. For example, the following filter condition excludes
customer data where the e-mail column contains null values:

Email Is Not Null

The following filter condition displays only rows where the e-mail column
contains null values:

Email Is Null

Displaying top or bottom values

For a report or report element that presents a large amount of numeric data, it is
useful to view a snapshot of the highest or lowest values, such as, the top 100
order totals or the counties whose median home prices are in the bottom 10
percent.

Select the column to highlight it, and choose Filter>Top/Bottom N from the
context menu. Top/Bottom N appears as shown in Figure 7-7.
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Top/Bottom N x

Filter: Top M 5
EBottam N
Top Percent
Bottom Percent
Mo Condition

)
Figure 7-7 Filtering data using Top/Bottom N values

On Top/Bottom N, select Top N, Bottom N, Top Percent, or Bottom Percent to
specify the condition. Enter a number in the next field, and choose OK.

Specifying a date as a comparison value

When you create a filter condition that compares the date-and-time values in a
column to a specific date, the date value must be in one of the following formats,
regardless of your locale:

3/26/2008
3/26/2008 2:30:00 PM

Interactive Viewer provides a calendar you can use to conveniently select a date.
Figure 7-8 shows how to access the calendar.

Filter x
Filker By: ORDERDATE
condiior: |Equal To ﬁ—Choose to open the calendar
Diate: 2 Select

* Please enter date values like: 7112011

Adwvanced Filker | Clear Filker

)
Figure 7-8 Selecting filter-condition values using the calendar

The calendar appears displaying the current date, month, and year. The current
date is highlighted by default, as shown in Figure 7-9.

m To accept the current date, choose Today.
m To choose another date, select it.

The selected date value appears in Date, in Filter. Choose OK for the filter
condition to take effect.
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Filter x

Filker By: CORDERDATE

Condition: Equal To Bt
Select

Date: Bi7j2011 s i

< a7
s M T W T F s
1z
3 4 5 6 R
10 11 12 13 14 15 18 [~
17o1s 18 20 21 2z 23
24 25 2 27 28 29 3
31

* Please el

oK Cancel 2
Figure 7-9 Selecting a date from the calendar

Comparing to a string pattern

For a column that contains string data, you can create a filter condition that
compares each value to a string pattern instead of to a specific value. For
example, to display only customers whose names start with M, use the Like
operator and specify the string pattern, M%, as shown in the following filter
condition:

Customer Like M%
You can use the following special characters in a string pattern:

m % matches zero or more characters. For example %ace% matches any value
that contains the string ace, such as Ace Corporation, facebook, Kennedy
Space Center, and MySpace.

m _ matches exactly one character. For example, t_n matches tan, ten, tin, and
ton. It does not match teen or tn.

To match the percent sign (%) or the underscore character (_) in a string, precede
the characters with two backslash characters (\\). For example, to match S_10,
use the following string pattern:

S\\_10
To match 50%, use the following string pattern:

50\\%
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Defining multiple filter conditions

When you create a filter, you define at least one filter condition, but you can
create as many filter conditions as you need to display relevant data. Each
condition you add further narrows the scope of displayed data. For example, you
can create a filter that returns rows where the customer’s credit rank is either A or
B and whose open orders total between $250,000 and $500,000. Each additional
condition introduces complexity to the filter. Make sure you design and test filters
with multiple conditions carefully. If you have too many filters that narrow the
scope of the report excessively, no data displays in the report, or report element.

Adding a condition

There are two ways to define multiple filter conditions. You can select a column
and define a filter, then select the next column and define a filter, and so on. Or
you can use the Advanced Filter dialog box, shown in Figure 7-10. You can use
Advanced Filter to modify or delete existing filter conditions.

Advanced Filter =
Filker By: PRODIUCTLIME
Condition: Equal To -

@) Specify literal value () Use value from data field

Yalue: Vintage Cars Select Yalues
Find Yalue:
Classic Cars
Mokorcycles
¥intage Cars

previous | pext

Add Condition  Change Condition

SALES OFFICE = San Frandsco
or PRODUCTLIMNE = Winkage Cars
=

,
Figure 7-10 Adding a filter condition

Filters:

For example, using the former method, you can define two filters, the first on the
SALES OFFICE column, the second on the PRODUCTLINE column.

When you use this method to define multiple filters, Interactive Viewer
constructs the following filter expression:

SALES OFFICE = San Francisco
and PRODUCTLINE = Vintage Cars
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This filter returns only data rows that meet both conditions. Sometimes, you want
to create a filter that returns data rows when either condition is true, or you want
to create a more complex filter. To accomplish either task, you can use the
Advanced Filter dialog box, shown in Figure 7-10.

As the example shows, Advanced Filter provides more options for defining a
filter with multiple conditions. It also displays all the filter conditions defined for
the report table, or chart element

How to define multiple filter conditions

1 Select the report column that contains the values to evaluate, then choose
Filter from the column toolbar.

2 On Filter, choose Advanced Filter. Advanced Filter appears. Filter By displays
the selected column.

3 Define the first filter condition as follows:

1
2

3

In Condition, select a comparison operator.

In Value, select or type the comparison value. For conditions that test
equality and for the Between condition, you can either set a literal value or
you can base the value on another data column by selecting the Use value
from data field option. For example, you can request actual shipping dates
that are greater than the forecast shipping dates, or actual sales that are less
than sales targets.

The conditions that support basing the filter value on another column are
Equal to, Not Equal to, Less Than, Less Than or Equal to, Greater Than,
Greater Than or Equal to, Between, and Not Between.

Choose Add Condition.

The filter condition appears in the Filters area.

4 Define the second filter condition as follows:

1
2
3

4

In Filter By, select another column.
In Condition, select a comparison operator.

In Value, select or type the comparison value. You can select Specify literal
value, or Use value from data field.

Choose Add Condition.

In the Filters area, the second filter condition appears below the first
condition, as shown in Figure 7-11. By default, the second condition is
preceded by the logical operator, AND.
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Advanced Filter x

Filker By: PRODIUCTLINE -
Condition: Equal To —
@) Specify literal value () Use value from data field

Yalue: Vintage Cars Selectk Yalues

Add Condition  Change Condition

Filter conditions

Filters:

and o not T LOgiCal Operators
SALES OFFICE = San Francisco

o
and PRODUCTLIME = Vintage Cars
Delete Validate, .,

)
Figure 7-11 Adding or modifying a filter condition

Choose a different logical operator, if necessary.
Add additional filter conditions using the previously outlined method.

If you create more than two filter conditions and you use different logical
operators, you can use the parentheses buttons to group conditions and define
the order of evaluation of the filter conditions.

8 Choose Validate to verify the syntax of the filter conditions, then choose OK.
9 Verify that the report displays the results you need.

Selecting a logical operator

As you add each filter condition, Interactive Viewer adds the logical operator
And between each filter condition. You can change the operator to OR. The AND
operator means that both filter conditions must be true for a data row to appear in
the report. The OR operator means that only one condition has to be true for a
data row to appear. You also can add the Not operator to either the AND or OR
operators to exclude a small set of data.

For example, the following filter conditions return only sales data for classic car
items sold by the San Francisco office:

Sales Office = San Francisco
And Product Line = Classic Cars

The following filter conditions return all sales data for the San Francisco and
Boston offices:

Sales Office = San Francisco
Or Sales Office = Boston
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The following filter conditions return sales data for all product lines, except
classic cars, sold by the San Francisco office:

Sales Office = San Francisco
And Not (Product Line = Classic Cars)

Specifying the evaluation order

Interactive Viewer evaluates filter conditions in the order in which they appear. If
you define more than two conditions, use parentheses to group conditions to get
the appropriate results. For example, A And B Or C is evaluated in that order, so
A and B must be true or C must be true for a data row to be included. In A And (B
Or C), B Or C is evaluated first, so A must be true and B Or C must be true for a
data row to be included. To illustrate the benefit of using parentheses, compare
the following examples.

The following filter contains four conditions and none of the conditions are
grouped:

Sales Office = San Francisco
and ProductLine = Classic Cars
and Total >= 8000

or Profit >= 4500

Figure 7-12 shows the generated report. Although the filter specifies the San
Francisco office and the Classic Cars product line, the report displays data for
other sales offices and product lines. Without any grouped conditions, the filter
includes rows that meet either conditions 1, 2, and 3 or just condition 4.

The following filter contains the same four conditions, but this time the third and
fourth conditions are grouped:

Sales Office = San Francisco
and ProductLine = Classic Cars
and (Total >= 8000

or Profit >= 4500)

Figure 7-13 shows the generated report using grouped filter conditions. In this
example, only two rows meet the defined conditions. The Sales Office = San
Francisco and ProductLine = Classic Cars conditions must be true, then either the
Total >= 8000 condition or the Profit >= 4500 condition is true.
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Sales Office Product Line Product Name

London
Motorcycles
2003 Harley-Davidson Eagle Drag
Bike 31150314 §i5,495.02]
Classic Cars
1952 Alpine Renault 1300 FA568.73 $4,935.47|
2001 Ferrari Enzo Fa571.08 $5,075.35]

Classic Cars

1952 Alpine Renault 1300 $10072.00 $5,143.00|
1952 Alpine Renault 1300 $49 467 B& $4,834 42|
1969 Dodge Charger §11,170.52 $5,473.71
1992 Ferrari 360 Spidet red $9.449.40 $4,775.40,
2001 Ferrari Enzo 3 434 52 $4,515.33]
2001 Ferrari Enzo F3974.40 $5,386.08]

Vintage Cars

1928 Mercedes-Benz SSK $3353.00 $4,725.00|

Clagsic Cars
1952 Alpine Renault 1300 $10,286.40 $5,554 56|

1972 Alfa Romeo GTA $3 61696 $3,133.44
Matorcycles

2003 Harley-Davidson Eagle Drag
Bike $9,304 25 $4,934.30|

Sydney

Wotarcycles
2003 Harley-Davidson Eagle Drag
Bike 920071 $4,539.73]

Figure 7-12 A report having multiple ungrouped filter conditions

Sales Office Product Line Product Name Total Profi
8 San Francisco
1= Classic Cars
1852 Alpine Renault 1300 510,235 40 §5,554 .56
1972 Alfa Romen GTA $5,616.96 $3,133.44

San Francisco

Figure 7-13 A report having grouped filter conditions

Changing a condition

From the Filters area on Advanced Filter, select the condition to modify as shown
in Figure 7-14. Modify the condition by changing the values in the Filter By,
Condition, or Value fields. Then, choose Change Condition. Choose OK to apply

the modified condition.

Deleting a condition

To delete a condition, select the condition on Filter. Then, select Clear Filter.
Choose OK.

To delete an advanced filter condition, in the Filters area on Advanced Filter,
select the condition. Then, select Delete.
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Verify that the remaining filter conditions are still valid.

Advanced Filter X
Select the condition
Filker By: SALES OFFICE -
Condition: Equal To . . .
. / — Modify the condition
@) Specify literal walyZ1) Use value From data field
Value: San Francisco Select Values

Add Condition  hange Candition
Filkers: Choose Change

SALES OFFICE = San F S ot Condition
= 2an Francisco
and PRODUCTLIMNE = Vintage Cars
?
Figure 7-14 Changing a filter condition

Filtering data in a merged column

You can also filter data in merged columns. When working with merged columns,
if you choose Filter from the context menu, Select Data Item appears, as shown in
Figure 7-15, providing a drop-down list of columns in the merged column.

Select Data Item x

CITY »

’
Figure 7-15 Selecting a data item

From the drop-down list, select the data item or column to filter data. Choose OK.

You can now create filters as described in the previous sections of this document.
To modify each line of data in the merged column, repeat this step for each data
item, and create a filter each time.
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Modifying charts

This chapter contains the following topics:
m About charts

m  Types of charts

m  Modifying charts in Interactive Viewer

m  Modifying Flash charts and gadgets
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About charts

A chart is a graphical representation of data in a report. You use charts to display
complex data in a format that is easily understood. A report can contain a chart
that functions as a report itself, or it can combine a chart with other report
elements to highlight relevant information. This section provides an overview of
the different types of charts you can modify using Interactive Viewer, and
explains how you can filter chart data, change chart subtypes, and format charts
in a report.

A chart displays data as one or more sets of points. Charts are particularly useful
for summarizing numeric data and showing the relationship between sets of
values called series. The two types of series are category series and value series,
typically denoted by the x and y axis. For example, a chart can show sales by
region, average temperatures by month, or the price of a stock over three months.

Interactive Viewer also enables you to modify the subtype, formatting, and layout
of Flash charts and Flash gadgets, both animated graphical representations of
report data. This section describes Flash charts and Flash gadgets, and explains
how you can modify them.

Types of charts

Specific types of data are best depicted with a specific type of chart. This section
describes the common types of charts you can modify in Interactive Viewer.

About bar charts

A bar chart typically displays data values as a set of vertical bars, but you can
transpose the axis to display horizontal bars. When you view report data in a
chart with vertical bars, you can easily compare the values. A bar chart is useful
to show data changes from one time period to another, for example from one year,
or quarter to another, or to illustrate comparisons among items.

Standard bar charts are side-by-side but you can have stacked and percent
stacked bar charts that also show the relationship of individual items to a whole.

Side-by-side bar chart

Side-by-side bar charts show bars from each series, one beside the other. Each of
these bars have the same width. The width depends on the number of series
being plotted. Figure 8-1 shows a side-by-side bar chart that graphically presents
a company'’s sales figures by geographical region.
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Sales by Territory

$240K
$220K
$200K
$ 180K
$160K
$140K

$120K -Current Year

$100K iPrior Year
$80K
$60K
$40K
$20K
$0K
Australia New Zealand Singapore
Territory Country State Customer Prior Year Current Year % Change Trend

IAPAC $415,840 $220,867 -47% [T]

= Australia $77,057 $53,197 -31% u

NSW 67,642 $42,252 -38% u

Victoria 39,415 $10,945 16% w

= New $233,362 $165,344 -29% U

Zealand

$233,362 $165,344 -29% u

= Singapore $105,421 $2,326 -98% (1]

105,421 52,326 -98% u

Figure 8-1 Side-by-side bar chart

Stacked bar chart

Stacked bar charts show bars stacked one above the other. The stacked bar chart
shows totals for each series as well as the proportion that each series contributes
to the grand total. The example in Figure 8-2 shows the company’s sales figures
for the current year and previous year, in the form of a stacked bar chart.

Sales by Territory

$400K
$360K
$320K
$280K

$240K

ﬁ Prior Year
-Current Year

$200K
$160K
$120K

$B0K

$40K

$0K

Australia New Zealand Singapore

Figure 8-2 Stacked bar chart
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Percent stacked bar chart

In a percent stacked bar chart, multiple series are stacked vertically and the
values appear as a percentage of the whole. The example in Figure 8-3 shows the
company’s sales figures by geographical location in terms of a percentage of the
whole. Figure 8-3 displays the sales values in percentages instead of the actual
numbers shown in the previous bar charts.

The percent stacked bar chart is meaningful only when you need to display and
compare multiple series. Do not use this chart subtype if you are displaying only
one series, for example, only sales for Australia.

Sales by Territory
[+

100%

20%

B0%

70%

60%

com [0 prior Year
40%

30%

20%

10%

0%

Australia New Zealand Singapore
Figure 8-3 Percent stacked bar chart

About tube, cone, and pyramid charts

Tube, cone, and pyramid charts are variations of the bar chart that use tubular,
conical, and pyramid-shaped risers in place of bars. You use a bar, tube, cone, or
pyramid chart when.you want to display data values as a set of vertical or
horizontal columns.

You can use Interactive Viewer to modify the subtype of tube, cone and pyramid
charts to side-by-side, stacked, or percent-stacked type depending on which type
best represents the data being used. You can also specify formatting options for
the chart, as described later in this document.

The example chart shown in Figure 8-4, Figure 8-5, and Figure 8-6 uses the same
data, sales of a product line across quarters, to illustrate these different chart

types.
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Product Line Classic Cars

Sales by Quarter

| s
3 6000
G 000 |
wmu‘ e
& z0m0 | E—
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0
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Figure 8-4 A tube chart showing sales by quarter

Product Line Classic Cars

Sales by Quarter

G000 I
S 5000 |
o 4000 |
& =000 |
: 2000 |
‘NEIDD |
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Figure 8-5 A cone chart showing sales by quarter
Product Line Classic Cars
Sales by Quarter
7000 |
5000 |
S 8000 |
) 4000 | .
£ 3000 | \
S 2o | /\ /\ .
1000 \
| \
200441 200452 200473 200474
Figure 8-6 A pyramid chart showing sales by quarter

About area charts
An area chart displays data values as a set of points connected by a line, with the

area shaded below the line. You use an area chart to present data that occurs over
a continuous period of time. For example, you can use an area chart to view the
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percentage of orders and the corresponding unit volume for trains, ships, and
planes over three months.

Stacked area chart

A stacked area chart consists of multiple series stacked vertically, as shown in
Figure 8-7. The example shows that the stacked area chart is suitable for the data
because the chart displays totals for all series as well as the proportion that each
series contributes to the total. The height of the top line shows the total value for
each category, for each quarter in this example. Each shaded area represents the
sales amount for a specific region.

Sales By Quarter and By Region

T0ooo0n

G000

S0000

40000

30000

20000

10000

Figure 8-7 Area chart

Overlay area chart

Overlay area charts show areas from each series independent of each other. The
areas appear by joining the values for the series. In an overlay area chart, the areas
of multiple series overlap, as shown in Figure 8-8. As the example shows, this
chart subtype is not suitable for showing multiple series if the data values
overlap. Use an overlay area chart if you want to show only one series, for
example, only sales for Asia.

Sales By Quarter and By Region
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Figure 8-8 Overlay area chart
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Percent stacked area chart

In a percent stacked area chart, multiple series are stacked vertically and the
values appear as a percentage of the total. Figure 8-9 shows the sales values in
percentages instead of the actual numbers as shown in the previous area charts.

The percent stacked area chart is meaningful only when displaying and
comparing multiple series. If displaying only one series, the percent stacked area
chart appears as in the example shown in Figure 8-10. The sales percentage of one
region compared to the whole is 100%.

Sales By Quarter and By Region
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Figure 8-9 Percent stacked area chart showing sales figures
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Figure 8-10 Percentage stacked area chart for a single series

About line charts

A line chart displays data values as a set of points connected by a line. You
typically use line charts to present large amounts of data that occur over a
continuous period of time. A line chart is the most basic type of chart in finance.
Figure 8-11 shows an example of a line chart, displaying the value of the Euro
against the US Dollar over ten days.
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Figure 8-11 Line chart displaying currency exchange rates

A line chart is similar to an area chart, except that it does not fill in the area below
the line, and it uses a square to mark each data value. There are three subtypes of
line charts.

Overlay line chart

In an overlay line chart, multiple series appear as overlapping lines, as shown in
Figure 8-12. The squares mark each data value. Overlay line charts show lines
from each series independent of the others. The lines appear joining the values for
the series.

Sales By Quarter and By Region
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Figure 8-12 Overlay line chart showing sales by quarter across regions

Stacked line chart

In a stacked line chart, multiple series are stacked vertically, as shown in

Figure 8-13. The stacked line chart shows totals for each series as well as the
proportion that each series contributes to the grand total. In the example, the top
line shows the total sales amounts for each quarter. The empty area between each
line represents the sales amount for a region.

The stacked line chart is not as effective as the stacked area chart for comparing
the amount that each region series contributes to the total because the areas are
not shaded. In a stacked area chart, the shaded areas provide a clear visual cue

that each part is compared to the whole.
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In addition, as the example shows, a user can easily misinterpret the data in a
stacked line chart. There is no obvious indication that the top line shows the total
sales amount for each quarter and that the middle line shows the difference in the
sales amount between Europe and Asia. A user viewing this chart can
misinterpret the top line to represent the sales data for the U.S., the middle line to
represent the sales data for Europe, and the bottom line to represent the sales data
for Asia.

Sales By Quarter and By Region
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Figure 8-13 Stacked line chart

Percent stacked line chart

A percent stacked line chart consists of multiple series stacked vertically and the
values shown as a percentage of the whole. As you can see in Figure 8-14, the
sales values appear as percentages instead of numbers. Like the percent stacked
area chart, the percent stacked line chart makes sense only when displaying and
comparing multiple series. Do not use this chart subtype if you are displaying
only one series, for example, only sales for Europe.

Like the stacked line chart, the percent stacked line chart is not as effective as the
percent stacked area chart.

Sales By Quarter and By Region
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Figure 8-14 Percent stacked line chart
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About pie charts

Pie charts show values as slices of a pie. The size of each slice is proportional to
the value it represents. You plot pie charts for multiple series as multiple pies, one
for each series. You use a pie chart to show the relationship of parts to the whole.
For example, Figure 8-15 shows the contribution of each state to the total sales of
a product.

State
s CA

Total Purchases Profit

San Rafael $3,216 $628
Los Angeles $2,692 $644
$5,907 $1,272

New Bedford $2,735 $741
Brickhaven $1,842 $440
$4,577 $1,181

e |
Nashua $3,188 $762
$3,188 $762

Las Vegas $2,121 $658
$2,121 $558

NYC $1,920 $357
$1,920 $357

Grand Total $17,714 54,131

Figure 8-15 Pie chart

About meter charts

A meter chart is very effective when showing a small number of values in a
prominent manner. A meter chart displays a value as a needle pointer on a
circular or semicircular dial. You can use a meter chart to create a gauge or
dashboard display. As Figure 8-16 shows, a meter chart resembles a speedometer,
with tick marks and numbers, showing a range of values. In this example, the
meter chart displays two pointers that represent two values, projected sales total
and actual sales total.
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Projected Sales and Actual Sales
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Figure 8-16 Meter chart showing projected sales and actual sales

You can show multiple dials in a chart, or one dial with multiple needles, by
using a superimposed meter chart. For example, you can use one needle to show
interior temperature, and another to show exterior temperature.

Standard meter chart

A standard meter chart displays multiple values in multiple dials, where each
dial displays a single value. The meter chart shown in Figure 8-17 displays the
same data as the chart in Figure 8-16, by using two dials instead of a single dial.

Projected Sales and Actual Sales

Legend
@ AcualialesTotal
) Projerteds alesTotsl

Figure 8-17 Standard meter chart

Superimposed meter chart

A superimposed meter chart displays multiple values in a single dial, as shown in
Figure 8-16. The dials overlap each other so that the chart can represent multiple
needles within a single region.

About stock charts

A stock chart shows data as points on a time continuum, such as days of the
week. Stock values appear as a candlestick, a box with lines extending up and
down from the ends. Open and close values mark the upper and lower edges of
the box. High and low values mark the upper and lower points of the line.

Although a stock chart typically displays stock price data, you can also use a
stock chart to show scientific data, such as temperature changes over time.
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Candlestick stock chart

Candlestick stock charts contain boxes with lines extending up and down from
the ends. The upper and lower edges are the open and close values of the stock.
The upper and lower points of the line are the high and low values of the stock, as
shown in Figure 8-19. The top and bottom of each box indicate the open and close
values. If the close value is higher than the open value, the box is white. If the
open value is higher than the close value, the box is shaded. This style
immediately provides information about whether a stock posted a gain or a loss
for a given day. Figure 8-18 displays the data used for the stock charts shown in
Figure 8-19 and Figure 8-20.

Bar stick stock chart

Bar stick stock charts consist of a vertical line with two horizontal lines called
ticks attached to it. The upper and lower points of the vertical line are the stock
open and close values. The ticks are the high and low values, as shown in

Figure 8-20.
Weekly Price Summary
High: $2.08
Lows: $2.03
Ave. Open: $2.51
Ave.Close: $2.57

Figure 8-18 Stock chart data

The chart in Figure 8-19 shows that the stock posted a gain on the fourth and sixth
day in the trading week and a loss on the other five days.

! I I I I I
f T T T T T T T
03/01/2005 03/03/200% 03/05/2005 03/07/2005

2.0

Figure 8-19 Candlestick stock chart

The example in Figure 8-20 shows a stock with moderate fluctuation. When the
stock is volatile on a given day, the two horizontal lines can appear far above or
below the vertical line. As you can see from the examples, the candlestick stock
chart shows the gain or loss pattern more clearly than the bar stick stock chart.
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Figure 8-20 Bar stick stock chart

About scatter charts

A scatter chart presents data as x-y coordinates by combining two sets of numeric
values into single data points. A scatter chart typically displays scientific and
statistical data, because it shows if there is a relationship between two sets of
measurements. Use a scatter chart to compare, for example, salaries and years of
experience, weight and body fat, rainfall amounts and pollen levels, or test scores
and hours of study. The greater the number of data values you include in a scatter
chart, the clearer are the trends the data reveals.

A scatter chart shows data as points. Scatter charts display values on both axes.
For example, the chart in Figure 8-21 shows the relationship between salary and
years of experience. Each pair of values, salary and years of experience, is plotted
as a single x-y value. The chart reveals a positive, or direct, relationship between
salary and years of experience. As the number of years increases, the salary also
increases. The chart also displays the salaries earned by men and women. In this
example, the chart reveals that men consistently earn more than women.
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1 3 5 i 7 g
Experience
Figure 8-21 A scatter chart displaying the average salaries by years of
experience

About bubble charts

A bubble chart resembles a scatter chart, but uses bubbles instead of data points.
You choose a bubble chart instead of a scatter chart if you have three values per
data point. For example, Figure 8-22 shows a bubble chart that plots the retail
against the wholesale prices of products, calculates the discount, and uses the size
of the bubbles to show the amount of the discount. The color-coding of the bubble
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identifies the product type. Bubble charts typically describe financial data. Use a
bubble chart when you want to represent data using more than two values.

% Discount by product type
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Figure 8-22 Displaying discount percentage for product types

About difference charts

A difference chart typically shows variation between two sets of data by shading
the areas between points of comparison. You use a difference chart when you
want to use shading and multiple graphs to accentuate the deviation between
data variables. The chart shown in Figure 8-23 displays the lead time between the
shipped date and the required date from the order date.

Order Shipment Lead Times

woo

- Lead Time
Shipped After

Days from Order

— MW e h oM -

10208 10208 10210 10211 10212 10213 10214
Order Number

Figure 8-23 A difference chart displaying the time taken to ship orders
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Modifying charts in Interactive Viewer

The basic characteristics of a chart are determined in the report design. You can
modify the chart in Interactive Viewer in the following ways:

m Change the chart subtype
m Filter data
m Format the chart

To choose any of these options select the chart to highlight it, then right-click the
chart area to display the context menu containing these options.

Changing chart subtype

Area charts, bar charts, cone charts, line charts, pyramid charts, and tube charts
have a stacked subtype and a percent stacked subtype. In a stacked chart, the data
points from one value series are arranged on top of the data points of another
series. You can choose the percent stacked subtype to show the contribution of
individual items to the whole.

If a type of chart offers subtypes, you can change the subtype in Interactive
Viewer. Many chart types offer two-dimensional subtypes, in which the chart
shape appears flat against the chart background. You can also display some charts
in two dimensions with depth, or three dimensions. A chart with depth appears
to have added dimension.

How to modify the chart subtype

1 Select the chart to highlight it. From the context menu choose Change
Subtype.

2 On Chart Subtype choose an option from the available subtypes. Choose OK
to apply your selection.

Filtering chart data

You can filter chart data in the same way that you apply filters to data in any
report column. In a chart you can filter data on the x-axis or the y-axis. Select the
chart, then choose Filter from the context menu. Chart Filter appears, as shown in
Figure 8-24. Complete the steps to apply filters that define what data is displayed
on the axes of the chart.
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The column to evaluate
The comparison operator
The value to which to compare

Filter

Filter By: Sale Amount
Condition: Equal To
alug: Select Values

Advanced Filker | Clear Filker

.

Figure 8-24 Creating a filter condition for a chart

You can set limitations on the data that the chart displays by applying a filter in
the same way that you would for any report column. You can also change an
existing filter condition or add conditions by choosing Advanced Filter from
Chart Filter, as shown in Figure 8-25.

Advanced Filter =
Filter By: Sale Amount =
Condition: Equal To —

©) specify literal value (O Use value From data Field

Walue! Select Values

Add Condition  Chanoe Condition

Filter conditions

| ne | ——Logical operators

?
Figure 8-25 Adding and modifying a filter condition for charts

Filters:

Formatting the chart

Charts include many different visual elements as shown in Figure 8-26. You can
customize the appearance of many of these elements using Interactive Viewer. To
clarify the presentation of data, or to create a more pleasing composition, you can
rearrange the layout of the chart. Some of the formatting for a chart, such as the
colors of the bars in a bar chart and the background color of the chart, are defined
in the original report, and cannot be modified. When viewing the report you can
modify the fonts and font sizes of the chart title and axis labels, and the height
and width of the chart. You can hide axis labels, place labels at an angle relative to
the axis, and hide the legend or determine where to display the legend in relation
to the chart. Depending on the type of chart you are working with, you can also
transpose the axes in some cases.
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Figure 8-26 displays the elements of a basic bar chart that you can format using
Interactive Viewer. In this example, the category series consists of a set of regions,
and the value series consists of a set of sales figure values.

y-axis title
y-axis labels
y-axis, for value series
Chart title

Sales by Region, 2008 D Chips 11
:l— Series labels
40,000 —~ [ ] Boards -+

30,000 —

Sales $

20,000 —+
10,000 -

-axis, f
0 x-axis, for

category series
North  South  East West x-axis labels

Regions x-axis title

Figure 8-26 Elements of a chart

As mentioned in an earlier section, a chart organizes data points into value sets
called series. Series can be of two types—a category series and a value series. The
category series typically determines what text, numbers, or dates you see on the
x-axis. The value series typically determines the text, numbers, or dates on the
y-axis. A value axis positions data relative to the axis marks. The value of a data
point determines where it appears on a value axis. You do not plot text on a value
axis. In most charts with axes, the x-axis is the category axis, and the y-axis is a
value axis.

The plotting options available for the x and y axes can differ in name and
function, depending on the chart type. For example, when you modify a meter
chart, which has no axes, you define the position of a needle on the dial instead of
defining the y-axis. When you modify a pie chart, you define the size of the slices
instead of the y-axis.

Using Interactive Viewer, you can change the titles of the axes, modify the scale of
the y-axis, and modify the labels on the x-axis, by changing the way the values are
displayed, and the existing interval. The following section describes how to
perform each of these tasks.
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Formatting the legend, title, and size of a chart

When you modify a chart, you can add a legend title, choose to display or hide
the legend on the chart, and determine the legend position. You can modify the
font, size, color, and style of the legend and in some cases legend items. You can
also choose to display or hide the chart title and modify the appearance of the title
text in the usual ways, by changing its font properties. In addition, you can
modify the chart’s size and the display dimension of a chart.

How to change the title of a chart
1 Select the chart, and choose Format Chart from the context menu.

2 On Format Chart, shown in Figure 8-27, in Chart, in Title, you can type a title
for the chart, or select Auto to enable Interactive Viewer to specify a title. To
specify font properties, select Title Font. On Font, specify the font, size, color,

background color, and style. You can Preview your selection in the next field.
Choose OK.

How to change the size of a chart

On Format Chart, in the Chart area, type the new values in the Width and Height
fields, then choose a unit of measurement from the next drop-down list. The
example shown in Figure 8-27 uses the unit of measurement, inches.

Format Chart x

« Chart
Title: Auto Title Font
Width: 7.5 inches v Height: 3.5 inches v
Dimension: 2D With Dep ¥ Flip Axis

« Legend

/| Show Legend Position:  Right b

« Category (X) Axis
/| Show Labels Labels Angle: 45.0
Stagger Labels Interval: |
= value (¥) Axis
i Bxis: 1 .
Title:
/| Show Labels Labels Angle: g

Stagger Labels Interval: |

Min: Max: Step Interval:

2
Figure 8-27 Formatting a chart

How to modify the dimension of a chart

Choose a dimension for the chart from the Dimension list. You can choose one of
the following:
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s 2D
m 2D with depth
s 3D

You can select two-dimensional subtypes for all charts. Choosing 2D displays the
chart flat against the chart background. When you choose the 2D dimension for a
column or bar chart, Interactive Viewer highlights the Use Glass Style field by
default. This option displays the chart with rounded edges in a column or bar
chart. Deselect this option to display a column or bar chart with sharp edges.
Choosing 3D displays the chart against an additional axis to the existing x and y
axes, providing greater depth. Choosing 2D with depth, also gives the chart an
appearance of depth.

Figure 8-28 shows an example of a bar chart with a dimension setting of 3D on the
left, and the same bar chart using a dimension setting of 2D with depth, on the
right. Three-dimensional charts show how an object on the z-axis changes
according to the x and y axes. The bar chart with two-dimensional depth setting
gives the appearance of a three-dimensional object, but is arranged on the x and y
axes only.
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$50K —— 1| 80K T
$0K Sprior Year | =/ Prior Year
$40K|
$0K

Figure 8-28 Comparing three-dimensional and 2D with depth bar charts

How to interchange the axes of a chart

To interchange the x and y axes of a chart, select Flip Axis in the Chart area on
Format Chart. You can flip the axes for some chart types. If this feature is
available for the chart type you are using, the Flip Axis box is visible.

How to format the legend of a chart

1 On Format Chart, select Show Legend to display a legend for the chart. If you
do not select this box, the legend does not appear on the chart. In Position,
select an option from the list to place the legend above, below, to the right, left,
or inside the chart.

2 Type a title for the legend. If you leave this field blank, no legend title appears
on the chart. In some cases, you can also specify font properties for the legend
title and each legend item.
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Formatting the x and y axes of a chart

You can use Interactive Viewer to modify axes titles of a chart, and the axis labels.
You can also delete axis titles, and suppress labels.

Changing the axis titles

Charts other than pie charts and meter charts can have x-axis and y-axis titles. To
add and format an axis title, navigate to Format Chart. You can hide the title of an
axis, or modify an existing title. On Format Chart, navigate to the y-axis section,
and type a title in the Title field. Then modify the font properties by choosing Title
Font.

Changing the axis labels of a chart

A chart displays axis labels by default, to the left of the vertical axis, and below a
horizontal axis. Using Interactive Viewer, you can specify whether to hide or
display labels, and modify the position and appearance of labels so that they are
easier to read. For example, you can rotate or stagger the labels on the x-axis so
that they are easier to fit on the chart and read. You can also modify the label font
by selecting Label Font and setting new font properties. Figure 8-29 shows an
example of the Format Chart dialog box.

Format Chart x

= Chart

Title: Auto Title Font

Width: 3 inches v Height: 3 inches v
Dimension: 2D With Dep ¥ Flip Axis
=~ Legend

Title:  Legend Title Font  Label Font

/| Show Legend Position:  Right »

« Category (X) Axis

Title: Tile Font  Label Font

| Show Labels Labels Angle: 0.0

Stagger Labels Interval: 1

« Yalue (¥) Axis
f Axis: 1 v

Title: Tile Font  Label Font

| Show Labels Labels Angle: g
Stagger Labels Interval: 1

Min: g Max: z4n000 Step Intervall 4ognn

’
Figure 8-29 Formatting the axes

Sometimes a chart displays so many values on an axis that the label text overlaps
and is not legible. You can rotate the labels at an angle relative to the axis or
stagger the labels, so that they do not overlap, as shown in Figure 8-30. For
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example, you can show data points for every third month, every ten days, every
other year, and so on. To change the label properties, navigate to Format Chart
and specify the values in the Category (X) axis title area.

How to modify the axes labels of a chart
On Format Chart, complete the following steps:

1 You can specify the title of value or y-axis for a chart. You can also specify the
title for an additional y-axis, if the chart contains more than one.

To display labels, select Show labels. To hide labels, deselect Show Labels.
To rotate the labels, specify a degree of rotation in the Labels Angle field.
To stagger labels, select Stagger Labels.

a A ON

If label names are too long, or if the chart looks too crowded when you display
all the labels, you can use Interactive Viewer to specify which labels to skip so
that only the other labels appear on the chart. To skip labels, set the Interval
value at which labels should appear. For example, to show every other label,
use an Interval value of 2. To show every fifth label, use an Interval value of 5,
and so on.You can also modify the font properties for labels by choosing Label
Font. The example in Figure 8-30 shows a chart on the left with staggered
labels, and one on the right with rotated labels.

Sales by Territory Sales by Territory

[+]
[+]
3 +: <
[+]

Figure 8-30 Staggered labels and rotated labels

Modifying scale

You can modify the scale of the value axis using Interactive Viewer to fit the data
that the axis displays. Category axes do not support scale changes. The scale
determines the range of values on a linear, logarithmic, or date-and-time axis. You
can use the axis scale to change the following settings:

m  Minimum and maximum values for an axis.

m Step Interval.

Chapter 8, Modifying charts 121



Step Interval is the interval between each value on the value axis or the
distance between major grid marks.

To set the scale of the y-axis, on Format Chart type values for minimum,
maximum, and step interval in the Value (Y) axis area. The chart on the left in
Figure 8-30 uses a scale between 0 and 240000 and a step value of 40000.

Drilling up or down data hierarchies in a chart

In some charts that contain hierarchical data, such as a chart in a cross tab,
Interactive Viewer supports drilling down into category or value series to view
more detailed data, or drilling up to view summary data. In a chart, drill-up or
drill-down capability is available for a category or value series. For example, if the
category axis of a chart displays location in regions, such as North America,
EMEA, APAC, and so on, you can select a region to view detailed data for that
region. You can then select each country in the region to view detailed data for
that country, and select each city to view details about sales, customers, and so on,
in the selected city. Similarly, you can drill up from a city view, to get a
summarized country view of the data, or a broader region view of the data.

In the following example, the category axis displays time in years. By selecting
the label for each year, you can drill down to view detailed data for each quarter
in the year and further to view details for each month in the quarter. Similarly,
you can drill up to view summarized data for the same hierarchies. You can drill
up from a month view, to a quarter view, or directly to a year view of the data in
the chart. This section also explains how you can perform a similar action on
hierarchical data in a value series.

How to drill down through a category series to view detailed information

1 In Interactive Viewer, select the chart. From the chart menu, choose Drill into
"Year,' as shown in Figure 8-31.

—
=y
£l Drill into “Year Column Chart Title

Filter 3

[11] <hange Subtype
Li| Format Chart

.
= Export Content

A0k

o

2003 2004 2005

Figure 8-31 Drilling into a year category

2 Categories appears listing the years for which data is available. Select a year
from the list as shown in Figure 8-32. Choose OK.
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Figure 8-32

Selecting a year
The chart displays data for the selected year, as shown in Figure 8-33.

=. T

Column Chart Title

1

2

Figure 8-33

Chart displaying data for two quarters in the year 2005

Drill into 'Quarter’.

To drill further into subcategories of the data, from the chart menu, choose

Categories appears listing the quarters for which data can be viewed. Select

the quarter for which you want to view detailed data, then choose OK.

The chart displays data for the quarter you selected.

How to drill up through a category series to view summary information

To drill up to a higher level in the data hierarchy, from the context menu shown in
Figure 8-34, choose Drill up to 'Quarter’, or Drill up to 'Year.'

1 Drill up to 'vear'

L Drill inko ‘Month'
Filker

JJJ Change Subtype
4| Fermat Chart

||_ Export Content

1 Drill up to 'Quarter’

»

Figure 8-34

Drill-up menu

The chart in the report displays the data for the selected category.

In the following example, the category axis displays the Product Line, and the

value axis displays sales. The data in the value series is grouped by year. You can
drill down to view sales by product line for each year, or tribally to view
summary information across years.
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How to drill down through a value series to view detailed information

1 In Interactive Viewer, select the chart. From the chart menu, choose Drill into
'year,' as shown in Figure 8-35.

£l Drilinto 'PRODUCTLINE'
Column Chart Title

= Drillinko 'year'

Filter 3

[11] Change Subtype
|4 Format chart

||_ Export Content

10,21

yRULLT

Classic Cars Motorcycles Planes Ships Trains Trucks and Buses  Vintage Cars

dh, 2003
:.Il 2004
2008

Figure 8-35 Drilling into time series

2 Series appears listing the years for which data is available. Select a year from
the list as shown in Figure 8-36. Choose OK.

Series x

Series: 2003 i
2003
2004
2005 i

Figure 8-36 Selecting a series value
The chart displays data for the selected year, 2005, as shown in Figure 8-37.

3 To drill further into subcategories of the data, from the chart menu, choose
Drill into 'quarter’.

4 Series appears listing the quarters for which data can be viewed. Select the
quarter for which you want to view detailed data, then choose OK.

The chart displays data for the quarter you selected.
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Figure 8-37 Chart displaying sales for each quarter in 2005

How to drill up through a value series to view summary information

To drill up to a higher level in the data hierarchy, from the context menu shown in
Figure 8-38, choose Drill up to 'year.' The chart in the report displays the data for
the selected series.

=L Drillinko 'PRODUCTLINE'
&7 Drill up to 'vear'
&) Drillint 'quarter’
Filker 3

1] Change Subtyps
|| Format Chart

||_ Export Content

Figure 8-38 Selecting an option to view summary data

Interactive Viewer supports drill-up and drill-down capability for the following
types of charts:

m Bar

m Line

m Area

m Pie

m Scatter

m Bubble

m Stock

m Difference

m Tube
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m Cone

m Pyramid

Working with drill-through hyperlinks in a chart

In addition to drilling down to view details, and drilling up to view summary
data, Interactive Viewer enables you to use drill-through hyperlinks present in a
chart to view external data on web sites, or in other reports. To view the
information that the link references, select the link. For example, the shipping
schedule report shown in Figure 8-39, links each order number to the
corresponding invoice. You can view the details of each invoice for orders that
were shipped, canceled, in process, or on hold. Select an order number for which
you want to view the invoice. Interactive Viewer displays the invoice for the
order number selected in Figure 8-39, as shown in Figure 8-40.

Shipping schedule
SHIPPEDDATE STATUS ORDERNUMBER CUSTOMERNUMBER)
=la1 2003
= Conceled Select order number
167 445
10248 131
10260 387
10262 141
Orders 4
=l
Process
10420 252
10421 124
10422 157
10423 34
10424 141
10425 119
Orders B
=1 On Hold
10334 144
10401 326
10407 450
10414 362
Orders
Orders 14

Figure 8-39 Drilling through the order number field

ey Classic Models, Inc
L= 2207 Bridgepointe Parkway

el san Mateo, CA 94404 Invou:e
Scandinavian Gift Ideas
Martha Larsson Order Date: 10/22/2003 i
Bkergatan 24 Ship Date: |r_]VOICe
Bracke 5-B44 67 order: 10167 displayed for the
Sweden Cust Mot 448
Sales Rep: Barry Jones SeIECted order

number

D tion Ity ) t Unit Price
S10_4757 1972 Alfa Romeo GTA 44 $136.00 9.00% 123.76 E,445.44
S18_1662 19805 Black Hawk Helicopter 43 $157.69 10.00% 141.92 6,102.56
S18_3020 1999 Yamaha Speed Boat 46 $£86.02 19.00% 69.68 3,205.28
S18_3856 1941 Chevrolet Special Deluxe Cabriolet 34 $105.87  20.00% 84.70 2,879.80
Figure 8-40 Invoice linked to from each order number
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Switching views between a chart and a report element

If data in a report table or a cross tab is also represented graphically in a chart, in
some cases you can switch between the chart view of the data, and the tabular
view of the data, using Interactive Viewer. The report developer must set this
option when designing the report element and chart, for a user to be able to
switch views in Interactive Viewer.

How to switch between a table and chart view of data

In Interactive Viewer, select the table, and choose Switch View from the main
menu. The chart view of the data appears.

If you are working with a cross tab, choose Switch View from the context menu.
You can also further Analyze the data in a cross tab, by choosing the Analyze
option from the context menu. The cross tab is appears in BIRT Data Analyzer if
you have purchased this licensed option.

Similarly to switch back to the table view, choose Switch View from the chart
menu, as shown in Figure 8-41. The table or cross-tab view of the data appears.

Header 3
Group (3
Column 3
=] Aggregation
Filter 3
Sart 3

Alignment 3

Format 3

“_ Export Content

Figure 8-41 Selecting switch view

Exporting data from a chart

You can export data from a chart to a flat file format, that uses a comma, tab, pipe,
or semicolon delimiter. These file formats can be read by Microsoft Excel.
How to export data from a chart

Select the chart, and choose Export Data from the chart menu. On Export Data,
specify the data to export, and other options, in the same way you did when
exporting report data.

Exporting a chart

You can export a chart to Excel, Excel 2007 and 2010, Microsoft Word, Microsoft
Word 2007 and 2010, Microsoft PowerPoint, Microsoft PowerPoint 2007 and 2010,
PDEF, PostScript, and XHTML formats.
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How to export a chart to other formats

Select the chart, and choose Export content from the chart menu. On Export
Content, specify the options in the same way you did when exporting report
content. Additionally, you can specify:

m  Resolution in DPI at which to export the chart

m Exporting the chart as an image

Modifying Flash charts and gadgets

Standard charts display data statically. Flash charts can have animation or other
features that Flash provides. Flash charts are similar to standard charts, and are
used in the same manner. Flash gadgets are a chart-like set of visualizations that
generally display a single value, such as a meter or a gauge.

Flash charts and gadgets add animation and other visual elements that display
data in a manner that is easy to understand. Gadgets differ from charts in that
they generally only display a single value or a set of independent values and can
represent less complex sets of data.

If your report contains Flash charts and gadgets, you can use Interactive Viewer
to modify the subtype of the chart or gadget, format the information that the chart
or gadget illustrates, create filters for chart or gadget data, and export chart or
gadget data, in a manner that is similar to performing these actions for standard
chart data.

The example in Figure 8-42 shows a doughnut chart on the left, and a segmented

doughnut chart on the right.
rawth
W Ymergng Markets

International Growth International

Emerging Markets

Real Estate Secur Feal Estate Secur

G
Large/Mid Cap cpe—/ ’
Mutual Fund Large/Mid Cap Tech Mutual Fund

Large/Mid Cap cpe—/

Large/Mid Cap Tech

Figure 8-42 Regular and segmented doughnut Flash chart

Sometimes, based on the type of Flash chart or gadget you use, additional options
are available in the context menu. For example, if you use a pie or doughnut
chart, you can enable rotation, or enable slicing-off of the segments of the chart
when you choose each segment. If you use a Flash bar chart, you can move the
labels by dragging them from their original position and dropping them in a new
position.
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Using Flash gadgets

You can work with meter, linear gauge, cylinder, thermometer, bullet, and
sparkline gadgets using Interactive Viewer. The following section describes these
gadgets and shows examples of each type of gadget.

Meter gadget

A meter is similar to the speedometer or fuel gauge of a car. It uses a radial scale
to display the data range, and a dial to indicate the data value. A meter displays
the specific data, utilizing an indicator that moves within a circular range to
indicate whether the monitored data is within defined limits. You can select
colors for the data range to suit the application, such as green for satisfactory,
yellow for caution, and red for alarm.

You can convert meter gadgets into linear gauge gadgets as described later in this
document. The example in Figure 8-43 shows shipped orders illustrated using a
meter gadget.

Shipped Orders

e
F1.5M o T $3.50

$5 Mt

Shipped Orders |Cancelled Orders |In Process Orders |Disputed Orders (OnHold Orders [Resolved Orders [Total Orders
I§ 8,022,204.26 $41,445.21 Ih 13,488 54 $0.00 f 146,561.44 % 2958060 I 2,272,280 05

Figure 8-43 Meter gadget

Linear gauge gadget

A linear gauge is a slider gauge with many additional features. It uses a
horizontal scale to display your data range and fully configured data needles to
indicate data values.

You can convert linear gauge gadgets into meter gadgets. The example in
Figure 8-44 uses a linear gauge to illustrate the amount for resolved orders.
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Resolved Orders

0 10K F2OK  F20k F40k SO0k FEOK FFOK  F20k FAOK F100K

On Hold Fesolved Total
Orders Orders
§ 39,580 60 § 3,272,280 05

Shipped Cancelled In Process Disputed
Orders Orders Orders Orders Orders
§3,032,200.26  [§ 41,4521 b 13,488 54 5 000 b 146,551 44

Figure 8-44 Linear gadget

Cylinder gauge gadget

A cylinder gauge is represented by a vertical cylinder, whose fill level is
indicative of the data to be displayed. It is used to show inventory levels, power

plant reports, and fuel levels.

You can convert cylinder gadgets into thermometer or bullet gadgets, as
described later in this document. The example in Figure 8-45 uses a cylinder
gadget to illustrate the amount for orders that are on hold.

Orders on Hold

Disputed Orders [OnHold Orders |[Resolved Orders [Total Orders

‘Shipped Orders |Cancelled Orders (InProcess Orders
F 14656144 F 29,580.50 $ 2,272,28005

§ 3,032,204 26 F 4144521 5 13,488 54 3 000

Figure 8-45 Cylinder gadget

Thermometer gadget

A thermometer gadget, as the name implies, displays temperatures. The fill level
of the thermometer indicates the data to display.
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You can convert thermometer gadgets to cylinder gadgets or bullet gadgets, as
described later in this document. The example in Figure 8-46 shows a
thermometer gadget illustrating the amount for cancelled orders.

Cancelled Orders

F3E0K
FI5K
$280K

$41.45K

Disputed Orders (OnHold Orders |Resolved Orders [Total Orders

Shipped Orders |Cancelled Orders [InProcess Orders
5 146,561.44 5 39,580.60 $ 3,273,280.08

§ 303220428 6 4144521 i 12,488 54 5 0.00

Figure 8-46 Thermometer gadget

Bullet gadgets

A bullet gadget is a variation of a bar chart and serves as a replacement for
dashboard gauges and meters. Bullet gadgets overcome the issues of gauges and
meters, which typically require too much space, and are cluttered with distracting
decoration. There are horizontal and vertical bullet gadgets. You can convert
bullet gadgets into cylinder gadgets or thermometer gadgets, as described in this
document. The example in Figure 8-47, shows a horizontal bullet gadget,

illustrating the amount for orders in progress.

Orders in progress

_ $13 e

e (O S R (R |
FO0 F2K B4 B6K F3K F10K F12k F14k 16k F18k F20K

On Hold Resolved Total
Orders Orders
4 39,580 60 $ 3,272,280 05

Shipped Cancelled Tn Process Disputed
Orders Orders Orders Orders Orders
§3,032,200.26  |§ 41,445 21 § 13,488 54 $ 000 b 145,561 44

Figure 8-47 Bullet gadget
Sparkline gadget

Sparkline gadgets are data-intense, design-simple, word-sized graphics charts for
embedding in a context of words, numbers, and images. Whereas the typical
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chart shows as much data as possible, and is set off from the flow of text,
sparkline gadgets are succinct, memorable, and located where they are discussed.
The use of sparkline gadgets inline typically means that they are about the same
height as the surrounding text. Also, sparkline charts can be used in
space-efficient executive dashboards to show a lot of KPIs in a single view.

Sparkline gadgets have no subtypes. The example in Figure 8-48, shows a
sparkline gadget illustrating the volatility of a stock portfolio.

Figure 8-48 Sparkline gadgets

Modifying the subtype of a Flash chart or gadget

You can modify Flash charts in the same way that you modify a standard chart.
Similar chart subtype options are available in the standard chart subtype and
Flash chart subtype menus. For Flash gadgets the available subtypes depend on
the gadget. For example, you can change the subtype of a meter gadget to a linear
gadget, or change the subtype of a bullet gadget to a cylinder or thermometer
gadget.
How to modify the subtype of a Flash chart

1 To change Flash chart subtypes, select the chart or gadget to highlight it, then
choose Change Subtype from the chart menu.

2 On Chart Subtype, select a subtype, then choose OK.

How to modify the subtype of a Flash gadget

1 To change Flash gadget subtypes, select the gadget to highlight it, then choose
Change Type from the gadget menu.

2 On Flash Gadget Type, select the subtype.

The example in Figure 8-49, shows how you can change the subtype of a meter
gadget to a linear gauge.
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Hash Gadget Type x

;’

Linear Gauge

)
Figure 8-49 Changing subtype of a meter gadget

In the example in Figure 8-50, you change the subtype of a cylinder gadget to a
bullet, or thermometer gadget.

Flash Gadget Type x
Thermometer Bulle-t .
,
Figure 8-50 Changing subtype of a cylinder gadget
Choose OK.

Formatting a Flash chart

You can format data in Flash charts in the same way that you format data in a
standard chart.

You can modify the font used for the chart title, the axes, the legend, and the
Tooltip of a chart. The font used for the Tooltip is called the base font. The font
used for the chart title, axis labels, and legend is known as outside font.

You can specify the font type, size and color for base fonts and outside fonts.

How to format a Flash chart

To format a Flash chart, select the chart. Then, choose Format Chart from the chart
menu and modify the information on Format as needed.

Choose OK.

Formatting a Flash gadget

Each gadget has a different set of formatting properties, which change specific
aspects of the gadget’s appearance. For each Flash gadget you can modify a set of
general formatting options, as well as needle, plot, scale, region, tick marks, and
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value properties. Figure 8-51 displays the formatting options visible for the linear
gadget in the example.

Resolved Orders
Plot value
539'5% ‘“;“‘ Needles
u Regions
— Tick marks
F0 FA00K 200K F1.2M F16M  F2W F2IM F2.8M F22M FI6M FI
— Scale
Figure 8-51 Formatting options displayed for a linear gauge gadget

Figure 8-52 and Figure 8-53 display the Format Chart dialog box for the linear
gadget in the previous example.

Format Flash Gadget b 4

= Flash Gadget

Width 4 inches v
Height 5 e =
Font Atial ¥ 10 ¥ | Ao hd

Shaow Tooltip

13

Needle
Showe Meedle value Ahiove MNeedle v

Show Needle On Top -

»

Scale

Show Yalue
] Auto values
Minimum Yalue 0

Mazimum Y alue 100000

« Region

a = Add

;

Figure 8-52 Formatting a Flash gadget dimensions, needle values, and scale
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Figure 8-53

Formatting a Flash gadget region and tick marks

The following section describes the formatting options you can modify for each

type of gadget.

Modifying general properties

General properties of a gadget control overall appearance, such as color, size, and
font properties. General properties can also define the title text, Tooltip, and
orientation for specific gadget types. Table 8-1 describes the general formatting
properties available to specific gadgets, and their usage.

Table 8-1 Formatting general properties

Option Gadget Usage

Color Bullet, cylinder, Sets the color of the gauge.

thermometer

Font All Set the font type, size, style, and
color of displayed values. You
can select a standard color
using color picker, or specify a
custom color.

Height All Specifies the height of the
gadget.

Orientation Bullet Specifies whether to display the
gadget horizontally or
vertically.

Title Sparkline, bullet Adds a title to the gadget.

Tooltip Linear gauge, meter Specifies text for the tooltip.

Width All Specifies the width of the

gadget.
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Modifying needle properties

Needle properties define the position of a needle. A needle appears only in a
linear gauge and in a meter gauge. Table 8-2 describes the needle properties you
can modify in Interactive Viewer.

Table 8-2 Formatting needle properties
Option Gadget Usage
Show Needle Linear gauge, meter Specifies the position of the
On needle.
Show Needle Meter Displays or suppresses the
Value value to which the needle

points, and specifies the display
position for the values.

Modifying plot properties

Plot properties control the appearance of elements in the data plot area of bullet
and sparkline gadgets. In both gadgets, you can specify whether to display or
hide plot values.

Additionally, in a sparkline gadget, you can specify whether to display the open,
close, lowest, or highest values. Table 8-3 describes the plot properties you can
modify using Interactive Viewer.

Table 8-3 Formatting plot properties
Option Gadget Usage
Show Close Sparkline Enables and disables the
Value display of the close value.
Show Highand Sparkline Enables and disables the
Low Values display of the high and low
values.
Show Open Sparkline Enables and disables the
Value display of the open value.
Show Plot Bullet, sparkline Displays or suppresses the
value plotted values.

Modifying scale properties

Scale properties define the range of values and the number of tick marks that a
gadget displays. The scale properties affect the numbers displayed on the gadget,
not its size. Minimum Value and Maximum Value specify the lowest and highest
numbers, respectively. However, if the data set value (represented by the needle
value) is lower than the minimum value or higher than the maximum value, the
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minimum or maximum value is ignored. Table 8-4 describes the scale properties
you can modify using Interactive Viewer.

Table 8-4 Formatting scale properties
Option Gadget Usage
Auto values All Enables a scale to be specified

by Interactive Viewer.

Maximum All Sets the highest value of the
Value scale.
Minimum All Sets the lowest value of the
Value scale.

Show values

Cylinder, meter, bullet,
linear gauge

Shows values of the scale.

Modifying region properties

Region properties enable the division of the data plot into regions. Use regions to
provide more information about values in a gadget. Table 8-5 describes the region
formatting properties you can modify in Interactive Viewer.

Table 8-5 Formatting region properties
Option Gadget Usage
Color Linear gauge, meter, Specifies the color of the region.
bullet
End Value Linear gauge, meter, Specifies where the region
bullet ends.
Label Linear gauge, meter, Specifies the name of the
bullet region.
Region Linear gauge, meter, Chooses the region for which
bullet the settings apply. You can also
add or remove a region from
the list.
Start Value Linear gauge, meter, Specifies where the region
bullet starts.
Show Labels Linear gauge Displays or suppresses the

region labels.
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Modifying tick marks

Ticks properties define the position and count of tick marks on a gadget. Tick
marks can appear in the positions listed in Table 8-6.

Table 8-6 Formatting tick marks
Option Gadget Usage
Auto Adjust All but sparkline Enables or disables tick marks
Tick Marks created evenly across the scale.
Position Cylinder, thermometer Positions tick marks on the

Position Above
Position Below
Position Left

Show Tick
Marks

Show Tick
Values

Major
Tickmarks
Count

Linear gauge, meter,
bullet

Linear gauge, meter,
bullet

Cylinder, thermometer

Linear gauge, meter,
bullet, cylinder,
thermometer

Linear gauge, meter,
bullet, cylinder,
thermometer

All but sparkline

right side of the gadget.

Sets tick marks to appear above
the gadget.

Sets tick marks to appear below
the gadget.

Positions tick marks on the left
side of the gadget.

Enables or disables the display
of tick marks on the gadget.

Enables or disables the display
of values on tick marks.

Specifies the number of tick
marks to display on the scale.

Modifying the value property

You can also display or hide the value in a cylinder or thermometer gadget, as
described in Table 8-7.

Table 8-7 Formatting the value property
Option Gadget Usage
Show Value Cylinder, thermometer Displays or hides the value

illustrated in the gadget.

How to format a Flash gadget

To format a Flash gadget, select the gadget. Select Format Flash Gadget from the
gadget menu and modify the information on Format as needed.

Choose OK to apply your selection.
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Filtering data in a Flash chart or gadget

You can also create filters for chart and gadget data in the same way you do for
standard charts. You can limit the appearance of data on a chart or gadget by
setting filters for the chart or gadget data.

How to filter data in a Flash chart or gadget

Select the chart or gadget, and choose Filter from the chart or gadget menu.
Create conditions as needed. To define more than one condition, choose
Advanced Filter and modify the options in the same way you did when creating
filters for report data.

Drilling up or down data hierarchies in a Flash chart

Interactive Viewer supports drilling up to view summary information and
drilling down to view details for the following Flash chart types:

s Column

m Bar

m Line

m Pie

m  Doughnut

Drilling up and down data hierarchies in a Flash chart function the same way as
for regular charts. For more information about drilling up and down data
hierarchies, see “Drilling up or down data hierarchies in a chart,” earlier in this
chapter.

Exporting data from a Flash chart or gadget

In Actuate 11 and later releases, you can export data from a Flash chart or gadget
to a flat file format, that uses a comma, tab, pipe, or semicolon delimiter. These
file formats can be read by Microsoft Excel.

How to export data from a Flash chart or gadget

Select the chart or the gadget, and choose Export Data from the chart or gadget
menu. On Export Data, specify the data to export, and other options, in the same
way you did when exporting report data.

Exporting a Flash chart or gadget

Using Interactive Viewer, you can export a Flash chart, or gadget to PDF format.
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How to export a Flash chart or gadget

Select the chart or the gadget, and choose Export content from the chart or gadget
menu. On Export Content, specify the options in the same way you did when
exporting report content. Additionally, specify the resolution in DPI at which to
export the chart or gadget.

Printing a Flash chart or gadget

Interactive Viewer enables you to print a flash chart or gadget.

How to print a Flash chart or gadget

Select the Flash chart or gadget. From the context menu, choose Print Chart and
specify the printer to which you want to send the print job.

Using effects

In some types of Flash charts, you can use the context menu to set or modify
visual animation effects. For example, in a pie or doughnut chart, you can specify
the following properties:

m Enable rotation of the pie or doughnut.
This option causes the pie or doughnut to rotate.

m Enable slicing movement.

This option causes each segment of the pie or doughnut, appears to slice away
from the original chart.

Modifying Adobe Flash Player options

This section describes how to modify Adobe Flash Player to display redraw
regions, debug and correct scripting errors, change the settings of the Flash
player, and get more information about the version of Adobe Flash player
currently in use. To get more information about your version of Adobe Flash
player, select the chart or gadget, then choose About Adobe Flash Player from the
context menu.

Displaying redraw regions

A redraw region is the area around a chart or gadget that is redrawn when that
object changes. Everything in a redraw region is redrawn during the next
rendering phase after an object changes. Displaying a redraw region provides you
with information about changes made to the Flash chart. Sometimes Flash Player
combines several closely-spaced objects together in a single redraw region,
improving performance speed of the objects being rendered.
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To display redraw regions, select the chart or gadget, and choose Redraw region
from the context menu. A red box appears on the object showing the redraw
region.

Using the debugger option

You can use this option to debug and correct errors that occur in the scripts and
code that run Flash charts and gadgets. To use the debugger option, select the
chart or gadget, and choose Debugger from the context menu.

Modifying settings

You use this option to customize Adobe Flash player settings based on your
requirements. You can modify display, privacy, local storage, microphone, and
camera settings. To modify Flash Player settings, select the chart or gadget, and
choose Settings from the context menu. Make the modifications on the Adobe
Flash Player Settings dialog box that appears. Choose Close.

Chapter 8, Modifying charts 141



142 Working with Actuate BIRT Viewers



Modifying cross tabs

This chapter contains the following topics:

About cross tabs

Formatting cross-tab data
Analyzing cross-tab data
Exporting cross-tab content
Modifying charts in a cross tab
Printing a cross tab

Saving a cross tab
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About cross tabs

A cross tab displays summary, or aggregate values such as sums, counts, or
averages, in a row-and-column matrix similar to a spreadsheet. For example, you
can use a cross tab to view sales data for each product line, by year, or total sales
for each product line, by geography, and so on.

In Interactive Viewer, you can modify and format a cross tab to change the
appearance of specific data values. You can also display detail information for
data values to view important summary information at a glance. You can export
cross-tab content to other formats such as Excel, Word, PowerPoint, PostScript,
PDEF or XHTML. You can also print cross tab content, modify charts, flash charts
and flash gadgets in a cross tab, and save a cross tab as a BIRT design (.rptdesign)
or BIRT document (.rptdocument) file.

If you need to drill further to analyze the data in various situations, you can
launch Actuate BIRT Data Analyzer, which enables you to manipulate the data in
the cross tab, create a pivot table of cross-tab data, and display more detailed
information for the existing data.

Introducing a cross tab

A cross tab is ideal for summarizing data in a compact and concise format. The
aggregate values in a cross tab are arranged in dimensions and measures, and
each cross tab can display multiple dimensions and multiple measures. The data
for a cross tab is derived from a cube, which also arranges data in dimensions and
measures. Dimensions are categories, such as products, customers, or sales
periods, by which measures are aggregated. Measures represent values that are
counted or aggregated, such as costs or units of products.

A cross tab has the following characteristics:

m [t requires at least three fields. In the example cross tab shown in Figure 9-1,
the three fields are year, product line, and revenue.

m  One field populates the column headings in the cross tab. There is one column
for each unique value in the field.

m  One field populates the row headings in the cross tab. There is one row for
each unique value in the field.

m  One field's values are aggregated, and these values populate the cells of the
cross tab. In the example, each cell displays a sales total by product line, for
each month and quarter, in the year 2004. The sales total is calculated by
applying the SUM aggregate function across the values in the extended price
field.
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Parts of a cross tab

A cross tab consists of the following three areas, as shown in Figure 9-1:
m The row area

m  The column area

m The detail area

The row and column areas contain the dimensions. The dimension values form
the row and column headings of the cross tab. The detail area contains one or
more measures to display aggregate data.

In the example report shown in Figure 9-1, data is grouped by month, quarter,
and year. Each number in the cross tab represents the sales total of a particular
product for a particular month. Grand Totals display the total sales of all products
for each month, the total sales for each quarter, and the total sales across months
and quarters in 2004. Grand Totals also display the total sales for each product
line by month, quarter, and for the whole year.

Rows /—Col umns
/_ Classic Cars | Motorcycles | Planes. Ships Trains || Trucks and Buses | Vintage Cars Grand Toial
! 4 Revenue Revenue Renernue
Year/QTR/Month
- EE

342,909 4256378 |
§45550  $302021
3202 395
£760,/30
200,269
4222036
$152,574
$585879) | —Detail area
386,082
355,964
$306,755
1 61,048,801
1540642
§925,713
$426,838
0 $1,005,1957
$573,998 4,300,603

9822,028 $4.300,503]

682, 5 $448.703
Grand Total | 51,682, F443,703

Figure 9-1 Parts of a cross tab

Formatting cross-tab data

You can use Interactive Viewer to improve the presentation of data in a cross tab.
You can modify the appearance of the dimensions and measures in a cross tab by
specifying formatting properties. For example, to indicate that the numbers
displayed in the cross tab are currency amounts, you apply the currency format
that displays a currency symbol alongside the amount. It is also easier to read the
numbers if they are aligned to the right. Using color, you can differentiate the
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product line subtotals that run horizontally across the report, from the quarterly
and yearly grand totals that run vertically down the report.

In Interactive Viewer, you can change the appearance of data in a cross tab in the
following ways:

m Format data and labels by specifying font properties, and text alignment for a
label, data element, or for the cross tab.

m Change the width of a column or the height of a row.

m Format data strings depending on the type of data in the data element.

Selecting a cross-tab element

To view available formatting options, select a cross-tab element. From the context
menu, choose Format, or Alignment to view the formatting options for the
selected element. For example:

m To format a label, select the label, then from the context menu, select a
formatting option.

m To format the data in a column, select a cell in the column, then from the
context menu that appears, select a formatting option.

m To format the values in a group, select a cell in the grouped column, then from
the context menu, select a formatting option. When you select a column to
modify, the changes you specify are applied to the data values in each data
group. If you choose the group at the highest level, the data values in this
group are formatted based on the options you select. You must choose each
group to specify formatting options for that group level. You can also specify
formatting properties for the group label for each group.

Changing font properties and alignment

Using Interactive Viewer, you can change the font properties and alignment of
values in cross-tab elements, including dimension and measure labels and data
values. The properties you can modify include the background color, font color,
size, and type. A value of Auto indicates that the default value applies. You can
also specify whether to display the font in bold, italic, or underlined style.

How to change font properties
1 Select a cross-tab element. From the main menu, choose Format>Font.
Font displays the current font property values, as shown in Figure 9-2.
2 On Font, specify the new properties as follows:

m  Use the drop-down lists to modify the font properties for the selected
element.
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m  Choose an option to apply bold, italic, or underlined style.
Choose OK.

Font x
Fonk: Size::

Auto w | Auko LY
Color: Background Color:

Auto ~ | Auko »
B I u

‘ Preview |

5
Figure 9-2 Specifying font properties

How to change text alignment

Select a cross-tab element. From the context menu, choose Alignment->Left,
Alignment->Center, or Alignment->-Right.

Reverting to default formats

To revert a cross-tab element back to its default font formats, select the cross-tab
element. From the main menu, choose Format>Font. Select Auto from each
drop-down list. To reset text alignment, select the element, and choose the
appropriate alignment option.

If you applied a number format to data, you can restore the formats to those in the
original cross tab. Select the data cell. From the context menu choose
Format>Format Data. Then, select Unformatted from the drop-down list.

Displaying details about data values

To view details about cross-tab data, select a cell in the data area. From the context
menu, choose Show Detail Tooltip as shown in Figure 9-3.

=% Show Detail Toolkip

Alignment
Format

2 Analyze

.. Export Content

Figure 9-3 Choosing Show Detail Tooltip from the context menu

Now when you select any cell in the display area of the cross tab, the Tooltip for
that data value appears. A Tooltip displays the column and row level details, the
measure value, and the aggregate function that applies for the selected cell, as
shown in Figure 9-4.
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Detail

Row Level

year: Year/QTRMonth
quarter: 3

month: 7

Column Level
PRODUCTLINE: Trains

Figure 9-4 Detail information for the selected cell

Displaying this detail Tooltip information is especially useful if you are analyzing
data in a large cross tab where you cannot simultaneously view the column
heading, row heading, and data cell in your browser window.

To return to the regular view, select any cell in the display area, and choose Hide
Detail Tooltip from the context menu.

Changing the width of a column or height of a row

You can optimize the layout of a cross tab by changing the width of cross-tab
columns and the height of rows. Using this option enables you to eliminate the
extra space when you print or export the cross tab to other formats, and also
creates additional space to avoid truncated column entries in the cross tab.

How to change column width

Select any cell in the cross tab. Hover the mouse pointer on the right or left border
of the highlighted cell, as shown in Figure 9-5. Using the mouse pointer, drag the
border outward or inward to increase or decrease the width of the selected cell.
The modified width applies to all rows in the column.

1}
4

11 Lal

172 Analyze

Classic Motorcycles Planes  Ships  Trains  Trucks and  Vintage Grand
Cars Buses Cars Total

Year,"q‘TRfMunth n 109,362 $30087  §3L,150  §26310  $83%7 §42,000 $256,315
=004 $103,333 = | $45694  $34000  $24304  $4763 $35,749 §48 623 $302,021
99,512 — $15,559  $9.870 32,193 §45,252 $202,395

$317.307 $85,68 66,763 521,029 $67.942  $136,849  $760,730

$29 958 $32329  §33882 10808 §33,352 $200,269)

70,608 §47973 §3530E §3.440  §4362 $31,729 §38,536 $233,036]

46,025 §16,472 $41,967 §42,110 $152,574

F206,722  §80,101 $65,780 $30,71% §4,862 $73.696 £119,998 $585,879

Figure 9-5 Modifying column width in a cross tab

How to change row height

Select any cell in the cross tab. Hover the mouse pointer on the top or bottom
border of the highlighted element, as shown in Figure 9-6. Using the mouse
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pointer, drag the border up or down to increase or decrease the height of the
selected element. The modified height applies to the entire row.

v 11 ey

I3 Analyze

Classic Motorcycles Planes = Ships  Trains  Trucks and Vintage Grand
Cars Buses Cars Total
YearfQTR/Month $109,562 $39,957 $31,159 $26,310  $6,387 $42,909 $236,315
2004 S+
2 $108,232 $45,604  §34000 24894 $4763 35,749 45, 628 $302,021

$99, §15550 49,79 32,103 445,252 $202,305

1 $317,307 $85,682 §65,159 $66,763 521,029 $67.942  $136,849  $760,730
Total

Figure 9-6 Modifying row height in a cross tab

Analyzing cross-tab data

You can use BIRT Data Analyzer to manipulate a cross tab to analyze its data.
Using BIRT Data Analyzer, you can answer questions such as:

m  What are the sales for product A over time?
m  How do total sales break down by product?
»  How many units of product B shipped to all locations in April?

You can add, remove, reorganize, and customize the data and its appearance in
the cross tab to examine relationships and trends. Using BIRT Data Analyzer, you
can perform the following tasks:

m Filter, group, and sort data
m Format a cross tab
m Perform calculations

To launch BIRT Data Analyzer, select any cell in the cross tab, then from the
menu, choose Data Analyzer.

For more information about BIRT Data Analyzer, see Using BIRT Data Analyzer.

Exporting cross-tab content
You can export cross tab content to other formats, such as Excel, PDF, PostScript,

PowerPoint, Word, and XHTML, just as you can export content from a BIRT
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report. When you export a cross tab to Microsoft Excel, Excel displays the cross
tab as a pivot table, in which you can further analyze existing data.

For more information on exporting content, see “Exporting content” in Chapter 4,
“Exporting report data and content.”

Modifying charts in a cross tab

You can modify charts present in a cross tab in Interactive Viewer, similar to how
you would for a regular chart.

For more information on modifying charts, see “Modifying charts in Interactive
Viewer” in Chapter 8, “Modifying charts.”

For information on modifying Flash charts and gadgets, see “Modifying Flash
charts and gadgets,” in Chapter 8, “Modifying charts.”

You can also sometimes switch views between a cross tab and chart, if this option
was enabled at the time of creating the cross tab in BIRT Designer Professional.
For more information on switching views, see “Switching views between a chart
and a report element,” in Chapter 8, “Modifying charts.”

Printing a cross tab

=

You can print a cross tab just as you can print a BIRT report. For more information
on printing a cross tab, see “Printing a report” in Chapter 2, “Navigating a
report.”

Saving a cross tab

Sometimes you need to save a modified cross tab, to use later, or make it available
for other users to view and modify. In Interactive Viewer, you can save a modified
cross tab just as you save a BIRT report. You can save a cross tab to the following

file types:
m Actuate BIRT report document (.rptdocument) file
m Actuate BIRT design file (.rptdesign) file

For more information on saving a cross tab, see “Saving a report” in Chapter 2,
“Navigating a report.”
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Modifying summary
tables

This chapter contains the following topics:

m  About summary tables

m Editing and formatting summary-table data

m Organizing data in a summary table

m Creating a computed column in a summary table
m Filtering data in a summary table

m  Modifying a chart in a summary table

m Saving a modified summary table
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About summary tables

A summary table presents aggregate or summary information in a report,
providing users with a concise view of the data at a glance. The aggregate
information displayed in a summary table is typically displayed in the table
header or footer, or the group or section header or footer in a detail BIRT report. A
summary table is particularly useful when a user needs to work with large
volumes of data, because the calculations are made at the data source level,
making only the computed data visible to the user. Report developers can create a
summary table using Actuate BIRT Studio or BIRT Dashboards by simply
selecting the relevant data fields in the correct order, and inserting them into the
report design. A summary table report can provide users with information such
as Sales by Territory, or Sales by Employee, or Sales by Employee, by Territory.

Although hiding details for a group in a detail table can achieve the same
presentation of aggregate information as a summary table, improved
performance and reduced server load are a few unique benefits of using a
summary table over hiding the details in a detail table.

You can use Interactive Viewer to edit and format data in a summary table,
organize data columns, create filters for column data, and save a modified
summary table. In addition, you can use both viewers to export a summary table,
export data in a summary table to supported flat-file formats, display a table of
contents, and print a summary table.

About columns in a summary table

The columns in a summary table are classified into dimension columns, attribute
columns, and measure columns. The columns used to group data in other
columns are dimension columns, and the columns whose aggregated values are
evaluated are measure columns.

A dimension column groups data in other columns. Dimension columns are
typically not aggregated. Some examples of dimension columns include order
date, country, state, product line, and so on. A measure column is typically
ungrouped, and contains aggregated data. Some examples of measure columns
include number of orders, quantity ordered, profit, revenue, and so on.
Sometimes a summary table can contain additional columns called attribute
columns. Attribute columns are typically associated with a dimension column.
For example, Product Code can be an attribute of the Product Line dimension.

Dimension columns are always displayed to the left in a report design. In the
example shown in Figure 10-1, Order date is a higher level or outer dimension
group, and Country is another dimension group that contains the associated
attribute Customer City. Dimension columns and their associated attribute
columns are typically displayed side-by-side in a summary table. The example
also displays a third dimension column, Order Status.
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A grouped dimension column displays subtotals for the data in each group. A
grouped dimension column does not display duplicate data values allowing for
accurately calculated aggregate data.

Dimension column

Dimension column
Dimension column

ORDERDATE

Measure column

; Attribute column
Austria Salzbury

Shipped i
Sub Total { Austria ) 1

Austria Graz
Reszalved
Shipped
Sub Total [ Austna )

S TR

Austria Salzhurg
Shipped i
Sub Total { Austria ) 1

Austria Salzhurg
Shipped i
Sub Total { Austria ) 1

Austria Graz
Shipped i
Sub Total { Austria ) 1

Austria Salzhurg
Shipped
Sub Total [ Austna )

- . RN

Figure 10-1 A summary table

The following section describes how you can modify data in a summary table.

About modification options

In Interactive Viewer, you can modify summary tables by editing and formatting
data, creating filters to display specific data, inserting calculations in a summary
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table, and so on. Table 10-1 compares the actions you can perform on dimension
columns, attribute columns, and measure columns.

Table 10-1 Modification options for data in a summary table
Dimension Attribute Measure

Action column column column
Create a new computed column v
Create filters v v v
Delete the column v v v

Edit and format the column header v v v

Filter data using the Top/Bottom N 4
condition

Format data v v v
Modify aggregate data v
Reorder columns v

Show or hide columns v v v

Sort column data in ascending or v v

descending order

Specify alignment properties v v v
Specify font properties v v 4

Editing and formatting summary-table data

In Interactive Viewer, you can modify the appearance of the data in a summary
table to edit and format column headers, column data, and font and alignment
properties. You can also modify font properties and format aggregate data values.

How to format the column header

Select the column to highlight it, then select Header>Change Text,
Header> Alignment—>Left, Center, or Right, or Header>Font from the context
menu, shown in Figure 10-2.

E‘ Change Text

Column ]

Alignment 3
Filker » A Font

Sort 3

Alignment »

Format 3

Figure 10-2 Modifying a column header
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How to format column data

Select the column to highlight it, then choose Format>Font or Format>Format
Data from the context menu.

How to format aggregate data values

Select the Subtotal or Grand Total value, and choose Format>Font or
Format>Format Data from the context menu.

For more information on editing and formatting column data, see Chapter 3,
“Editing and formatting a report.”

Organizing data in a summary table

You can organize data in a report by sorting column data, showing or hiding
columns and report elements, and moving or deleting a column.

Sorting data

You can sort data in dimension columns, or attribute columns in a summary table,
in descending order. A grouped column automatically sorts data in ascending
order. To modify the sort order, select the column, and choose Sort>Sort
Descending from the context menu.

Showing and hiding columns in a report

You can hide or show dimension columns, attribute columns and measure
columns in a summary table.

Select a column to highlight it, then select Column>Show Column from the
context menu to display the column in the report.

Select a column to highlight it, then select Column>Hide Column from the
context menu to hide the column that you do not want to display in the report.

Moving and deleting a column

In Interactive Viewer, you can move an attribute or measure column, but cannot
move a dimension column in a summary table. You can delete a dimension
column, an attribute column, or a measure column. You can move attribute
columns among other attribute columns in a summary table. When you move a
measure column in a summary table, you can move it only within the other
measure columns.

To move a measure column, select the column and choose Column>Move to Left
from the context menu.
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To delete a column, select the column and choose Column~>Delete Column from
the context menu.

Creating a computed column in a summary table

|:| You can create a computed column for data in measure columns, as you would do
for a regular report column. You can also edit an existing computed column in a
summary table. You cannot create computed columns for data in dimension
columns. For more information on computed columns, see Chapter 6,
“Performing calculations in a report.”

Filtering data in a summary table

You can filter data in dimension, attribute, and measure columns in the same way
in which you filter data in a report table. You can create multiple filter conditions,
and modify existing filter conditions. You cannot create filters for data in a
dimension column containing date-and-time data.

You can also filter a measure column using the Top/Bottom N condition as
shown in Figure 10-3. Select the measure column, and choose Filter>Filter or
Filter>Top/Bottom N from the context menu. You cannot use the Top/Bottom N
condition to filter data values in a dimension or attribute column.

For more information about filtering data, see Chapter 7, “Filtering report data.”

Header 2

Column 2

Alignment » | " Top/Bottom M
Format 3

Figure 10-3 Filtering data in a summary table

Modifying a chart in a summary table

You can modify a chart in a summary table, in the same way you perform this
task in a detail table. You can modify the subtype, formatting options, and export
the chart to other formats. For more information about charts, see Chapter 8,
“Modifying charts.”
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Saving a modified summary table

You can save a modified summary table similar to how you perform this task for
a BIRT report. For more information see Chapter 2, “Navigating a report.”
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Functions and operators

This chapter contains the following topics:
m Functions

m  Operators
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ABS( )

Functions

This section is a complete reference to all of the functions in Interactive Viewer.
This reference organizes the functions into two sections based on those used in
expressions when creating a computed column and functions that are used to
perform aggregate calculations.

Functions used in computed column expressions

The following list of functions appear when you create expressions to compute
column data. Each function entry includes a general description of the function,
its syntax, the arguments to the function, the result the function returns, and an
example that shows typical usage. Use this reference to find information about a
function that you want to use when you insert a computed column to display
calculated data in your report design.

ABS()

Syntax

Argument

Returns

Example

Returns the absolute value of a number without regard to its sign. For example, 6
is the absolute value of 6 and -6.

ABS(num)

num
The number, or numeric expression specifying the number, for which you need to
find the absolute value.

A number representing the absolute value of num.

The following example returns the absolute value for each number in the
TemperatureCelsius data field.

ABS ( [TemperatureCelsius])

ADD_DAY()

Syntax

Arguments

Adds a specified number of days to a date value.
ADD_DAY (date, daysToAdd)

date
The date or date expression representing the start date.
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Returns

Example

ADD_HOUR( )

daysToAdd
The number of days to add to the start date. If you specify a negative number, the
result is as if the number is subtracted from the start date.

The date value that results from adding the specified number of days to the start
date.

The following example adds 15 days to each date value in the InvoiceDate data
field.

ADD DAY ( [InvoiceDate], 15)

ADD_HOUR()

Syntax

Arguments

Returns

Example

Adds a specified number of hours to a date value.
ADD_HOUR(date, hoursToAdd)

date
The date or date expression representing the start date. If a start date does not
have a time value, the function assumes the time is midnight, 12:00 AM.

hoursToAdd
The number of hours to add to the start date. If you specify a negative number,
the result is as if the number is subtracted from the start date.

The date-and-time value that results from adding the specified number of hours
to the start date.

The following example adds eight hours to each date value in the ShipDate data
field.

ADD HOUR( [ShipDate], 8)

ADD_MINUTE()

Syntax

Arguments

Returns

Adds a specified number of minutes to a date value.
ADD_MINUTE(date, minutesToAdd)

date
The date or date expression representing the start date. If a start date does not
have a time value, the function assumes the time is midnight, 12:00 AM.

minutesToAdd
The number of minutes to add to the start date. If you specify a negative number,
the result is as if the number is subtracted from the start date.

The date-and-time value that results from adding the specified number of
minutes to the start date.
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ADD_MONTH( )

Example

The following example subtracts 30 minutes from each date in the StartTime data
field.

ADD MINUTE ( [StartTime], -30)

ADD_MONTH()

Syntax

Arguments

Returns

Example

Adds a specified number of months to a date value.
ADD_MONTH(date, monthsToAdd)

date
The date or date expression representing the start date.

monthsToAdd
The number of months to add to the start date. If you specify a negative number,
the result is as if the number is subtracted from the start date.

The date value that results from adding the specified number of months to the
start date. This function always returns a valid date. If necessary, the day part of
the resulting date is adjusted downward to the last day of the resulting month in
the resulting year. For example, if you add 1 month to 1/31/08, ADD_MONTH()
returns 2/29/08, not 2/31/08 or 2/28/08, because 2008 is a leap year.

The following example adds two months to each date value in the InitialRelease
data field.

ADD MONTH([InitialRelease], 2)

ADD_QUARTER()

Syntax

Arguments

Returns

Example

Adds a specified number of quarters to a date value.
ADD_QUARTER(date, quartersToAdd)

date

The date or date expression representing the start date.

quartersToAdd
The number of quarters to add to the start date. If you specify a negative number,
the result is as if the number is subtracted from the start date.

The date value that results from adding the specified number of quarters to the
start date. A quarter is equal to three months. For example, if you add 2 quarters
to 9/22/08, ADD_QUARTER( ) returns 3/22/09.

The following example adds two quarters to each date value in the
ForecastClosing data field.

ADD QUARTER ( [ForecastClosing], 2)
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ADD_SECOND( )

ADD_SECOND()

Adds a specified number of seconds to a date value.
Syntax ADD_SECOND(date, secondsToAdd)

Arguments date
The date or date expression representing the start date. If a start date does not
have a time value, the function assumes the time is midnight, 12:00 AM.

secondsToAdd
The number of seconds to add to the start date. If you specify a negative number,
the result is as if the number is subtracted from the start date.

Returns The date-and-time value that results from adding the specified number of
seconds to the start date.

Example The following example adds 30 seconds to each date value in the StartTime data
field.

ADD SECOND ( [StartTime], 30)

ADD_WEEK( )

Adds a specified number of weeks to a date value.
Syntax ADD_WEEK(date, weeksToAdd)

Arguments date
The date or date expression representing the start date.

weeksToAdd
The number of weeks to add to the start date. If you specify a negative number,
the result is as if the number is subtracted from the start date.

Returns The date value that results from adding the number of weeks to the start date.

Example The following example adds 2 weeks to each date value in the OrderDate data
field.

ADD WEEK( [OrderDate], 2)

ADD_YEAR()

Adds a specified number of years to a date value.
Syntax ADD_YEAR(date, yearsToAdd)
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BETWEEN( )

Arguments date
The date or date expression representing the start date.

yearsToAdd
The number of years to add to the start date. If you specify a negative number, the
result is as if the number is subtracted from the start date.

Returns The date value that results from adding the number of years to the start date.
Example The following example adds 5 years to each date value in the HireDate data field.

ADD YEAR([HireDate], 5)

BETWEEN( )

Tests if a value is between two specified values.
Syntax BETWEEN(value, upperBound, lowerBound)

Arguments value
The value to test. The value can be a string, numeric, or date value.

upperBound
The first value in the range of values to which to compare. String and date values
must be enclosed in double quotation marks (" ").

lowerBound
The second value in the range of values to which to compare. String and date
values must be enclosed in double quotation marks (" ").

Returns True if value is between upperBound and lowerBound, or equal to upperBound
or lowerBound; returns false otherwise.

Examples The following example tests each value in the SalesTotal data field to see if the
value is between 10000 and 20000.

BETWEEN ( [SalesTotal], 10000, 20000)

The following example tests each value in the CustomerName data field to see if
the value is between A and M.

BETWEEN ( [CustomerName] , "A", "M")

The following example tests each value in the ReceiptDate data field to see if the
value is between 10/01/07 and 12/31/07.

BETWEEN ( [ReceiptDate], "10/01/07 12:00 AM", "12/31/07 12:00 AM")

The following example uses BETWEEN( ) in conjunction with the IF() and
ADD_DAY( ) functions to calculate a shipment date. If an orderDate value is in
December 2007 (between 12/1/07 and 12/31/07), add 5 days to the orderDate
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CEILING( )

value. If an orderDate value is in a month other than December, add 3 days to the
orderDate value.

IF ( (BETWEEN ( [orderDate], "12/1/07 12:00 AM", "12/31/07 12:00
AM")), (ADD DAY ([orderDate], 5)), (ADD DAY ([orderDate], 3)))

CEILING()

Syntax

Arguments

Returns

Examples

Rounds a number to the nearest specified multiple.
CEILING(num, significance)

num
The numeric value to round to.

significance
The multiple to round num to.

The number that results from the rounding up. If num is an exact multiple of
significance, no rounding occurs.

CEILING( ) is commonly used to round up prices. For example, to avoid dealing
with pennies, you can round up prices in a Price data field to the nearest nickel
using the following expression:

CEILING ([Price], 0.05)

If the Price value is 20.52, CEILING( ) returns 20.55.

The following example rounds up prices to the nearest dime.
CEILING ([Price], 0.1)

If the Price value is 20.52, CEILING( ) returns 20.60. If the Price value is 20.40,
CEILING( ) returns 20.40. No rounding occurs because 20.40 is already a multiple
of 0.1.

The following example rounds prices up to the nearest dollar.
CEILING ([Price], 1)
If the Price value is 20.30, CEILING( ) returns 21.0.

DAY( )

Syntax

Argument

Returns a number from 1 to 31 representing the day of the month.
DAY (date)

date
The date or date expression from which you want to extract the day.
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DIFF_DAY( )

Returns

Example

The number of the day of the month for the specified date value.

The following example gets the number of the day for each date value in the
ShipDate data field.

DAY ( [ShipDate])

DIFF_DAY()

Syntax

Arguments

Returns

Example

Calculates the number of days between two date values.
DIFF_DAY (date1, date2)

date1
The first date or date expression to use in the calculation.

date2
The second date or date expression to use in the calculation.

The number of days between datel and date2.

The following example calculates the number of days between each value in the
invoiceDate data field and each value in the paymentDate data field. The results
show how long it takes to pay invoices.

DIFF DAY ([invoiceDate], [paymentDate])

The following example calculates the number of days from an order date to
Christmas.

DIFF DAY ([orderDate], "12/25/08")

The following example calculates the number of days from the current date to
Christmas. TODAY( ) is a function that returns the current date.

DIFF_DAY (TODAY (), "12/25/08")

DIFF_HOUR( )

Syntax

Arguments

Calculates the number of hours between two date values.
DIFF_HOUR(date1, date2)

datel
The first date or date expression to use in the calculation. If the date does not have
a time value, the function assumes the time is midnight, 12:00 AM.

date2
The second date or date expression to use in the calculation. If the date does not
have a time value, the function assumes the time is midnight, 12:00 AM.
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Returns

Example

DIFF_MINUTE( )

The number of hours between datel and date2.

The following example calculates the number of hours between each value in the
startTime data field and each value in the finishTime data field.

DIFF HOUR( [startTime], [finishTime])

The following example calculates the number of hours from the current date to
Christmas. NOW() is a function that returns the current date and time. If you
supply a literal date as an argument, you must include the time value, as shown
in the following example.

DIFF_HOUR(NOW(), "12/25/08 12:00 AM")

DIFF_MINUTE( )

Syntax

Arguments

Returns

Example

Calculates the number of minutes between two date values.

DIFF_MINUTE(date1, date2)

date1
The first date or date expression to use in the calculation. If the date does not have
a time value, the function assumes the time is midnight, 12:00 AM.

date2
The second date or date expression to use in the calculation. If the date does not
have a time value, the function assumes the time is midnight, 12:00 AM.

The number of minutes between datel and date2.

The following example calculates the number of minutes between each value in
the startTime data field and each value in the finishTime data field.

DIFF MINUTE ( [startTime], [finishTime])

The following example calculates the number of minutes from the current date to
Christmas. NOW() is a function that returns the current date and time. If you
supply a literal date as an argument, you must include the time value, as shown
in the following example.

DIFF_MINUTE(NOW(), "12/25/08 12:00 AM")

DIFF_MONTH()

Syntax

Arguments

Calculates the number of months between two date values.
DIFF_MONTH(date1,date2)

datel
The first date or date expression to use in the calculation.
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DIFF_QUARTER( )

Returns

Example

date2
The second date or date expression to use in the calculation.

The number of months between datel and date2. The function calculates the
difference by subtracting the month number of datel from the month number of
date2. For example, if datel is 8/1/08 and date2 is 8/31/08, DIFF_MONTHY( )
returns 0. If datel is 8/25/08 and date2 is 9/5/08, DIFF_MONTH( ) returns 1.

The following example calculates the number of months between each value in
the askByDate data field and each value in the ShipByDate data field.

DIFF MONTH ( [askByDate], [shipByDate])

The following example calculates the number of months from each value in the
hireDate data field to the end of the year.

DIFF_MONTH( [hireDate], "1/1/09")

DIFF_QUARTER()

Syntax

Arguments

Returns

Example

Calculates the number of quarters between two date values.
DIFF_QUARTER(date1, date2)

datel
The first date or date expression to use in the calculation.

date2
The second date or date expression to use in the calculation.

The number of quarters between datel and date2. DIFF_QUARTER calculates the
difference by subtracting the quarter number of the month in datel from the
quarter number of the month in date2. The first quarter consists of the first three
months in a calendar year, the second quarter consists of the next three months,
and so on. For example, if datel is 8/1/08 and date2 is 10/31/08,
DIFF_QUARTER( ) returns 1. If datel is 7/25/08 and date2 is 09/5/08,
DIFF_QUARTER() returns 0.

The following example calculates the number of quarters between each value in
the PlanClosing data field and each value in the ActualClosing data field.

DIFF QUARTER ( [PlanClosing], [ActualClosing])

The following example calculates the number of quarters from each value in the
orderDate data field to the end of the year.

DIFF_QUARTER ( [orderDate], "1/1/09")
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DIFF_SECOND( )

DIFF_SECOND( )

Syntax

Arguments

Returns

Example

Calculates the number of seconds between two date values.
DIFF_SECOND(date1, date2)

date1
The first date or date expression to use in the calculation. If the date does not have
a time value, the function assumes the time is midnight, 12:00 AM.

date2
The second date or date expression to use in the calculation. If the date does not
have a time value, the function assumes the time is midnight, 12:00 AM.

The number of seconds between datel and date2.

The following example calculates the number of seconds between each value in
the startTime data field and each value in the finishTime data field.

DIFF SECOND([startTime], [finishTime])

The following example calculates the number of seconds from the current date to
Christmas. NOW( ) is a function that returns the current date and time. If you
supply a literal date as an argument, you must include the time value, as shown
in the following example.

DIFF_SECOND (NOW(), "12/24/08 12:00 AM")

DIFF_WEEK( )

Syntax

Arguments

Returns

Example

Calculates the number of weeks between two date values.

DIFF_WEEK(date1, date2)

date1
The first date or date expression to use in the calculation.

date2
The second date or date expression to use in the calculation.

The number of weeks between datel and date2. The function calculates the
difference by subtracting the week number of datel from the week number of
date2. For example, if datel is 1/3/08 (week 1 of the year), and date2 is 1/7/08
(week 2 of the year), DIFF_WEEK( ) returns 1.

The following example calculates the number of weeks between each value in the
askByDate data field and each value in the shipByDate data field.

DIFF WEEK( [askByDate], [shipByDate])
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DIFF_YEAR( )

The following example calculates the number of weeks from each value in the
orderDate data field to the end of the year.

DIFF_WEEK([orderDatel, "1/1/09")

DIFF_YEAR()

Syntax

Arguments

Returns

Example

Calculates the number of years between two date values.
DIFF_YEAR(date1, date2)

date1

The first date or date expression to use in the calculation.

date2
The second date or date expression to use in the calculation.

The number of years between datel and date2. The function calculates the

difference by subtracting the year number of datel from the year number of
date2. For example, if datel is 1/1/08 and date2 is 12/31/08, DIFF_YEAR()
returns 0. If datel is 11/25/08 and date2 is 1/5/09, DIFF_YEAR( ) returns 1.

The following example calculates the number of years between each value in the
HireDate data field and each value in the TerminationDate data field.

DIFF YEAR( [HireDate], [TerminationDate])

The following example calculates the number of years from each value in the
HireDate data field to the current date. TODAY( ) is a function that returns the
current date.

DIFF YEAR( [HireDate], TODAY())

FIND( )

Syntax

Arguments

Finds the location of a substring in a string.
FIND(strToFind, str)
FIND(strToFind, str, startPosition)

strToFind
The substring to search for. The search is case-sensitive.

str
The string in which to search.

startPosition
The position in str where the search starts.
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Returns

Example

IF()

The numerical position of the substring in the string. The first character of a string
starts at 1. If the substring is not found, FIND( ) returns 0.

The following example searches for the substring, Ford, in each ProductName
value. If the product name is 1969 Ford Falcon, FIND( ) returns 6.

FIND ("Ford", [ProductName])

The following example searches for the first hyphen (-) in each product code. If
the product code is ModelA-1234-567, FIND( ) returns 7.

FIND("-", [ProductCode])

The following example uses FIND( ) in conjunction with the LEFT( ) function to
display the characters preceding the hyphen in a product code. The LEFT()
function extracts a substring of a specified length, starting from the first character.
In this example, the length of the substring to display is equal to the numerical
position of the hyphen character.

LEFT ( [ProductCode], FIND("-", [ProductCode]))
If the product code is ModelA-1234, LEFT( ) returns the following string:
ModelA

IF()

Syntax

Arguments

Returns

Example

Returns one value if a specified condition evaluates to TRUE, or another value if
the condition evaluates to FALSE.

IF(condition, dolfTrue, dolfFalse)

condition
The condition to test.

dolfTrue
The value to return if condition evaluates to TRUE.

dolfFalse
The value to return if condition evaluates to FALSE.

Returns the doIfTrue value if condition is TRUE or the dolIfFalse value if
condition is FALSE.

The following example calculates and displays different discount amounts based
on the value in the Total data field. If the Total value is greater than 5000, the
discount is 15%. Otherwise, the discount is 10%.

IF([Total]l >5000, [Total]l*15%, [Total]*10%)

The following example uses IF( ) in conjunction with the BETWEEN( ) and
ADD_DAY( ) functions to calculate a shipment date. If an orderDate value is in
December 2007 (between 12/1/07 and 12/31/07), add 5 days to the orderDate
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IN()

value. If a orderDate value is in a month other than December, add 3 days to the
orderDate value.

IF ( (BETWEEN ( [orderDate], "12/1/07 12:00 AM", "12/31/07 12:00
AM")), (ADD DAY ([orderDate], 5)), (ADD DAY ([orderDate], 3)))

The following example checks each value in the Office data field. If the value is
Boston, San Francisco, or NYC, the computed column displays U.S. If the value is
something other than Boston, San Francisco, or NYC, the computed column
displays Europe and Asia Pacific.

IF([Officel="Boston" OR [Office]l="San Francisco" OR
[Office] ="NYC", "U.S.", "Europe and Asia Pacific")

IN()

Tests if a value is equal to a value in a list.
Syntax IN(value, check1,..., checkN)

Arguments value
The value to test. The value can be a string, numeric, or date value.

check1, ..., checkN
The value or values to compare to.

Returns True if value is equal to one of the check values; returns false otherwise.

Example The following example tests if New Haven, Baltimore, or Cooperstown are values
in the city data field. If any one of the cities is in the data field, IN( ) returns true.

IN([city], "New Haven", "Baltimore", "Cooperstown")

The following example tests if 9/15/08 or 9/30/08 are values in the payDate data
field. If you supply a literal date as an argument, you must include the time
value, as shown in the following example.

IN( [payDate], "9/15/08 12:00 AM", "9/30/08 12:00 AM")

The following example uses IN( ) in conjunction with the IF( ) function to test if
Ships or Trains are values in the ProductLine data field. If Ships or Trains is a
value in the field, the computed column displays Discontinued Item; otherwise,
the product line value is displayed as it appears in the field.

IF(IN([ProductLine], "Ships", "Trains"), "Discontinued Item",
[ProductLinel)

172 Working with Actuate BIRT Viewers



ISNULL( )

ISNULL()

Syntax

Argument

Returns

Example

Tests if a value in a specified data field is a null value. A null value means no
value exists.

ISNULL (value)

value
The data field in which to check for null values.

True if a value in the specified data field is a null value; returns false otherwise.

The following example uses ISNULL( ) in conjunction with the IF( ) function to
test for null values in the BirthDate data field. If there is a null value, the
computed column displays No date specified; otherwise the BirthDate value is
displayed.

IF (ISNULL( [BirthDate] ), "No date specified", [BirthDate])

LEFT()

Syntax

Arguments

Returns

Example

Extracts a substring from a string, starting from the leftmost, or first, character.
LEFT(str)
LEFT(str, n)

str
The string from which to extract a substring.

n
The number of characters to extract, starting from the first character.

A substring of a specific length.

m If you omit n, the number of characters to extract, the function returns the first
character only.

m If nis zero, the function returns an empty string.

m If nis greater than the length of the string, the function returns the entire
string.

The following example displays the first letter of each name in the
CustomerName data field.

LEFT ( [CustomerName] )

The following example uses the LEFT( ) and FIND( ) functions to display the
characters preceding the hyphen in a product code.

LEFT ( [ProductCode], FIND("-", [ProductCode]))
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If the product code is ModelA-1234, LEFT( ) returns the following string:
ModelA

LEN()

Syntax

Argument

Returns

Example

Counts the number of characters in a string.
LEN(str)

str
The string expression to evaluate.

The number of characters in the specified string.

The following example returns the length of each value in the ProductCode data
field.

LEN ( [ProductCode] )

The following example uses LEN( ) in conjunction with the RIGHT( ) and FIND( )
functions to display the characters that appear after the hyphen in a product code.
RIGHT( ) extracts a substring of a specified length, starting from the last
character. In this example, the length of the entire string returned by LEN( )
minus the length up to the hyphen is the number of characters to display.
RIGHT( [PRODUCTNAME], LEN([PRODUCTNAME] ) - (FIND("-"

, [PRODUCTNAME] )))

If the product code is ModelA-Ford, RIGHT( ) returns the following string:

A-Ford

LIKE()

Syntax

Tests if a string matches a pattern.
LIKE(str, pattern)

str
The string to evaluate.

pattern

The string pattern to match. You must enclose the pattern in double quotation
marks (" "). Use the correct case when typing the characters to match; the match is
case-sensitive. You can use the following special characters in a pattern:

m A percent character (%) matches zero or more characters. For example, %ace%
matches any string value containing the substring ace, such as Facebook, and
MySpace. It does not match Ace Corporation because this string contains a
capital A, and not the lowercase a.
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Returns

Example

LOWER( )

m  An underscore character (_) matches exactly one character. For example, t_n
matches tan, ten, tin, and ton. It does not match teen or tn.

To match a literal percent (%), underscore (_), precede those characters with a two
backslash (\\) characters. For example, to see if a string contains M_10, specify
the following pattern:

neM\\_10%"
True if the string matches the pattern; returns false otherwise.

The following example returns true for values in the customerName field starting
with D.

LIKE ( [customerName], "D%")

The following example returns true for productCode values containing the
substring Ford.

LIKE ([productCode], "%Ford%")

The following example uses two LIKE( ) expressions to look for the substrings
“Ford” or “Chevy” in each ProductName value. If a product name contains either
substring, the computed column displays U.S. Model; otherwise, it displays
Imported Model.

IF(((LIKE([ProductName], "%$Ford%") = TRUE) OR (LIKE ([ProductName],
"$Chevy%") = TRUE)), "U.S. model", "Imported Model")

LOWER()

Syntax

Argument

Returns

Example

Converts all letters in a string to lowercase.
LOWER(str)

str
The string to convert to lowercase.

The specified string in all lowercase letters.

The following example displays all the string values in the productLine data field
in lowercase.

LOWER ( [productLine])

MOD( )

Syntax

Returns the modulo value for a number and a divisor.
MOD(number, divisor)
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Arguments

Returns

Example

number
The number from which to derive the mod value.

divisor
The divisor for the mod function.
Returns the remainder value of number divided by divisor.

The following example computes the remainder of PriceEstimate data field
divided by 12, returning an integer. For example, if the PriceEstimate value is
27365, MOD( ) returns 5.

MOD ( [PriceEstimate], 12)

MONTH()

Syntax

Arguments

Returns

Example

Returns the month for a specified date value.
MONTH(date)
MONTH(date, option)

date
The date or date expression whose month to retrieve.

option
A number representing the month format to return. Use one of the following
values:

m 1 to get the month as a number from 1 to 12.
m 2 to get the full month name, for example, January. The result is locale-specific.

m 3 to get the abbreviated month name, for example, Jan. The result is
locale-specific.

If you omit option, MONTHY( ) returns the month as a number.
The month for a specified date value.

The following example returns the month (1 - 12) for each value in the ShipDate
data field.

MONTH ( [ShipDate])
The following example returns the full month name for each ShipDate value.

MONTH ( [ShipDate], 2)
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NOTNULL( )

NOTNULL()

Syntax

Argument

Returns

Example

Tests if a value in a specified data field is a non-null value.
NOTNULL(value)

value
The data field in which to check for non-null values.

True if a value in the specified data field is not a null value; returns false
otherwise.

The following example uses NOTNULL( ) in conjunction with the IF() function
to test for non-null values in the BirthDate data field. If there is a non-null value,
the BirthDate value is displayed; otherwise the string “No date specified” is
displayed.

IF (NOTNULL ( [BirthDate] ), [BirthDate], "No date specified")

NOW( )

Syntax

Returns

Example

Returns the current date and time.
NOW()

The current date and time. For example:
Sep 23, 2008 11:56 AM

The following example uses the DIFF_MINUTE( ) and NOW( ) functions to
calculate the number of minutes from the current date and time to Christmas.

DIFF_MINUTE (NOW(), "12/25/08 12:00 AM")

QUARTER( )

Syntax

Arguments

Returns

Example

Returns the quarter number for a specified date value.
QUARTER(date)

date
The date or date expression whose quarter number to get.

A number from 1 to 4 representing the quarter for a specified date value. Quarter
1 starts in January.

The following example displays the quarter number for each value in the
CloseDate data field.

QUARTER ( [CloseDate])
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The following example displays a string—Q1, Q2, Q3, or Q4—for each value in
the CloseDate data field.

"Q" & QUARTER( [CloseDatel)

RIGHT()

Syntax

Arguments

Returns

Example

Extracts a substring from a string, starting from the rightmost, or last, character.
RIGHT (str)

RIGHT((str, n)
str
The string from which to extract a substring.

n
The number of characters to extract, starting from the last character.

A substring of a specific length.

m If you omit n, the number of characters to extract, the function returns the last
character only.

m If nis zero, the function returns an empty string.

m If nis greater than the length of the string, the function returns the entire
string.

The following example displays the last four characters of each value in the

ProductCode data field.

RIGHT ( [ProductCode], 4)

The following example uses RIGHT( ) in conjunction with the LEN( ) and FIND( )
functions to display the characters that appear after the hyphen in a product code.
This example assumes that the number of characters after the hyphen varies.
Therefore, the length of the entire string (returned by LEN( )) minus the length up
to the hyphen (returned by FIND( )) is the number of characters to display.

RIGHT ( [ProductCode], (LEN([ProductCode]) - FIND("-" ,
[ProductCodel])))

If the product code is Model A-Ford, RIGHT( ) returns Ford. If the product code is
ModelB-Toyota, RIGHT( ) returns Toyota.

ROUND( )

Syntax

Rounds a number to a specified number of digits.
ROUND(num)
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Arguments

Returns

Example

ROUNDDOWN( )

ROUND(num, dec)

num
The number to round.

dec
The number of digits to which to round num. If you omit dec, ROUND( ) assumes
0.

A number rounded to a specified number of digits.

The following example rounds the numbers in the PriceEstimate data field to
return an integer. For example, if the PriceEstimate value is 1545.50, ROUND( )
returns 1546. If the PriceEstimate value is 1545.25, ROUND( ) returns 1545.

ROUND ( [PriceEstimate])

The following example rounds the numbers in the PriceEstimate data field to one
decimal place. For example, if the PriceEstimate value is 1545.56, ROUND( )
returns 1545.6. If the PriceEstimate value is 1545.23, ROUND( ) returns 1545.2.

ROUND ( [PriceEstimate], 1)

The following example rounds the numbers in the PriceEstimate data field to one
digit to the left of the decimal point. For example, if the PriceEstimate value is
1545.56, ROUND( ) returns 1550. If the PriceEstimate value is 1338.50, ROUND( )
returns 1340.

ROUND ( [PriceEstimate], -1)

ROUNDDOWN( )

Syntax

Arguments

Returns

Example

Rounds a number down to a specified number of digits.
ROUNDDOWN(num)

ROUNDDOWN(num, dec)

num
The number to round down.

dec
The number of digits to which to round num down. If you omit dec, ROUND( )
assumes 0.

A number rounded down to a specified number of digits.

The following example rounds down the numbers in the PriceEstimate data field
to return an integer. For example, if the PriceEstimate value is 1545.25,
ROUNDDOWN( ) returns 1545. If the PriceEstimate value is 1545.90,
ROUNDDOWN( ) returns 1545.

ROUNDDOWN ( [PriceEstimate])
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The following example rounds down the numbers in the PriceEstimate data field
to one decimal place. For example, if the PriceEstimate value is 1545.56,
ROUNDDOWN( ) returns 1545.5. If the PriceEstimate value is 1545.23,
ROUNDDOWN( ) returns 1545.2.

ROUNDDOWN ( [PriceEstimate], 1)

The following example rounds the numbers in the PriceEstimate data field down
to one digit to the left of the decimal point. For example, if the PriceEstimate
value is 1545.56, ROUNDDOWN( ) returns 1540. If the PriceEstimate value is
1338.50, ROUNDDOWN( ) returns 1330.

ROUNDDOWN ( [PriceEstimate] , -1)

ROUNDUP()

Syntax

Arguments

Returns

Example

Rounds a number up to a specified number of digits.
ROUNDUP(num)

ROUNDUP(num, dec)

num
The number to round up.

dec
The number of digits to which to round num up. If you omit dec, ROUND()
assumes 0.

A number rounded up to a specified number of digits.

The following example rounds up the numbers in the PriceEstimate data field to
return an integer. For example, if the PriceEstimate value is 1545.25,
ROUNDUP( ) returns 1546. If the PriceEstimate value is 1545.90, ROUNDUP( )
returns 1546.

ROUNDUP ( [PriceEstimate])

The following example rounds up the numbers in the PriceEstimate data field to
one decimal place. For example, if the PriceEstimate value is 1545.56,
ROUNDUP( ) returns 1545.6. If the PriceEstimate value is 1545.23, ROUNDUP( )
returns 1545.3.

ROUNDUP ( [PriceEstimate], 1)

The following example rounds up the numbers in the PriceEstimate data field to
one digit to the left of the decimal point. For example, if the PriceEstimate value is
1545.56, ROUNDUP( ) returns 1550. If the PriceEstimate value is 1338.50,
ROUNDUP( ) returns 1340.

ROUNDUP ( [PriceEstimate], -1)
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SEARCH()

Syntax

Arguments

Returns

Example

Finds the location of a substring in a string. The substring can contain wildcard
characters.

SEARCH(pattern, str)
SEARCH(pattern, str, startPosition)

pattern
The string pattern to search for. You must enclose the pattern in double quotation
marks (" "). You can use the following special characters in a pattern:

m  An asterisk ( * ) matches zero or more characters, including spaces. For
example, t*n matches tn, tin, and teen.

m A question mark (?) matches exactly one character. For example, t?n matches
tan, ten, tin, and ton. It does not match teen or tn.

str
The string to search.

startPosition
The position in str where the search starts.

The numerical position of the string pattern in the string. The first character of a
string starts at 1. If the substring is not found, SEARCH( ) returns 0.

The following example searches for the string pattern, S*A, in each product code.
If the product name is KBS5412A, SEARCH( ) returns 3.

SEARCH ("S*A", [ProductCode])

The following example uses SEARCHY( ) in conjunction with the LEFT( ) function
to display the characters preceding the first space character in a product name.
The LEFT( ) function extracts a substring of a specified length, starting from the
first character. In this example, the length of the substring to display is equal to
the numerical position of the space character.

LEFT ( [ProductName] , SEARCH(" ", [ProductName]))
If the product name is 1969 Ford Falcon, LEFT( ) returns 1969.

SQRT()

Syntax

Calculates the square root of a number.
SQRT(num)
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Argument

Returns

Example

num
The number, or numeric expression specifying the number, for which you want to
find the square root. The number must be a positive number.

A number that is the square root of num.

The following example calculates the square root of each value in the LotSize data
field.

SQORT ( [LotSizel)

The following example uses SQRT( ) to calculate the actual distance travelled
uphill, given the base distance and elevatlon values. This example applies the
Pythagoras theorem, which states that a+b = Using this theorem, the actual
distance travelled is ¢, which means we want to calculate

¢ = Jal+b
which translates to the following expression:

SORT ( ( ( [Distance] * [Distance]) + ([Elevation] * [Elevation])))

TODAY()

Syntax

Returns

Example

Returns the current date that includes a time value of midnight, 12:00 AM.
TODAY()

The current date in the following format:

Sep 25, 2008 12:00 AM

The following example calculates the number of days from the current date to
Christmas.

DIFF_DAY (TODAY (), "12/25/08")

The following example calculates the number of years from each value in the
HireDate data field to the current date.

DIFF YEAR( [HireDate], TODAY())

TRIM( )

Syntax

Argument

Removes the leading and trailing blanks from a specified string. TRIM( ) does not
remove blank characters between words.

TRIM(str)

str
The string from which to remove leading and trailing blank characters.
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Returns

Example

TRIMLEFT( )

A string with all leading and trailing blank characters removed.

The following example uses TRIM( ) to remove all leading and trailing blank
characters from values in the FirstName and LastName data fields. The
expression uses the & operator to concatenate each trimmed FirstName value
with a space, then with each trimmed LastName value.

TRIM([FirstName]) & " " & TRIM([LastName])

TRIMLEFT()

Syntax

Arguments

Returns

Example

Removes the leading blanks from a specified string.
TRIMLEFT((str)

str
The string from which to remove the leading blank characters.

A string with all leading blank characters removed.

The following example concatenates a literal string with each value in the
customerName data field. TRIMLEFT( ) removes all blank characters preceding
the customerName value so that there are no extra blank characters between the
literal string and the customerName value.

"Customer name: " & TRIMLEFT ( [customerName])

TRIMRIGHT( )

Syntax

Argument

Returns

Example

Removes the trailing blanks from a specified string.
TRIMRIGHT (str)

str
The string from which to remove the trailing blank characters.

A string with all trailing blank characters removed.

The following example concatenates each value in the Comment data field with a
semicolon, then with a value in the Action data field. TRIMRIGHT( ) removes all
blank characters after the Comment value so that there are no extra blank
characters between the Comment string and the semicolon.

TRIMRIGHT ( [Comment]) & "; " & [Action]

UPPER()

Converts all letters in a string to uppercase.
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WEEK( )

Syntax

Argument

Returns

Example

UPPER(str)

str
The string to convert to uppercase.

The specified string in all uppercase letters.

The following examples displays all the string values in the customerName data
field in all uppercase.

UPPER ( [customerName] )

WEEK( )

Syntax

Argument

Returns

Example

Returns a number from 1 to 52 representing the week of the year.
WEEK(date)

date
The date or date expression whose week of the year to get.

A number representing the week of the year for the specified date value.

The following example gets the week number of the year for each date value in
the ShipDate data field.

WEEK ( [ShipDate])

WEEKDAY( )

Syntax

Arguments

Returns the day of the week for a specified date value.
WEEKDAY (date, option)

date
The date or date expression from which you get the day of the week.

option
A number representing the weekday format to return. Use one of the following
values:

m 1 to get the day as a number from 1 (Sunday) to 7 (Saturday).
m 2 to get the day as a number from 1 (Monday) to 7 (Sunday).
m 3 to get the day as a number from 0 (Monday) to 6 (Sunday).

m 4 to get the full weekday name, for example, Wednesday. The result is
locale-specific.

m 5 to get the abbreviated weekday name, for example Wed. The result is
locale-specific.
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Returns

Example

YEAR( )

If you omit option, WEEKDAY( ) assumes option 1.
The day of the week for a specified date value.

The following example gets the full weekday name for each date value in the
DateSold data field.

WEEKDAY ( [DateSold], 4)

YEAR()

Syntax

Returns

Example

Returns the four-digit year value for a specified date value.
YEAR(date)

date
The date or date expression from which you extract the year part.

The number representing the four-digit year for the specified date value.

The following example retrieves the four-digit year for each date value in the
ShipDate data field, and adds 15 to the four-digit year. If the ShipDate value is
Sep 16, 2008, YEAR( ) returns 2023.

(YEAR ( [ShipDatel]) + 15)

Functions used in aggregate calculations

Table 11-1 describes the range of functions that perform aggregate calculations. In
Interactive Viewer, you can perform aggregate calculations across the data rows
in a group, section, or across an entire report table.

Table 11-1 Aggregate functions
Aggregate function Description
AVERAGE Returns the average, or mean for a set of data rows. For
example, if a report column contains values 5, 2, 7, and 10,
AVERAGE returns 6.
COUNT Counts the number of data rows. If a column contains values
5,2,7,and 10, COUNT returns 4.
COUNT VALUE Counts the number of unique values in a set of data rows. If

a report column contains values 5, 2, 5, 7, and 10,
COUNTVALUE returns 4.

(continues)
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Table 11-1 Aggregate functions (continued)

Aggregate function

Description

FIRST

LAST

MAX

MEDIAN

MIN

MODE

QUARTILE

STDDEV

SUM

Returns the first value in set of data rows. If a report column
contains data rows 5, 2, and 10, FIRST returns 5.

Returns the last value in a set of data rows. If a report
column contains data row values 2, 5, 7, and 10, LAST
returns 10.

Returns the largest value in a set of data rows. If a report
column contains data row values 5, 2, 7, and 10, MAX
returns 10. For string values, MAX returns the last
alphabetical value. For date values, MAX returns the latest
date.

Returns the median, or middle value in a set of data rows. If
a report column contains values, 5, 2, 7, and 10, MEDIAN
returns 6.

Returns the smallest value in a set of data rows. If a report
column contains data row values 5, 2, 7, and 10, MIN returns
2. For string data, MIN returns the first alphabetical value.
For date values, MIN returns the earliest date.

Returns the mode, or the value that occurs most frequently
in a set of data rows. If a report column contains values, 5, 2,
5,7, and 10, MODE returns 5.

Returns the quartile value in a set of data rows, given a
specified quart (0-4). A quartile can be defined as any three
values that divide a set of values into four equal parts, such
that each part represents 1/4 of the set of values. MIN,
MEDIAN, and MAX return the same value as QUARTILE
when quart is equal to 0, 2, and 4 respectively. If a set of data
rows contains 50, 75, 80, 90, and 95, and you specify a quart
of 2, QUARTILE returns 80.

Returns the standard deviation of a set of data rows.
Standard deviation is a statistic that shows how widely
values disperse from the mean value. If a set of data rows
contains 50, 75, 80, 90 and 95, STDDEV returns 17.536.

Adds all the values in a set of data rows. If a report column
contains 50, 75, 80, 90, and 95, SUM returns 390.
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Table 11-1 Aggregate functions (continued)

Aggregate function

Description

VARIANCE

WEIGHTEDAVE

Returns the variance of a set of data rows. Variance is a
statistical measure expressing large the size of the
differences between the values. The variance increases as the
differences between the numbers increase. If a set of data
rows contains 50, 75, 80, 90, and 95, VARTIANCE returns
307.5. If a set of data rows contains 5, 2, 5, 7, and 10,
VARIANCE returns 8.7.

Returns the weighted average value in a set of data rows,
given weights specified in another set of values. In a
weighted average, each number is assigned a weight or
degree of importance. These weights determine the relative
importance of each number on the average. Grades are often
computed using a weighted average. For example, for a set
of scores 50, 75, 80, 90, and 95, with respective weights, 10,
25,15, 30, and 20, WEIGHTEDAVE returns 81.75.

Operators

This section is a complete reference to all the operators you can use when you
create expressions. This reference organizes the operators into the following

categories:

m  Operators in computed column expressions

m  Operators in conditional formatting and filter condition expressions

Operators in computed column expressions

Table 11-2 lists the operators you can use when you write expressions for a
computed column.

Table 11-2 Operators in computed column expressions
Operator Use to Example
+ Add two or more numeric values  [OrderAmount] + [SalesTax]
together
- Subtract one numeric value from [OrderAmount] - [Discount]
another
* Multiply numeric values [Price] * [Quantity]

(continues)
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Table 11-2 Operators in computed column expressions (continued)
Operator Use to Example
/ Divide numeric values [Profit] /12
A Raise a numeric value to a power  [Length]"2
% Specify a percent [Price] * 80%
= Test if two values are equal IF([ProductName] = "1919
Ford Falcon", "Discontinued
Item", [ProductName])
> Test if one value is greater than IF([Total] > 5000, [Total]*15% ,
another value [Total]*10%)
< Test if one value is less than IF([SalePrice] < [MSRP],
another value "Below MSRP", "Above
MSRP")
>= Test if one value is greater than or  IF([Total] >= 5000, [Total]*15%
equal to another value , [Total]*10%)
<= Test if one value is less than or IF([SalePrice] <= [MSRP],
equal to another value "Below or equal to MSRP",
"Above MSRP")
AND Test if two or more conditions are  IF(([Gender] = "Male" AND
true [Salary] >= 150000 AND
[Age] < 50), "Match found",
"No match")
OR Test if any one of multiple IF(([City] = "Boston") OR
conditions is true ([City] = "San Francisco"),
"U.S.", "Europe and Asia")
& Concatenate string values [FirstName] & " " &

[LastName]

Operators in conditional formatting and filter
condition expressions

Table 11-3 lists the operators you can use when you create expressions for
conditional formatting and filter conditions.

Table 11-3 Operators in conditional formatting and filter condition
expressions
Operator Use to Example
Any Of Test if a column value is equal to Country Any Of USA,

any one of the specified values.
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Table 11-3 Operators in conditional formatting and filter condition
expressions (continued)

Operator Use to Example

Between Test if a column value is between ~ Profit Between 1000 and
two specified values. 2000

Bottom N Test if a column value is among the = SalesAmount Bottom N
lowest 1 values. 10

Bottom Test if a column value is in the SalesAmount Bottom

Percent bottom 7 percent of all values. Percent 5

Equal to Test if a column value is equal toa  Country Equal to France
specified value.

Greater Than  Test if a column value is greater Total Greater Than 5000
than a specified value.

Greater Than  Test if a column value is greater Total Greater Than or

or Equal to than or equal to a specified value. ~ Equal to 5000

In Test if a column value is in the list ~ Country In USA, Canada,
of specified values. Usage similar ~ Mexico
to the Any Of operator.

Is False Test if a column value is False. LoanApproved Is False

Is Not Null Test if a column value isnotanull ~ CreditLimit Is Not Null
value. A null value means no value
is supplied.

Is Null Tests if a column value is a null CreditLimit Is Null
value.

Is True Test if a column value is True. LoanApproved Is True

Less Than Test if a column value is less thana Total Less Than 5000
specified value.

Less Thanor  Test if a column value is less than ~ Total Less Than or Equal

Equal to or equal to a specified value. to 5000

Like Test if a column value matches a ProductName Like
string pattern. %Ford%

Not Between  Test if a column value is not Profit Not Between 1000
between two specified values. and 2000

Not Equalto  Test if a column value is not equal ~ Country Not Equal to
to a specified value. France

Not In Test if a column value is not in the ~ Country Not In USA,

specified list of values

Canada, Mexico

(continues)
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Table 11-3 Operators in conditional formatting and filter condition

expressions (continued)

Operator Use to Example

Not Like Test if a column value does not ProductName Not Like
match a string pattern. %Ford%

Top N Test if a column value is among the = SalesAmount Top N 10

top n values.

Top Percent Test if a column value is in the top
n percent of all values.

SalesAmount Top
Percent 5
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Two

Actuate BIRT Viewer Reference






Configuring Actuate BIRT
Viewer

This chapter covers the following topics:
m Configuring the Actuate BIRT Viewer toolbar using iv_config.xml
m  Configuring an Actuate BIRT Viewer using web.xml

m Configuring a BIRT Viewer Java Extension
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Configuring the Actuate BIRT Viewer toolbar using
iv_config.xml

The Actuate BIRT Viewer provides a toolbar and context menus that support
many of the formatting, sorting, and grouping tasks you perform on data. The
tool bar and menus also support adding or deleting columns or groups, and
working with fonts and text alignment. You also can print reports and export
content or data. Enable or disable each of these features using the configuration
file iv_config.xml. Its location is

<context root>\WEB-INF\iv_config.xml

The iv_config.xml file contains lists of features that are enabled or disabled based
on security roles as defined in Actuate iServer. The default roles included for
iv_config.xml are

s Al

m Active Portal Intermediate
m Active Portal Advanced

m Active Portal Administrator

The Active Portal roles are created when iServer is installed or, if you are using
the Java Component Actuate BIRT Viewer, set in the web.xml
DEFAULT_WORKGROUP_FUNCTIONALITY_ROLE parameter. You can add
additional iServer roles as needed. Each set of features for a role is called a feature
control. Each feature control contains the user role being described, and the set of
features that are marked individually as available or not available. The following
section of iv_config.xml shows the default feature control for the Active Portal
Advanced role:

<FeatureControl>
<Role>Active Portal Advanced</Role>
<Features>
<Feature>
<FeatureName>SaveDesign</FeatureName>
<Availablity>false</Availablitys>
</Feature>
<Feature>
<FeatureNames>SaveDocument</FeatureName>
<Availablitys>true</Availablity>
</Feature>

</Features>
</FeatureControls>
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All <FeatureControl> tags are placed within the <FeatureConfiguration>
element. Each feature is described by the <Feature> tag, and its availability is
described with the <Availability> tag. If a particular feature is available to a role,
availability is set to true. If the feature is not available, it is set to false.

Exception stack trace display is also controlled in the iv_config.xml file. When an
exception occurs, the viewer can display a stack trace can be displayed in the
exception dialog. The trace is used for support purposes, and is set to false by
default. This value is not associated with user roles and is placed outside the
<FeatureControl> tag. The format of the iv_config.xml file appears as shown in
the following code:

<IVConfigs>
<!-- Disable stack trace on exception dialog -->
<ExceptionStackTrace>false</ExceptionStackTrace>

<!-- Config features -->

<FeatureConfigurations>
<!-- All -->
<FeatureControls>

</FeatureControls>
<FeatureControl>

</FeatureControls>

</FeatureConfigurations>
</IVConfig>

Table 12-1 lists the features that can be set, and how the availability tag affects
them.

Table 12-1 Actuate BIRT Viewer feature set

Feature Availability tag description

AdvancedSort Shows or hides the Advanced Sort item in the context
menu.

Aggregation Shows or hides the Aggregation item in the context
menu.

CalculatedColumn  Shows or hides the New Computed Column and Edit
Computed Column items in the context menu.

ChartSubType Shows or hides the Chart Subtype item in the context
menu.
ChartProperty Shows or hides the Chart Property item in the context
menu.
(continues)
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Table 12-1 Actuate BIRT Viewer feature set (continued)

Feature Availability tag description

ColumnEdit Shows or hides the Hide Column, Show Columns, and
Delete Column items in the context menu.

CollapseExpand Shows or hides the Hide Detail and Show Detail items
in the context menu.

ColumnResize Shows or hides the Column Width item in the context
menu.

ConditionalFormat ~ Shows or hides the Conditional Formatting item in the
context menu.

EditReport Shows or hides the Enable Interactivity item in the
Toolbar main menu.

ExportData Shows or hides the Export Data menu item in the
Toolbar main menu.

ExportReport Shows or hides the Export Content menu item in the
Toolbar main menu.

Filter Shows or hides the Filter item in the context menu.

Format Shows or hides the Format, Change Font, and
Alignment items in the context menu.

GroupEdit Shows or hides the Move To Group, Add Group, and
Delete Group items in the context menu.

HideShowlItems Shows or hides the Hide/Show Item menu item in the
Toolbar main menu.

Highlight Shows or hides highlighting.

HoverHighlight Shows or hides the mouse over rectangles on page
elements.

LinkToThisPage Shows or hides the Link To This Page item in the main
menu.

MainMenu Enables or disables the Toolbar’s main menu.

PageBreak Shows or hides the Page Break item in the context
menu.

PageNavigation Shows or hides the page navigation icons in the
navigation bar.

Parameter Shows or hides the Parameter item in the Toolbar.

Print Shows or hides the Print menu item in the Toolbar main
menu.

ReorderColumns Shows or hides the Reorder Columns item in the context

menu.
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Table 12-1 Actuate BIRT Viewer feature set (continued)

Feature Availability tag description

SaveDesign Shows or hides the Save Design menu item in the
Toolbar main menu.

SaveDocument Shows or hides the Save Document menu item in the
Toolbar main menu.

ScrollControl Shows or hides the scroll control panel in page content.

ServerPrint Shows or hides the Server Print menu item in the
Toolbar main menu.

Sort Shows or hides the Sort Ascending and Sort Descending
items in the context menu.

SuppressDuplicate Shows or hides the Repeat Values and Do Not Repeat
Values items in the context menu.

SwitchView Shows or hides the Switch View item in the context
menu.

Toc Shows or hides the TOC menu item in the Toolbar main
menu.

TextEdit Shows or hides the edit text icon on text elements.

Toolbar Shows or hides the Toolbar.

ToolbarHelp Shows or hides the toolbar Help menu item.

TopBottomNFilter Shows or hides the Top/BottomN item in the context

menu.

Configuring an Actuate BIRT Viewer using web.xml

Actuate BIRT Interactive Viewer (IV) parameters in web.xml affect how BIRT
reports are run and viewed. Table 12-2 describes these configuration parameters
for BIRT reports, BIRT Viewer and Interactive Viewer.

Table 12-2

Actuate BIRT Viewer web.xml parameters

Parameter name

Description

ALLOW_EXPORT_PAGE_

LIMIT

Indicates the maximum number of pages that can be exported

or printed at a time from an Actuate BIRT Viewer. For example,
if the value of this parameter is 200, no more than 200 pages
will be exported or printed from a report using the viewer.

(continues)
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Table 12-2

Actuate BIRT Viewer web.xml parameters (continued)

Parameter name

Description

ALLOW_IV_PAGE_LIMIT

AUTOSUGGEST_DELAY

AUTOSUGGEST_FETCH_
SIZE

AUTOSUGGEST_LIST _
SIZE

BIRT_ARCHIVE _
MEMORY_TOTALSIZE

BIRT_CHART_MAX_ROW

BIRT_CHART_MAX_
VARIABLE_SIZE

BIRT_DATA_RESULTSET _
MAX_BUFFER_SIZE

BIRT
HTMLRENDEROPTION_
ENGCASSTYLE

BIRT_JDBC_
CONNECTION_POOL_
SIZE

BIRT_JDBC_
CONNECTION_POOL_
TIMEOUT

BIRT_MAX_MEMORY _
SIZE_PER_ARCHIVE

Specifies whether Information Console checks for a page limit
before triggering an operation.

Configure the delay before the parameters page opens an
automatic suggestion for a parameter. The value is measured in
milliseconds, and the default value is 500.

The number of autosuggest parameter values to load on the
parameters page. The default value is -1, which loads all
values.

The number of autosuggest parameter values to display on the
parameters page when active. If more values exist than are
displayed, the user can scroll through the other values. The
default value is 10.

The total memory available for BIRT report document files, in
kilobytes. The default value is 50 megabytes.

The maximum number of rows bound to a chart in a BIRT
report. The default value is 10000 rows.

The maximum size for a variable used in a Flash chart,
measured in bytes. The default value is 0, which allows a
variable to be of any size.

The result set buffer size, in megabytes, for a data set in a BIRT
report. The default value is 10 megabytes.

Enables the agentStyleEngine property for the HTML render
option for a BIRT report. This setting is related to using a
browser’s internal CSS capabilities when rendering reports in
HTML. It provides better column alignment and faster
rendering, especially in a browser other than Microsoft Internet
Explorer. The default value is True.

Specifies the number of idle connections cached by BIRT JDBC
connection pool. The default value is 10.

Specifies how long an idle connection will remain in the BIRT
JDBC connection pool in seconds. The default value is 3600.

The amount of memory used by each BIRT report document
file, in kilobytes. A report larger than this size is written to disk
instead of being cached in memory. Use this parameter for
performance tuning. The default value is 200 kilobytes.
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Table 12-2 Actuate BIRT Viewer web.xml parameters (continued)

Parameter name

Description

BIRT_RESOURCE_PATH

BIRT_SCRIPT_LIB_PATH

BIRT_SAVE_REPORT_
DOCUMENT_ENABLED

BIRT_SAVE_REPORT _
DOCUMENT_FOLDER

BIRT_VIEWER_LOCALE

CACHE_CONTROL

The path to Actuate BIRT shared resources, including libraries
and templates for the BIRT report designs and BIRT Studio. The
default value is <context root>\resources

Path for the BIRT script libraries (JARs). The default value is
<context root>\scriptlib.

Determines if temporary report files are saved. Enables the user
to save output from BIRT Interactive Viewer using the
__outputDocName URL parameter. Using this parameter saves
the document to the folder assigned to
BIRT_SAVE_REPORT_DOCUMENT_FOLDER. Default is true.

Path to the folder where temporary report files are created. The
default path to which to save BIRT Report Documents saved
using the __outputDocName parameter. This parameter is
made available by setting the
BIRT_SAVE_REPORT_DOCUMENT_ENABLED parameter.

Locale that determines formatting for numbers and dates on
BIRT reports. The default value is the locale of the machine on
which Information Console is installed.

Specifies how a web browser caches information using one of

the following values:

m  NO-CACHE indicates that the browser does not cache
information and forwards all requests to the server. With
NO-CACHE, the back and forward buttons in a browser do
not always produce expected results, because choosing
these buttons always reloads the page from the server.

If multiple users access Information Console from the same
machine, they can view the same cached data. Setting
CACHE_CONTROL to NO-CACHE prevents different
users viewing data cached by the browser.

m  NO-STORE indicates that information is cached but not
archived.

m PRIVATE indicates that the information is for a single user
and that only a private cache can cache this information. A
proxy server does not cache a page with this setting.

m PUBLIC indicates that information may be cached, even if it
would normally be non-cacheable or cacheable only within
an unshared cache.

(continues)
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Table 12-2 Actuate BIRT Viewer web.xml parameters (continued)

Parameter name

Description

CACHE_CONTROL
(continued)

DEFAULT_LOCALE
DEFAULT_TIMEZONE

DEFAULT_WORKGROUP_
FUNCTIONALITY_ROLE

EXPORT_AS_
ATTACHMENT

IV_ENABLE_IV

JAVA_REPORT_API
IMAGE_CACHE_
EXPIRATION

JREM_TASK_QUEUE_SIZE

JREM_THREAD_POOL_
SIZE

m  UNSET (no value) is the default value. The browser uses its
own default setting when there is no CACHE_CONTROL
value.

Caching information reduces the number of server requests
that the browser must make and the frequency of expired page
messages. Caching increases security risks because of the
availability of information in the cache. For additional
information about cache control, see the HTTP /1.1
specifications.

The default locale. The default locale is en_US. Users can select
a locale when they log in.

The default time zone. The default time zone is Pacific
Standard Time (PST).

Specifies the functionality role for all users using the BIRT
Viewer. The default value is Active Portal Intermediate.

Determines whether a Microsoft Excel, Powerpoint, or Word
report for the BIRT Viewer is opened in the Microsoft Internet
Explorer browser or a separate application.

m  When the value is true, the exported report opens in a
separate Microsoft Word, Microsoft Powerpoint, or
Microsoft Excel application.

m  When the value is false, the exported report opens in the
browser window with Microsoft Word, Microsoft
Powerpoint, or Microsoft Excel embedded inside the
browser.

The Firefox browser always opens these report formats in a
separate application.

Determines whether the Enable Interactivity option is usable in
the BIRT Viewer control menu. If false, the Enable Interactivity
option is disabled.

Specifies how long in seconds to cache images for Actuate BIRT
reports and business reports. The default value is 86,400, which
is one day.

Specifies the maximum queue length for the Java Report
Engine thread pool. The default value is 1000.

Specifies the maximum number of threads in the Java Report
Engine thread pool. The default value is 10.
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Table 12-2

Actuate BIRT Viewer web.xml parameters (continued)

Parameter name

Description

JREM_THREADPOOL_
MAXSYNC_
TASKRUNTIME

JREM_THREADPOOL_
MONITORTHREAD _
POLLINGINTERVAL

JREM_THREADPOOL_
SYNC_TASKQUEUE_
TIMEOUT

NUMBER_OF_FILTER _
VALUES

DEFAULT_COLUMN_
PAGE_BREAK_INTERVAL

DEFAULT_PAGE_BREAK _
INTERVAL

DEFAULT_ROW_PAGE_
BREAK_INTERVAL

PROXY_BASEURL

REPOSITORY_CACHE_
TIMEOUT_SEC

TEMP_FOLDER_
LOCATION

Specifies the maximum time a synchronous report generation
is allowed to run. The default value is 600.

Controls the interval in seconds at which the Java Report
Engine thread pool checks for Java report execution time-out or
queue time-out. The default value is 30.

Specifies the maximum time, in seconds, that a Java
synchronous request stays in the Java Report Engine task
queue before timing out, in seconds. The default value is 300.

Specifies the number of distinct values to display when a user
chooses to filter a report on a column in the BIRT Viewer. The
default value is 200.

Specifies the number of columns to display on one page when
viewing a cross tab. Must be a non-negative number. Default
value is 10.

Specifies the number of rows to display in one page when
viewing a report. If set to 0, there are no page breaks.

Specifies the number of rows to display on one page when
viewing a cross tab. Must be a non-negative number. Default
value is 40.

Indicates a proxy server’s URL if the network uses one between
the BIRT Viewer web application and the client. The default
value is blank, which indicates that the network does not use a
Proxy server.

Specifies, in seconds, how long to retain temporary files that
BIRT Viewer creates when a user modifies the appearance of a
report. The default value is 900, which is 15 minutes.

Path to the folder where temporary files are created.

Configuring a BIRT Viewer Java Extension

The BIRT Design Engine API provides the IBirtViewerExtension,
IBirtViewerContext, IBirtViewerOp, and IBirtViewer Session Java interfaces to
extend the functionality of the BIRT Viewer. Classes implementing these
interfaces are associated with the BIRT Viewer web application when they are
added in the birtviewer-extension.xml configuration file. Its location is:

<context roots>\WEB-INF\birtviewer-extension.xml
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For example, to enable myIVExtension.jar to operate on the BIRT Viewer, add an
entry to birtviewer-extension.xml as follows:

<?xml version="1.0" encoding="UTF-8" ?>

- <BirtWebViewerExtension>

- <!l-- Class name for Interactive viewer extension -->
<InteractiveViewer>com.actuate.sample.MyIvExtension.class
</InteractiveViewers>
</BirtWebViewerExtensions>

Save the compiled code archive to the <context root>\WEB-INF\lib folder for the
BIRT Viewer web application and restart the application to enable the custom
interface. The interfaces are part of the com.actuate.birtviewer.extension package
of the BIRT Design Engine API.

The IBirtViewerExtension interface defines the event handler methods that
activate implemented code, as follows:

package com.actuate.birtviewer.extension;
public interface IBirtViewerExtension{

// Event handler that runs when a design changes
void afterDesignChange( IBirtViewerContext context, IBirtViewerOp
operation, ReportDesignHandle designHandle ) ;

// Event handler after design get opened.
void afterDesignOpen( IBirtViewerContext context,
ReportDesignHandle designHandle ) ;

// Event handler that runs when a design is saved
void afterDesignSave( IBirtViewerContext context, IBirtViewerOp
operation, ReportDesignHandle designHandle, String path );

//Event handler that runs when viewer creates a new session object
void afterViewerSessionStart( IBirtViewerContext context ) ;

// Event handler that runs before a design change occurs
void beforeDesignChange ( IBirtViewerContext context, IBirtViewerOp
operation, ReportDesignHandle designHandle ) ;

// Event handler that runs before a design opens
void beforeDesignOpen( IBirtViewerContext context, String path );

// Event handler that runs before a design is saved

boolean beforeDesignSave( IBirtViewerContext context,
IBirtViewerOp operation, ReportDesignHandle designHandle,
String path );

// Event handler before soap response get sent back.
void beforeResponse( IBirtViewerContext context, IBirtViewerOp
operation, GetUpdatedObjectsResponse response );
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// Triggered whe session object get destoroyed.
void beforeViewerSessionClose( IBirtViewerSession session ) ;

}

The IBirtViewerContext interface defines methods that retrieve information from
the HTTP session, as follows:

package com.actuate.birtviewer.extension;
public interface IBirtViewerContext {

// Gets the base URL for the viewer
String getAppBaseUrl( );

// Gets reportlet id/bookmark if user is working on a reportlet.
String getReportletId( );

// Gets the extended session object
IBirtViewerSession getSession( );

// Gets the current user name
String getUserName ( ) ;

// Gets the volume profile name
String getVolumeProfile( ) ;

// Gets teh resource folder name
String getVolumeResourceFolder( ) ;

}

The IBirtViewerOp interface defines methods that retrieve information from the
extended session for BIRT Viewer, as follows:

package com.actuate.birtviewer.extension;
public interface IBirtViewerOp {

// Gets column ids if target element is a table
String[] getColumnIIds( ) ;

// Gets the operation name
String getName( ) ;

// Gets the target element instance ids
String[] getTargetIIds( );

// Get target element type
String getTargetType( ) ;

}
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The IBirtViewerSession interface defines methods that retrieve and set a session
from the extended session for BIRT Viewer, as follows:

package com.actuate.birtviewer.extension;
public interface IBirtViewerSession

// Check whether key exists.
boolean containsKey( String key );

//Get attribute from session.
Object getAttribute( String key );

//Set attribute into session.
void setAttribute( String key, Object attribute );

}
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Actuate BIRT Viewer URIs

This chapter contains the following topics:

About the BIRT Viewer servlet

Information Console file manager URIs overview
Information Console file manager URIs quick reference
Common URI parameters

Information Console file manager URIs reference

Chapter 13, Actuate BIRT Viewer URIs 205



About the BIRT Viewer servlet

Java servlets extend web server functionality. The BIRT Viewer is a Java servlet
that manages binary content and performs tasks such as uploading and
downloading binary files.

You invoke the BIRT Viewer servlet using the following syntax:
http://<application servers:<ports/<context roots>/iv

where

m application server is the name of the machine hosting the application server.
m port is the port on which the application server listens for requests.

m context root is the Information Console context root.

m ivis the name to which the servlet is mapped in the web application’s web.xml
file. A typical location for web.xml is <context root>\WEB-INF\web.xml.

Servlet names are case sensitive. Do not modify the servlets, their names, or their
mapping in web.xml.

Using open-source BIRT URIs in Actuate BIRT Viewer

Actuate BIRT Viewer fully supports the URIs for the open-source BIRT Viewer.
After migrating from open-source BIRT to Actuate BIRT, you can use the same
URIs in the Actuate BIRT Viewer that you used in open-source BIRT.

Accessing the BIRT Viewer using a URI

The BIRT Viewer servlet displays a BIRT report and provides tools to affect the
document and design files. This servlet provides both the BIRT Viewer and the
BIRT Report Interactive Viewer. The Interactive Viewer is licensed separately
from the viewer.

The viewer displays the report with toolbar options to navigate the report and a
menu to perform additional tasks, as shown in Figure 13-1.

@ ACTUATE.
oI} /s & [ |

g Classic Models, Inc
2207 Bridgepointe Parkway

San Mateo, CA 94404 Customer Order HiStOI‘y

Australian Collectors, Co.
Contact: Peter Ferguson Sales Representative: Andy Fixter

Figure 13-1 The BIRT Viewer
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Name

URI
parameters

The Interactive Viewer displays the report with toolbar options to navigate the
report, a menu to perform additional tasks, and provides context menus to edit
and format report elements, as shown in Figure 13-2.

Y ACTUATE.
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e Classic Models, Inc 2] k]

aiz=d 2207 Bridgepointe Parkway T ——

foans Fal o N P —
WSS San Mateo, CA 94404 CUSLOITICT UTUcCI midLoly
Australian Collectors, Co.
Contact: Peter Ferguson Sales Representative: Andy Fixter

636 St Kilda Road
Level 3

Figure 13-2 The BIRT Interactive Viewer

The viewer servlet supports rptdocument file formats. For backwards
compatibility with previous releases, the viewer also supports the bizdocument
file format.

com.actuate.iv.servlet.lVServlet

Table 13-1 lists and describes the URI parameters for the Interactive Viewer
servlet.

Table 13-1 IV URI parameters

URI parameter Description

__bookmark Name of the element of a report to display instead of
the whole report file.

__floatingfooter Boolean value to add a margin under the footer.

__format A format for the displayed report:

m pdf: Adobe pdf

xls: Microsoft Excel

doc: Microsoft word

ppt: Microsoft powerpoint

ps: PostScript

html: HTML

flashchartsxml: used to display a fusion chart

flashgadgetsxml: used to display flash gadgets in a
fusion chart.

m reportlet: This is used together with __bookmark to
show a particular part/element of the report.

__from_page _range  The page range of a report to display.
(continues)
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Table 13-1 IV URI parameters (continued)

URI parameter Description

__from_page_style The page style to use for a report in pdf or ps formats.

m auto: The page size and content size remains the
same.

m actualSize: Change the page size to fit the content.

m fitToWholePage: Change the content size to fit the
page size.

Used with the __format parameter.

__imageid Identifier of the report file image to display.

__instanceid Identifier of the report file to display.

__launchiv A Boolean value that enables Interactivity.

__locale Code for a locale. For example FR_fr specifies the
French language and the country, France

__page The number of a page to render.

__report Name of the report file to display.

__rtl Boolean value that specifies right-to-left orientation for
the report.

repositoryType The name of the object to download.

serverURL The URL that accesses iServer, such as
http://ESL02835:8000

userid The user’s identifier, required to log in to the Actuate
iServer.

volume A string value specifying the Encyclopedia volume for

this report.

Information Console file manager URIs overview

The following sections describe the Java Component Information Console JSPs
that manage files and folders. For a repository managed with iServer, the
Information Console provides this functionality. For information about
Information Console URISs, see Information Console Developer Guide.

The following sections provide quick reference tables and detailed reference
information about Actuate Information Console URIs. An Actuate Information
Console URI is a directive to Actuate Information Console to perform an action,
such as showing a list of files, rather than change the appearance of the
application.
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Information Console pages use the .do extension for the Struts action mapping to
a page. The complete page name appears as part of the reference material.
Actuate Information Console page and folder names are case sensitive.

Information Console file manager URIs quick reference

Table 13-2 lists the Information Console file manager URIs.

Table 13-2 Actuate Information Console URI pages

Actuate Information
Console page

Description

about page
banner page
browse file page

delete file status page
detail page

drop page

error page

execute report page
getfiledetails page
getfolderitems page
home page

list page
page not found page

parameters page

Displays information about Actuate Information
Console.

Displays a banner at the top of each Information
Console file manager page.

Provides file and folder browsing functionality for
the submit request pages.

Displays whether a file was successfully deleted.

Supports error handling and presenting object
details.

Supports deleting files or cancelling running jobs.

Retrieves an error message from the exception or
the request and displays it.

Submits a run report job request to the server.
See file or folder detail page.
See index page.

Provides the link from the My Folder button to the
Information Console file manager home page.

Supports listing files and folders.

Displays an error message when a JSP is
unavailable in Information Console file manager.

Presents a list of the request parameters.
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Common URI parameters

All Actuate Information Console file manager URIs have the parameters shown
in Table 13-3. String values that are too long are truncated for all parameters. The
web browser that you use determines the length of parameters.

Table 13-3 Common URI parameters
URI parameter Description
locale The current user’s locale, such as U.S. English (en-US).

Information Console locale names have the form nn_CC.
nn is the language abbreviation and CC is the country

code.

serverURL Contains the URI that accesses the Actuate web
application, such as http:/ /Services:8000.

timezone The current user’s time zone.

volume The volume to which the user is connected.

_vp The name of a server configured in VolumeProfile.xml.

Information Console uses the volume information in a
VolumeProfile entry except when a volume parameter
specifies a different one.

Information Console file manager URIs reference

This section provides the detailed reference for Information Console file manager
URIs. In the definitions, <context root> represents the name of your Actuate
Information Console context root. Table 13-4 lists the topics in this section and the
pages discussed in each topic. All pages are under the Information Console
context root.

Table 13-4 Actuate Information Console pages

Page Information Console file

about page iportal\activePortal\ private\options\about.jsp
banner page iportal\activePortal\ private\common\banner.jsp
browse file page browsefile.do

iportal\activePortal\ private\query \browse.jsp

delete file status page iportal\activePortal\private\filesfolders
\deletefilestatus.jsp

detail page
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about page

Table 13-4 Actuate Information Console pages

Page Information Console file

m error detail page  iportal\activePortal\errors\detail.jsp
getfiledetails.do
m fileorfolderdetail iportal\activePortal\private\filesfolders\filedetail.jsp
page
drop page deletefile.do
error page errors\error.jsp
iportal\activePortal\ private\common\errors

\error.jsp

execute report page executereport.do

index page getfolderitems.do
iportal\activePortal\ private\filesfolders
\filefolderlist.jsp

list page getfolderitems.do
iportal\activePortal\ private\filesfolders
\filefolderlist.jsp

home page iportal\activePortal\ private \common
\breadcrumb.jsp

page not found page iportal\activePortal\errors\pagenotfound.jsp

parameters page iportal\activePortal\ private \newrequest
\parameters.jsp

viewer page for BIRT IVServlet

reports

about page

Name
Parameters
Used by

Displays the Help about page, containing information about Actuate Information
Console. Called when the user chooses the About tab on the Options page. The
default about page for Information Console is similar to Figure 13-3.

<context root>\iportal\activePortal\private\options\about.jsp
The about page uses the common URI parameters.

iportal\activePortal\ private\options\optionspage.jsp
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banner page

@ ACTUATE.

Log out About Help
=5102835 Options : About & BIRT Report Studio ﬁ My Folder
E|T='!| Documents m FreTes

E-= Home
| ®= administrato | Actuate iPortal version: 10
..r—‘ | Public Volume name: esl02835
JSP server: Apache Tomcat/5.5.26
User name: administrator
Current language: English (United States)
Current time zone; GMT-8:00 Pacific Standard Time
Copyright: ©1995-2008 Actuate Corporation
Figure 13-3 Information Console about page

banner page

Provides the banner that appears across the top of all Actuate Information
Console web pages. The default banner displays the Actuate logo, user name,
cluster name, and volume name, and provides links for Logout, Options, and
Help. The banner page obtains the user name, cluster name, and volume name
from variables maintained by the authenticate page.

Name <context root>\iportal\activePortal\private\common\banner.jsp

Used by iportal\activePortal\private\login.jsp
iportal\activePortal\ private\channels\channelnoticelist.jsp
iportal\activePortal\ private\channels\channeloperationstatus.jsp
iportal\activePortal\ private\filesfolders\ deletefilestatus.jsp
iportal\activePortal\ private \filesfolders\filedetail.jsp
iportal\activePortal\ private \filesfolders \filefolderlist.jsp
iportal\activePortal\ private \jobs\getjobdetails.jsp
iportal\activePortal\ private\jobs\joboperationstatus.jsp
iportal\activePortal\ private\jobs\selectjobs.jsp
iportal\activePortal\ private \newrequest\newrequest.jsp
iportal\activePortal\ private \newrequest\newrequest2.jsp
iportal\activePortal\ private \newrequest\submitjobstatus.jsp
iportal\activePortal\ private\options\options.jsp
iportal\activePortal\ private\query \create.jsp
iportal\activePortal\ private\query \execute.jsp

browse file page

Contains file and folder browsing functionality used by other submit request
pages.
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Name

Parameters

Used by

delete file status page

<context root>\browsefile.do

<context root>\iportal\activePortal\private\query\browse.jsp

workingFolder is the name of the folder for which to display contents in the
folder browser window. The browse file page also uses the common URI
parameters.

iportal\activePortal\ private \newrequest\browse.jsp
iportal\activePortal\ private\query \browse. jsp

delete file status page

Name
Used by

Summarizes the result of a deletion performed by the drop page and indicates
whether a file was successfully deleted. The delete file status page includes
authenticate to obtain user session data. Information Console performs the
deletion as part of an action and then forwards to the delete file status page.

<context root>\iportal\activePortal\private\filesfolders\deletefilestatus.jsp
Not applicable

detail page

Name
Used by

Displays detailed information about Repository objects. There are two detail
pages:
<context root>\iportal\activePortal\errors

<context root>\iportal\activePortal \filesfolders

error detail page
Provides a template error page that can be embedded in another page.
<context root>\iportal\activePortal\errors\detail.jsp

iportal\activePortal\ private \common \errors\error.jsp
iportal\activePortal\viewer \ print.jsp
iportal\activePortal\viewer\saveas.jsp
iportal\activePortal\viewer \searchframe.jsp
iportal\activePortal\viewer \viewdefault.jsp
iportal\activePortal\viewer \viewtoc.jsp
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drop page

Name

Parameters

Used by

file or folder detail page

Displays detailed information about the selected viewable folder or file. Users
request file details by choosing the magnifying glass icon to the right of files listed
on the folder page, or folder details by choosing the magnifying glass icon to the
right of the folder name in the breadcrumb. Users can request another viewable
document or delete the current file or folder from the file or folder detail page.
filedetail jsp uses the HTML code in <context root>\iportal\activePortal
\private\filesfolders\filedetailcontent.jsp to display the information.

<context root>\getfiledetails.do
<context root>\iportal\activePortal\private\filesfolders\filedetail.jsp

Table 13-5 describes the parameters for the file or folder detail page. The file or
folder detail page also uses the common URI parameters.

Table 13-5 File or folder detail URI parameters
URI parameter Description
name The full path name of the repository object for which

to show details. This parameter is ignored if objectID is
also specified.

objectID The repository object’s unique identifier.

version The repository object’s version number. The default is
the latest version.

Not applicable

drop page

Name

Parameters

Deletes the specified file or folder. The drop page includes the banner page to
obtain user session data.

<context root>\deletefile.do

Table 13-6 describes the parameters for the drop page. The drop page also uses
the common URI parameters.

Table 13-6 File or folder drop URI parameters

URI parameter Description

ID The unique identifier of the repository object to delete.
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Used by

error page

Table 13-6 File or folder drop URI parameters

URI parameter Description

name The full path name of the repository object to delete.
Multiple name parameters, to delete more than one file
or folder at a time, are allowed. This parameter is
ignored if ID is also specified.

redirect URI to which to redirect the job deletion page. The
default redirect page is processedaction_status.

Not applicable

error page

Name

Used by

Displays the specified error message. Information Console uses two pages. All
Information Console code uses <context root>\iportal\activePortal\private\
common\errors\error.jsp.

<context root>\iportal\activePortal\errors\error.jsp
<context root>\iportal\activePortal\private\common\errors\error.jsp

iportal\activePortal\ private\login.jsp
iportal\activePortal\ private \common \closewindow.jsp
iportal\activePortal\ private \common \sidebar.jsp
iportal\activePortal\ private \common\errors\errorpage.jsp
iportal\activePortal\ private\options\options.jsp
iportal\activePortal\private\query \create.jsp
iportal\activePortal\ private\query \execute.jsp
iportal\activePortal\ private \templates\ template.jsp
iportal\activePortal\viewer \closewindow.jsp
iportal\activePortal\viewer \ print.jsp
iportal\activePortal\viewer\saveas.jsp
iportal\activePortal\viewer\searchframe.jsp
iportal\activePortal\viewer \searchreport.jsp
iportal\activePortal\viewer\viewframeset.jsp

execute report page

Submits a run report job request.

When executing a report job or query, a Cancel button appears after a specified
wait time passes. You can change the time by setting the
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execute report page

EXECUTE_REPORT_WAIT_TIME configuration parameter in the appropriate
Actuate Information Console configuration file.

For reports that accept run-time parameters, you can set the parameter in the
URL by adding an ampersand (&), the parameter name, and an equal(=) sign,
followed by the parameter value in quotes.

Name <context root>\executereport.do

Parameters Table 13-7 describes the parameters for the execute report page. The execute
report page also uses the common URI parameters.

Table 13-7 Execute Report URI parameters
URI parameter Description
__ageDays Use with __ageHours to determine how long output

objects exist before they are automatically deleted. Use
only if __archivePolicy is set to Age. __ageDays can be
any positive number.

__ageHours Use with __ageDays to determine how long output
objects exist before they are automatically deleted. Use
only if __archivePolicy is set to Age. __ageHours can
be any positive number.

__executableName The name of the executable file for this request.

invokeSubmit Controls whether the browser is redirected to the
parameter screen or whether the report job is run
immediately. If True, the report job is executed without
displaying the parameters. If False, the parameters are
displayed. False is the default.

__outputDocName The name and path of the resulting BIRT document.
This parameter is only usable for BIRT Reports when
the BIRT_SAVE_REPORT_DOCUMENT_ENABLED
parameter is set to TRUE in web.xml.

If the given path is absolute, then executereport saves
the report to that path. If the given path is relative,
then executereport saves the report to the path set in
the BIRT_SAVE_REPORT_DOCUMENT_PATH
web.xml parameter.

__priority Specifies the job submission priority. Values are High,
Medium, and Low.

__priorityValue Specifies a number ranging from 1 to 1000 and
corresponding to the job submission priority. You can
only specify values allowed by your functionality
level.
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home page

Table 13-7 Execute Report URI parameters

URI parameter Description

__progressive Indicates whether to display the report document after
it generates. If False, the report document displays
after it generates. If True, the report document displays
progressively, as it generates.

__serverURL Contains the URI that accesses the JSP engine, such as
http:/ /Services:8900.
__wait If "wait", Information Console waits for the report

generation to be completed before displaying it. If
"nowait", Information Console displays the first page
right away even if the report job is not completed.

For example, the following URL executes the Sales By Territory.rptdesign report
immediately with the Territory run-time parameter set to EMEA:

http://localhost:8080/ActuateJavaComponent/executereport.do?
___requesttype=immediate& executableName=/Public
/BIRT%20and%20BIRT%20Report%20Studio%20Examples
/Sales%20by%20Territory.rptdesign&userid=anonymous&
__saveOutput=false&Territory=%22EMEA%22&invokeSubmit=True

The following parameter names are reserved for internal use only by the execute
report page:

m doframe

m inputfile

m jobType

m name

m selectTab
Used by Not applicable.

home page

Provides two sets of links. On the right side it provides a graphical and a text
shortcut link from the My Folder button to the current user’s Actuate Information
Console home folder. If the Information Console installation includes BIRT
Studio, there is another shortcut link, BIRT Studio, to the BIRT Studio. On the left
side, it provides the links and other text for the breadcrumb, or path from the
repository root to the current folder.
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index page

Users access their home page by choosing the My Folder link below the Actuate
Information Console page banner.

Figure 13-4 shows the default My Folder and breadcrumb links.

Breadcrumb links BIRT Report Studio link Home link
)
Log out ANwt Help
5 eslnza3s Al esinzes @ & BIRT Report Studio [ My Folder
-3 Documents Filter: on | OFF wiew: [Categories =]
| Folders |
S Home £ public 1 Resources

Figure 13-4 My Folder and breadcrumb links
Name <context root>\iportal\activePortal\private\common\breadcrumb.jsp
Used by iportal\activePortal\private\skins\tabbed\templates\mypagetemplate.jsp
iportal\activePortal\ private \skins\tabbed \ templates\ template.jsp

iportal\activePortal\ private\skins\classic\ templates \ template.jsp
iportal\activePortal\ private\skins\treeview \templates\ template.jsp

index page

Provides the entry point and structure for the parts of Actuate Information
Console generated from multiple files.

The index page is the default entry point to the Actuate Information Console web
application. The index page provides the entry point and structure to support the
Files and Folders functionality. The structure is a table that Actuate Information
Console uses to format and present files and folders data. Page content varies
depending on the Actuate Information Console directive.

The index page uses the banner page to provide the reporting web page banner.
filefolderlist.jsp uses the HTML code in <context root>\iportal\activePortal\
private \filesfolders\filefolderlistcontent.jsp to display files and folders data.

Name <context root>\getfolderitems.do
<context root>\iportal\activePortal\private\filesfolders\filefolderlist.jsp

Parameters Table 13-8 describes the parameters for files and folders index page. The files and
folders index page also uses the common URI parameters.
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list page

Table 13-8 File and folders index URI parameters
URI parameter Description
startUpMessage Specifies a message to appear when Actuate

Information Console calls this page.

subpage Specifies the content of the page. Possible values are:
m _list: include list
m _detail: include detail

Specifying any other value for subpage invokes the
page not found page.

list page

Name

Parameters

Lists files in a container, such as a folder.

The list page presents a list of files and folders that reside in the current working
repository folder. Users request folder listings by choosing links on the reporting
web page. The list page includes a filter section where users specify criteria for
viewing report documents.

When users access a repository for the first time, Actuate Information Console
displays their home folder, if they have one, or the top folder in the repository. All
files and folders in that folder that they have permission to view appear in the list
page. Users can specify a filter to choose the types of files to view.

<context root>\getfolderitems.do
<context root>\iportal\activePortal\private\filesfolders\filefolderlist.jsp

Table 13-9 describes the parameters for the list page. The list page also uses the
common URI parameters.

Table 13-9 File and folder list URI parameters

URI parameter Description
applyFilter If True, apply filter. If False, filter not applied.
filter The filter specifying the file and folder names to list.

"n

Filter is a string. The default is "".

folder The folder for which to list the contents. Folder name is
a string. If no folder is specified, List uses the last
working folder known for the session if cookies are
enabled. If cookies are not enabled, List uses the user’s
home folder as specified in the user settings.

(continues)
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page not found page

Table 13-9 File and folder list URI parameters (continued)
URI parameter Description
onlyLatest If True, show only the latest version of a file if multiple

versions exist. If False, show all versions of a file if
multiple versions exist. The default is False.

resetFilter Any non-null value for resetFilter causes the filter to
return to its original state. Users can reset the filter by
choosing the Default button on the listing page.

showDocument If True, show all viewable documents. If False, do not
show viewable documents. The default is True.

showExecutables If True, show all report executables. If False, do not
show report executables. The default is True.

showFolders If True, show all folders. If False, do not show folders.
The default is True.

Used by Not applicable.

page not found page

Displays an error message when Actuate Information Console cannot find the
page that a user specifies. This page is a Information Console page only.

Name <context root>\iportal\activePortal\errors\pagenotfound.jsp
Used by Not applicable.

parameters page

Displays report job parameters. Parameters include the headline, output file
name, and report executable file name. Users access the parameters list by
choosing Parameters.

Parameters looks like Figure 13-5.
Name <context root>\iportal\activePortal\private\newrequest\parameters.jsp

Used by iportal\activePortal\private\newrequest\newrequestpage.jsp
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parameters page

o L Help

Parameters

Customer Parameters

Credit Rank [ >l (String)
Customer Mame | _>| (String)
Purchase Frequency | _’l (String)
Purchase Wolume | >l (String)
Office Parameters

City [ [ {5tring)
g I ml (String)

Cancel Back | MNext Finish

Figure 13-5 Parameters page
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aggregate data (continued) flipping 119

filtering 156 formatting 120
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viewing cross tabs and 144 plotting 117
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extending functionality of 201
navigating through reports with 12
BIRT_ARCHIVE_ MEMORY_TOTALSIZE
parameter 198

BIRT_CHART_MAX_ROW parameter 198

BIRT_CHART_MAX_VARIABLE_SIZE
parameter 198

BIRT_DATA_RESULTSET_MAX_BUFFER _

SIZE parameter 198
BIRT_HTMLRENDEROPTION_
ENGCASSTYLE parameter 198

BIRT_JDBC_CONNECTION_POOL_ SIZE

parameter 198
BIRT_JDBC_CONNECTION_POOL _
TIMEOUT parameter 198
BIRT_MAX_MEMORY_SIZE_
PER_ARCHIVE parameter 198
BIRT_RESOURCE_PATH parameter 199
BIRT_SAVE_REPORT_DOCUMENT_
ENABLED parameter 199
BIRT_SAVE_REPORT_DOCUMENT_
FOLDER parameter 199
BIRT_SCRIPT_LIB_PATH parameter 199
BIRT_VIEWER_LOCALE parameter 199
black and white images 45
blank characters 182, 183
blank values 91
Boolean column format dialog 34
Boolean data type 34
Bottom N operator 92, 156, 189
Bottom Percent operator 92, 189
breadcrumbs 217
browse file page 209, 212
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See also charts
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bullet gadgets 131, 136
See also Flash gadgets

C

cache 198, 199, 200
CACHE_CONTROL parameter 199, 200

calculated columns. See computed columns

calculated data 41, 78, 160

CalculatedColumn feature 195
Calculation dialog box 79, 80
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CEILING function 165
Change Font command 196
Change Text command 38
changes, previewing 21, 25, 118
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column headers 21, 38

columns 7

data 20
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chart dimensions 115, 118
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Chart Property command 195

chart reports 102

Chart Subtype command 115, 195

Chart Subtype dialog 115, 132

chart subtypes 115, 132

chart titles 118

chart types 102
See also specific type

chart view 127

ChartProperty feature 195

charts
animating. See Flash charts
binding to rows 198
changing 48, 115
displaying data and 102,121, 150, 156
displaying small sets of values in 110
drilling through 122, 126
exporting 40, 45, 48, 127
exporting data in 127
filtering data for 116
formatting 116, 118, 120
interchanging axes values in 119
overlapping multiple series in 106, 108
previewing 118
rendering as images 53
resizing 118
scaling axes values in 121
setting font properties for 118, 119, 120
showing percentages in 104, 107, 109
showing relationships in 110
showing side-by-side series in 102
stacking series in 103, 106, 108
tracking stock data and 111

ChartSubType feature 195

closing table of contents 13

closing values (charts) 111

closing values (gadgets) 136

CMYK images 45

CollapseExpand feature 196

Color property 135, 137

colors 23,44,116, 145

column areas (cross tabs) 145

column headers 21, 38, 154
changing font properties for 21
editing 38
exporting 43
formatting text in 21, 154
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selecting 20
column headings 71
column headings (cross tabs) 144
column labels
See also column headers; field names
column names. See column headers
Column Width command 196
ColumnEdit feature 196
ColumnResize feature 196
columns
See also fields
accessing toolbar for 7
aggregating data and 66, 67, 68, 69, 70
changing font properties for 22, 23
changing order of 59, 155
comparing date values in 92
comparing string patterns in 93
copying formats for 37
creating computed. See computed columns
creating multiple formatting rules for 29
deleting 59, 60, 156
displaying data types in 29, 30
displaying hidden 60
editing 7
exporting specific 41
filtering empty or null values in 91
filtering merged 99
formatting data in 20, 21, 23, 155
getting distinct values in 70
getting number of values in 70
grouping data and 64, 65, 71
grouping on multiple 65
hiding 60, 155
merging 20
removing aggregate data from 69
removing conditional formats from 29
resizing 58, 59
restoring default formats for 37
selecting 20, 23
setting page breaks for 74, 201
setting text attributes for 25
sorting merged 62
sorting multiple 61
suppressing duplicate values in 71, 72,73
viewing cross tabs and 144
viewing summary tables and 152
comma-separated values files 40, 41, 42



comparison operators 26, 89, 95
comparisons 26, 27,90, 92, 93, 114
computed columns
See also calculated data; calculations
creating 78,79, 156
editing 80
exporting and 48
writing expressions for 80-82, 160, 187
concatenation 80, 188
conditional formatting 23-29, 188
Conditional Formatting command 24, 196
Conditional Formatting dialog 24, 25, 26, 29
ConditionalFormat feature 196
conditions
comparing data and 25, 26, 27, 95, 171
filtering data and See filter conditions
formatting data and. See conditional
formatting
cone charts 104
See also charts
configuration files 194, 197
configuration parameters 197
configurations
mapping servlets to 206
connection pool 198
connection timeout intervals 198
context menus 7, 128, 194
cookies 210
Copy Format command 37
Copy Format dialog 37
Copy Style command 23
Copy Style dialog box 23
copying
alignment properties 23
font properties 23
formats 37
hyperlinks 14
COUNT function 70, 185
Count Value function 70
COUNTDISTINCT function 185
creating
computed columns 78,79, 156
expressions 80-82
filter conditions 89, 94
filters 88-89, 95
formatting rules 24, 25, 28
hyperlinks 14

summary tables 152

criteria. See conditions

cross tabs
aligning data in 147
changing font properties for 146
customizing charts in 150
displaying data and 144
displaying tooltips for 147, 148
exporting and 40, 45, 49, 149
formatting data in 145, 146
printing 150
restoring default formats for 147
saving 150
selecting elements in 146
setting page breaks for 201
viewing 145

CSV files 40, 41, 42

cubes 144

Currency format 31

currency values 145

current date and time 177, 182

customizing
charts 115, 116, 150, 156
date-and-time formats 33
Flash charts 133
Flash gadgets 133
Flash Player 141
numeric formats 31
reports 6
string formats 36
summary tables 152, 153, 154

cylinder gauge gadgets 130, 138
See also Flash gadgets

D

dashboards 4, 110, 131, 132
data
See also values
aggregating 66-??,70, 153
analyzing 40, 63
changing 20
comparing 27, 93
controlling access to 13

creating animated representations of 102

displaying 58, 60, 78, 102
exporting 40-43, 127, 139, 149

Index
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data (continued)
filtering 86, 99, 115, 139, 156
formatting 20, 23, 30, 145, 154
grouping 62-65, 152
hiding 70,71, 152
organizing 58, 60, 62, 155
previewing changes to 21, 25
restoring default formats for 37, 147
restoring original order of 62
retrieving 13, 86
showing differences in 114
sorting 60-62, 155

Data Analyzer 144

Data Analyzer command 149

data buffer 198

data cubes 144

data fields. See fields

data filters
adding conditions to. See filter conditions
applying to charts 116, 139
comparing date values and 92
comparing string values and 91, 93
creating 88-89, 95
removing 98
retrieving specific values and 90-92, 96
setting at runtime 86
setting on Flash objects 139
setting on merged columns 99
setting on summary tables 156
testing 89, 94

data formats. See formats

data groups. See groups

data points 102, 113, 117
See also charts

data range. See range of values

data rows. See rows

data series
See also charts
displaying multiple 111
drilling through 122, 124
overlapping multiple 106, 108
plotting data and 102, 117
showing open and close values 112
showing relationship to whole 110
showing side-by-side comparisons of 102
stacking multiple 103, 106, 108

data sets 136, 198
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data sources 4, 126, 152

data type export options 42

data types 30,70

Date column format dialog 32

date formats 199

date values
adding days to 81, 160
adding months to 162
adding quarters to 162
adding time values to 161, 163
adding weeks to 163
adding years to 163
aggregating 70
as literals 81
calculating days between 166
calculating months between 167
calculating quarters between 168
calculating time values between 166, 167,

169

calculating weeks between 169
calculating years between 170
comparing 26, 92
exporting 42
formatting 32-34
grouping 64
plotting 117, 121
restoring default formats for 37
returning current 177, 182
returning month for 176
returning quarter in 177
returning weekdays for 165, 184
returning weeks for 184
returning year for 185
showing changes over time 102
subtracting 82

date-and-time format symbols 33

date-and-time formats 32, 33

day formats 184

DAY function 165

days
adding to date values 81, 160
calculating number of 166
returning number in month 165
returning specific 184

debugging 141

default banner 212

default folders 15, 16



default locale 200
default security roles 194
default time zone 200
DEFAULT_COLUMN_PAGE_BREAK_
INTERVAL parameter 201
DEFAULT_LOCALE parameter 200
DEFAULT_PAGE_BREAK_INTERVAL
parameter 201
DEFAULT_ROW_PAGE_BREAK _
INTERVAL parameter 201
DEFAULT_TIMEZONE parameter 200
DEFAULT_WORKGROUP_
FUNCTIONALITY_ROLE parameter 194,
200
Delete Column command 196
delete file status page 209, 213
Delete Group command 196
deleting
aggregate data 69
blank characters 182, 183
columns 59, 60, 156
files 213,214
filter conditions 98
folders 214
formatting conditions 29
page breaks 74,75
text 38
delimiter characters 40
Design Engine API 201
design files 15, 86
designs 15,199
detail areas (cross tabs) 145
detail data 71, 152
detail pages 209, 213
developers 127
deviation 114
DIFF_DAY function 80, 82, 166
DIFF_HOUR function 166
DIFF_MINUTE function 167
DIFF_MONTH function 167
DIFF_QUARTER function 168
DIFF_SECOND function 169
DIFF_WEEK function 169
DIFF_YEAR function 170
difference charts 114
See also charts

dimension columns 152, 156

See also summary tables
dimensions 144, 145

See also cross tabs
directories 15
directory paths. See file paths
Disable Interactivity command 7
displaying

AFP output 47

aggregate data 66,71, 144, 152

banners 212

calculated values 78, 160

charts 127

columns 60

cross tabs 144, 145

data 58, 60, 78, 102

detail data only 71

distinct values 201

duplicate values 71,72,73

error messages 215

Excel output 48

filter conditions 95

hidden values 72

legends 119

numeric values 29

PDF output 51

redraw regions 141

report elements 70

report parameters 220

reports 4,12

specific content 14, 86

specific page 12, 14

specific section 12

summary tables 152

table of contents 13, 63, 197

tables 127

tooltips 147, 148

XHTML documents 56
distinct values 70, 185, 201
do directive 209
Do Not Repeat Values command 72, 197
.doc formats. See Word document formats
.docx formats. See Word document formats
document files 15,214, 220
documentation ix
documents 4, 16

See also reports
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doughnut charts 128

See also Flash charts
downloading

binary files 206
DPI setting (charts) 44, 49
drilling actions

charts 122,124, 126

cross tabs 144

Flash objects 139
drop pages 209, 214
Duplex value 44
duplicate values

counting 70

hiding 71,72,73

summary tables and 153
dynamic data filters 86

E

Edit Computed Column command 80, 195
edit text icon 197
editable report items 38
editing. See changing
EditReport feature 196
e-mail 14
embedded fonts 53
emitters 40
empty values 91
Enable Interactivity command 6, 196, 200
Enable Pivot table option 49
Encoding Style option 41
Encyclopedia volumes 210
See also repositories
End Value property 137
Equal to operator 90, 189
error detail page 213
error messages 215, 220
error page 209, 215
errors 82,141,195
Excel emitters 40, 48
Excel formats
exporting charts and 127
exporting report content and 40, 43, 54
Excel spreadsheets 48, 200
exception stack trace 195
executable files 220
executableName parameter 216
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execute report page 209, 215
executing

Java servlets 206

Export Column Data Type option 42
Export Column Header option 43
Export Content command 45, 140, 196
Export Content dialog

exporting to AFP formats 44, 45
exporting to Excel 50

exporting to PDF 52

exporting to Postscript 53
exporting to PowerPoint 55
exporting to Word 54

exporting to XHTML 56

Export Data command 127, 139, 196

Export Data dialog 41

Export Locale Neutral Format option 43

EXPORT_AS_ATTACHMENT
parameter 200

ExportData feature 196

exporting

charts 45,127

data 40-43,127,139, 149
Flash objects 51, 139

report content 40, 43-56, 197
specific report pages 44, 48

ExportReport feature 196
expressions

adding literal values to 81

adding reserved characters to 82
aggregating data and 67, 70
calculating data values and 78, 79, 80, 160
changing 80

exporting data and 48

filtering data and 88, 94, 95, 188
formatting data and 25, 26, 27, 34, 188
returning unexpected values from 30
verifying data types in 30

verifying syntax of 79

extensible HTML formats 44, 56, 127
external data sources 126

F

feature controls 194
Feature tag 195
FeatureConfiguration tag 195



FeatureControl tag 195
features 194, 195
field names 78, 82
fields
See also columns
building cross tabs and 144
creating expressions and 78, 82
displaying specific set of 86, 87
sorting data and 60, 61
testing for null values in 173
file cache 198
file names 15, 16
file or folder detail page 214
file paths 199, 201
files
accessing 219
archiving 198
changing location of 15, 16
deleting 213, 214
exporting and 40, 42,43
filtering 219
getting information about 214
naming 15, 17
saving cross tabs and 150
saving reports and 15
saving temporary 199
Filter command 196
filter conditions
adding 88
changing 98
deleting 98
displaying 95
grouping 96, 97
selecting multiple values for 90, 94, 95, 96
setting evaluation order for 97
Filter dialog box 89, 90, 98
filter expressions 188
Filter feature 196
filter parameter 219
filtering
data 86,99, 115, 139, 156
report documents 219
report files 219
filters
adding conditions to. See filter conditions
applying to charts 116, 139
comparing date values and 92

comparing string values and 91, 93
creating 88-89, 95
removing 98
retrieving distinct values and 201
retrieving specific values and 90-92, 96
setting at runtime 86
setting on Flash objects 139
setting on merged columns 99
setting on summary tables 156
testing 89, 94
financial data 114
FIND function 170
Firefox browser 200
See also web browsers
FIRST function 186
Fixed format 31
Flash chart types 139
Flash charts
changing subtype of 132
debugging 141
displaying data and 102, 128
drilling through 139
exporting and 48, 51, 139
filtering data for 139
formatting 133
printing 51, 140
redrawing 140
setting visual effects for 140
Flash Gadget Type dialog 132
Flash gadget types 129
Flash gadgets
adding titles to 135
changing subtypes of 132
debugging 141
displaying data and 102, 128
exporting and 51, 139
filtering data for 139
formatting 133, 138
hiding values in 136
printing 51, 140
redrawing 140
setting color of 135
setting properties for 135-138
showing regions in 137
showing tick marks in 136, 138
Flash objects. See Flash charts; Flash gadgets
Flash Player 140, 141
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flat file formats 40

Flip Axis option 119

folder detail page 214

folder names 209

folder parameter 219

folders
accessing 219
browsing contents 212
changing default 15, 16
creating temporary files and 199, 201
deleting 214
getting information about 214
linking to 217

font attributes 21

Font command 21, 146

Font dialog 21, 146

font properties 21, 23, 146

Font property 135

font size 17,116

font substitution 52

fonts 116, 154

footers 17, 67, 68

Format Chart dialog 118, 119

Format command 196

Format Data command 30

Format feature 196

Format Flash Gadget command 138

format patterns 31, 33, 36

formats
copying 37
creating multiple rules for 29
defining custom 31, 33, 36
exporting charts and 127
exporting data and 40, 43, 127
printing reports and 17
removing conditions on 29
restoring default 37, 147
selecting standard 31, 32, 35
setting conditions for 23-29
setting locale for 199

formatting
aggregate data 155
Boolean values 34
charts 116, 118, 120
cross tabs 145
data 20, 23, 30, 145, 154

232 Working with Actuate BIRT Viewers

Flash charts 133

Flash gadgets 133, 138

text 20, 21, 35-36, 154
formatting options 24, 135, 146
formatting rules 24, 25, 28, 29
formulas. See expressions
forward button (web browser) 199
functionality roles 200
functions 70, 79, 160

G

gadgets. See Flash gadgets

gauges 110,129, 130

General Date format 33

general formatting properties (gadgets) 135

General Number format 31

generating reports 201

graphs. See charts; Flash charts

grayscale images 45

Greater Than operator 90, 189

Greater Than or Equal to operator 189

Group Details dialog 64

group footers 67, 68

group headers 67, 68,71,73

group labels 38

GroupEdit feature 196

grouping
data 62-65, 152
filter conditions 96, 97

grouping intervals 64

groups
aggregating data and 66, 67, 68
changing order of 65
collapsing and expanding 71
displaying data and 58, 62, 63, 152
formatting cross tabs and 146
hiding detail data in 70, 71, 152
hiding duplicate values in 71, 73
selecting multiple columns and 65
setting page breaks for 74
sorting summary data in 155

H

Header command 38
headers
See also column headers



displaying aggregate data in 67, 68
printing reports and 17
suppressing duplicate values and 71,73
headings. See column headings; row headings
Height property 135
help menu 197
Hide Column command 60, 155, 196
Hide Detail command 71, 196
Hide Detail Tooltip command 148
Hide or Show Items dialog 70
Hide/Show Item command 196
HideShowltems feature 196
hiding
chart items 119, 121
detail data 70, 71, 152
duplicate values 71,72,73
gadget region labels 137
gadget tick marks 138
gadget values 136
items in reports 60, 70
summary data 155
toolbars 197
high values (candlesticks) 111
Highlight feature 196
home folders 217
home page 209, 217
hours
adding to date values 161
calculating number of 166
HoverHighlight feature 196
HTML formats
exporting charts and 127
exporting reports and 17, 44, 51, 56
rendering to 198
hyperlinks 14,126

IBirtViewerContext interface 203
IBirtViewerExtension interface 202
IBirtViewerOp interface 203
IBirtViewerSession interface 204
ID parameter 214

idle connections 198

IF function 81,171

image cache 200

image resolution 53

images 18,45

IN function 172

In operator 189

index pages 218

Information Console
viewing reports and 198

input 13, 86

interactive features 4,7

Interactive Viewer 207
changing parameters and 87
changing reports and 7, 20
customizing charts and 102, 115, 150, 156
customizing Flash objects and 128
displaying cross tabs and 144, 145, 150
displaying reports and 4, 6, 58, 197
displaying summary tables and 152, 153,

154, 155

exporting data and 40, 43
filtering data and 86
formatting data and 31, 32, 35, 37
grouping data and 63
navigating through reports with 12
printing reports and 17
saving reports and 15, 199
setting gadget values and 137
tracking data and 78

Interactive Viewer licenses 6

Interactive Viewer servlet
See also Interactive Viewer

Internet Explorer 200
See also web browsers

invokeSubmit parameter 216

Is False operator 189

Is Not Null operator 91, 189

Is Null operator 91, 189

Is True operator 189

ISNULL function 173

iv_config.xml 194, 195

IV_ENABLE_IV parameter 200

J

Jakarta Struts action mapping 209
JAR files 199

Java programming interfaces 201
Java Report Engine 200

Java servlets 206
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JAVA_REPORT_API_IMAGE_CACHE_ Link To This Page dialog 14

EXPIRATION parameter 200 linking to folders 217
JavaServer Pages. See JSPs linking to reports 12, 14
JDBC connection pool 198 links 212,217
jobs 220 See also hyperlinks

JREM_TASK_QUEUE_SIZE parameter 200 LinkToThisPage feature 196
JREM_THREAD_POOL_SIZE parameter 200 list pages 209, 219

JREM_THREADPOOL_MAXSYNC_ lists 172,220
TASKRUNTIME parameter 201 literal characters 93
JREM_THREADPOOL_MONITORTHREAD literal values 26, 81
_ POLLINGINTERVAL parameter 201 locale parameter 210
JREM_THREADPOOL_SYNC_TASKQUEUE  locales
_ TIMEOUT parameter 201 creating computed columns and 81
JSPs exporting data and 42
mapping actions to 209 filtering data and 92
naming 209 formatting data and 31, 33, 199
setting default 200
L specifying current 210
Label property 137 logical operators 96

labels Long Date format 33
changing chart axes 120, 121 Long Time format 33

changing text in 38 low values (candlesticks) 111

deleting text in 38 LOWER function 175

formatting chart 116, 120 lowercase characters 35, 36, 175

formatting text in 21, 154 Lowercase format 35

hiding chart 121 M
selecting 20
LAST function 186 MainMenu feature 196
leading characters 182, 183 matching character patterns 93, 174, 181
LEFT function 173 mathematical operations 78, 80, 187
legend titles 119 MAX function 70, 186
legends 118, 119, 122 Maximum Value property 137
LEN function 174 maximum values (charts) 121
Less Than operator 90, 189 maximum values (gadgets) 136
Less Than or Equal to operator 189 measure columns 152, 155
libraries 199 See also summary tables
licenses 6 measures 144, 145
LIKE function 174 See also cross tabs
Like operator 189 MEDIAN function 186
line chart subtypes 108, 109 Medium Date format 33
line charts 107 Medium Time format 33
See also charts memory 198
linear gauge gadgets 129, 134 menus 7, 128, 194
See also Flash gadgets merging columns 20
Link To This Page button 14 meter chart subtypes 111

Link To This Page command 14, 196
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meter charts 110, 117 Not Like operator 91, 190

See also charts Not operator 96
meter gadgets 129 NOTNULL function 177
See also Flash gadgets NOW function 177
MIN function 70, 186 null values 91, 173
Minimum Value property 137 Number column format dialog 31
minimum values (charts) 121 number data types 30
minimum values (gadgets) 136 number formats 29, 30, 31, 199
minutes NUMBER_OF_FILTER_VALUES
adding to date values 161 parameter 201
calculating number of 167 numeric values
MOD function 175 aggregating 70, 185
MODE function 186 as literals 81
month formats 176 averaging 185
MONTH function 176 calculating square root of 181
months combining 113
adding to date values 162 displaying 29
calculating number of 167 filtering 91
returning 176 formatting 30-32, 145
Move To Group command 196 grouping 64
Move to Group Header command 73 plotting 117, 121
Move to Group Header dialog 73 restoring default formats for 37, 147
multiple sort actions 61 returning absolute 160
My Folder link 218 rounding 165, 178, 179, 180
showing percentage to whole 104, 107, 109
N showing relationship between 102
name parameter 214, 215 showing totals for 103, 106, 108
naming o
computed columns 79
JSPs 209 objectID parameter 214
report files 15,17 online documentation ix
naming restrictions 209 online help. See online documentation
naming restrictions. See case sensitivity onlyLatest parameter 220
navigating tumbled documents 44 opening
navigation options 12,13, 14 applications 200
needle properties (gadgets) 136 BIRT Viewer 5
needles (gadgets) 136 Data Analyzer 149
networks 201 Interactive Viewer 6
New Computed Column command 79, 195 reports 15
No Condition operator 86 table of contents 13
NO-CACHE value 199 opening values (charts) 111
non-null values 177 opening values (gadgets) 136
NO-STORE value 199 operations. See actions
Not Between operator 91, 189 operators
Not Equal To operator 91, 189 comparing data and 26
Not In operator 189 filtering data and 86, 95, 96
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operators (continued)

listed 187,188

setting parameter values and 88
OR operator 96, 188
orientation (gadgets) 135
Orientation property 135
output formats

exporting charts and 127

exporting reports and 40, 43

printing reports and 17
outputDocName parameter 216
overlay chart subtypes 106, 108
overwriting reports 15,17

P

Page Break command 74, 196
Page Break dialog 74
page breaks 58, 74, 201
page footers 17
page headers 17
page names 209
page navigation 12
page navigation icons 196
page not found messages 219, 220
page not found page 209, 220
Page range option 44
page ranges 18, 44
PageBreak feature 196
PageNavigation feature 196
pagination 17, 58
See also page breaks
Parameter command 196
Parameter feature 196
parameters
adding to URIs 210
changing values for 87

configuring report viewers and 197

displaying 220
executing reports and 217
prompting for 198
retrieving data and 13, 86
setting values for 86, 88
Parameters command 13, 87, 88
Parameters dialog box 87, 88
parameters list 220
parameters page 198, 209, 220
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paths 199, 201
home folders 217
pattern matching 93, 174, 181
PDF emitters 40, 51
PDF formats
exporting and 43, 51, 127
printing reports and 17
PDF print options 17
PDF viewer plug-in 18
percent (%) character 93
Percent format 31

percent stacked chart subtypes 104, 107, 109,

115
percentages 80, 188
performance 44, 152, 198
pie charts 110,117, 128

See also charts

pipe-separated values files 40, 42
Plex Mode option 44
plot properties (gadgets) 136
Position Above property 138
Position Below property 138
Position Left property 138
Position property 138
Postscript emitters 53
Postscript formats 43, 53, 127
Powerpoint documents 200
PowerPoint formats 44, 55, 127

predefined formats. See standard formats

previewing

AFP output 45

charts 118

data 21,25

reports 18
Print command 17, 196
Print dialog box 17
Print feature 196
printing

cross tabs 150

Flash objects 51, 140

reports 17-18, 44,197

specific range of pages 18
priority parameter 216
priority Value parameter 216
PRIVATE value 199
programmers 127
progressive parameter 217



prompting for values 86
prompts 13, 86
properties
copying 23
exporting data and 40
formatting data and 21, 146
printing reports and 17
proxy servers 199, 201
PROXY_BASEURL parameter 201
ps formats. See Postscript formats
PSV files 40, 42
PUBLIC value 199
pyramid charts 104
See also charts

Q

QUARTER function 177
quarters 162,168, 177
QUARTILE function 186
question mark (?) character 181
queue 200

R

range of values 129, 130, 136, 164
redirect parameter 215
redraw regions (Flash objects) 140
region labels 137
region properties (gadgets) 137
Region property 137
regions (gadgets) 137
removing. See deleting
renaming files 15, 17
rendering

charts 53

images 45

reports 198
Reorder Columns command 59, 65, 196
ReorderColumns feature 196
Repeat Values command 72, 197
repeated values. See duplicate values
__report parameter 207
report components. See report elements
report design files 15, 86
report designs 15, 199
report document files 15, 214, 220

report documents 4, 16
See also reports
report elements 4, 20, 40, 70
report emitters 40
report engine 200
report executable files 220
report files
See also specific type
accessing 219
archiving 198
changing location of 15, 16
deleting 213,214
exporting and 40, 42, 43
filtering 219
getting information about 214
naming 15,17
saving cross tabs and 150
saving reports and 15
saving temporary 199
report parameters 13, 86, 220
See also parameters
report viewers 4, 8
See also BIRT Viewer; Interactive Viewer
reporting tasks 8,15
reports
adding data to 78
aggregating data and 66
changing 15, 20
customizing 6
displaying 4, 12
exporting 40, 43-56, 197
filtering 219
filtering data and 89
generating 201
grouping data and 62, 63, 65, 71
hiding data in 70, 71, 152
hiding items in 60, 70
limiting data in 86
linking to 12, 14
navigating through 12, 13, 14
opening 15
overwriting 15,17
previewing 18
printing 17-18, 44, 197
rendering 198
running 87, 215
saving 15

Index 237



reports (continued)
setting page breaks for 58, 74, 201
submitting requests for 215
viewing restrictions for 199
viewing structure of 12
viewing summary data and 152
repositories
accessing items in 219
getting information about 213
REPOSITORY_CACHE_TIMEOUT_SEC
parameter 201
repositoryType parameter
IV servlet 208
requests 200
submitting 215
reserved characters 82
reserved parameters 217
resetFilter parameter 220
resizing
charts 118
columns 58, 59
resources 199
result sets 198
return values 30, 80
RGB images 45
RIGHT function 178
right-click menus. See context menus
roles 194
rotating axis labels 120, 121
ROUND function 178
ROUNDDOWN function 179
rounding 165,178, 179, 180
ROUNDUP function 180
row areas (cross tabs) 145
row headings 144
rows
aggregating data and 66, 67, 68
binding to charts 198
counting 185
displaying specific set of 86, 89, 90, 95
exporting specific 41
filtering empty or null values in 91
formatting merged columns in 21
grouping data and 62
hiding duplicate values in 71,72,73
returning first value in 186
returning last value in 186
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returning most frequent value in 186
setting page breaks for 74, 201
showing quartile value for 186
viewing cross tabs and 144
rptdesign files. See report design files
rptdocument files. See report document files
rules. See formatting rules
running
Flash objects 141
Java servlets 206
reports 87,215
run-time data filters 86

S

Save Design command 15, 197
Save dialog box 15, 16
Save Document command 16, 197
SaveDesign feature 197
SaveDocument feature 197
saving

cross tabs 150

report designs 15

report documents 16

reports 15

summary tables 157

temporary files 199
scalable vector graphics 53
scale properties (gadgets) 136
Scale to page size option 18
scaling axes values 121
scatter charts 113

See also charts
scientific data 111, 113
Scientific format 31
script libraries 199
ScrollControl feature 197
scrolling 51, 52, 197
SEARCH function 181
searching text strings 170, 181
seconds

adding to date values 163

calculating number of 169
security 200
security roles 194
Select Data Item dialog 20, 62, 69, 99
semicolon-separated values files 40, 42



series. See data series
Server Print command 197
ServerPrint feature 197
servers 152,199, 201
extending functionality of 206
serverURL parameter 210,217
IV servlet 208
servlets 206
Short Date format 33
Short Time format 33
Show Close Value property 136
Show Column command 60, 155
Show Columns command 196
Show Detail command 71, 196
Show Detail Tooltip command 147
Show High and Low Values property 136
Show Labels property 137
Show Legend option 119
Show Open Value property 136
Show Plot value property 136
Show Tick Marks property 138
Show Tick Values property 138
Show Value property 138
Show values property 136, 137
showDocument parameter 220
showExecutables parameter 220
showFolders parameter 220
side-by-side chart subtypes 102
Simplex value 44
single color images 45
skipping axis labels 121
Sort Ascending command 197
Sort Descending command 197
Sort feature 197
sort order 60, 61, 67
sorting data 60-62, 155
sparkline gadgets 131, 136
See also Flash gadgets
special characters. See characters
spreadsheets 48, 200
See also Excel formats
SQRT function 181
square root 181
SSV files 40, 42
stack trace 195
stacked chart subtypes 103, 106, 108, 115
staggering axis labels 120, 121

standard deviation 186
standard formats
date-and-time values 32
numeric values and 31
string data and 35
standard meter chart subtype 111
starting
BIRT Viewer 5
Interactive Viewer 6
startUpMessage parameter 219
static text 38
See also labels
statistical data 113
STDDEV function 186
step values (charts) 122
stock chart subtypes 112
stock charts 111
See also charts
String column format dialog 35
string data types 29
string format symbols 36
string formats 35, 36
string patterns 93, 174, 181
string values 210
strings
aggregating data and 70
comparing substrings in 91, 93, 174
concatenating 80, 188
converting to lowercase 36, 175
converting to uppercase 36, 183
counting characters in 174
finding substrings in 170, 181
formatting data and 20, 35
grouping data and 64
removing blank characters in 182, 183
returning length of 174
returning substrings in 173, 178
Struts action mapping 209
subpage parameter 219
substrings
comparing 91, 93, 174
extracting 173, 178
finding location of 170, 181
subtotals 153
SUM function 70, 186
summary data 66,102, 144, 152
See also aggregate data
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summary reports 71,152
summary tables
adding computed columns to 156
changing 153
creating 152
customizing charts in 156
displaying data and 152
filtering data in 156
formatting data in 154
hiding columns in 155
moving columns in 155
organizing data in 155
saving 157
viewing data in 152
superimposed meter chart subtype 111
SuppressDuplicate feature 197
SVG images 53
Switch View command 127, 197
SwitchView feature 197
syntax errors 82

T

table of contents 12, 63, 197
table view 127
tables
See also summary tables
aggregating data and 66, 67, 68, 70
changing columns in 7
changing font properties for 22
displaying 127
exporting 40, 48
formatting data in 20, 21
hiding columns in 60
moving columns in 59
removing aggregate data from 69
resizing columns in 58, 59
selecting columns in 20, 23
selecting report elements in 20
tab-separated values files 40, 42
TEMP_FOLDER_LOCATION parameter 201
temperature changes 111
template error pages 213
temporary files 199, 201
text
aligning 22, 23, 147, 154
changing 38
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deleting 38
displaying as graphics charts 131
filtering 91, 93
formatting 20, 21, 35-36, 154
hiding 73
plotting 117
restoring alignment for 37, 147
restoring default formats for 37
setting font properties for 21, 146
text attributes 21, 25
text files 40, 42
text strings. See strings
Text wrapping option 51, 52
TextEdit feature 197
thermometer gadgets 130, 138
See also Flash gadgets
thread pool 200
3-D charts 115
tick marks (gadgets) 136, 138
tick properties (gadgets) 138
Tickmarks count property 138
time formats. See date-and-time formats
time values
adding to date values 161, 163
aggregating 70
calculating number of 166, 167, 169
exporting 42
formatting 32-34
grouping 64
restoring default formats for 37
returning current 177, 182
time zones 200, 210
timezone parameter 210
Title property 135
TOC command 13, 197
Toc feature 197
TODAY function 182
Toolbar feature 197
ToolbarHelp feature 197
toolbars 7,12, 194
Tooltip property 135
tooltips 135, 147
Top N operator 92, 156, 190
Top Percent operator 92, 190
Top/Bottom N command 91
Top/Bottom N dialog 91
Top/BottomN command 197



TopBottomNFilter feature 197
totals

See also summary data
trace 195
trailing characters 182, 183
transient files 199, 201
trends 113, 149
TRIM function 182
TRIMLEFT function 183
TRIMRIGHT function 183
truncated strings 210
TSV files 40, 42
tube charts 104

See also charts
Tumble value 44
types. See data types

U

underscore (_) character 93

Unformatted format option 37, 147

unique values 185
See also distinct values
UNSET value 200
unshared cache 199
uploading binary files 206
UPPER function 183
uppercase characters 35, 36, 183
Uppercase format 35
URIs
adding parameters to 210
overview 208, 209
URIs reference 210
URLs 12, 14
user IDs 208
user roles 194, 200
userid parameter 208
users 4
accessing home page 218

calculating 66, 70, 78, 152

changing parameter 87

combining 113

comparing 26, 90, 92, 114

counting 70, 185

determining deviation in 114
determining standard deviation for 186
determining variance in 187
determining weighted average for 187
displaying highest or lowest 136, 137
displaying open or close 136
displaying range of 129, 130
displaying set of independent 128
displaying single 128

displaying top or bottom 91

excluding sets of 90, 96

filtering empty or blank 91

formatting Boolean 34

formatting on 24, 25, 26, 29

grouping data and 63

hiding duplicate 71,72,73

prompting for 13, 86

returning from expressions 30, 80
returning largest 186

returning median 186

returning most frequent 186

returning smallest 186

selecting 88, 90

setting at runtime 86

showing changes over time 102, 105, 107
showing range of 136

showing relationship between 102, 149
showing relationship to whole 110
showing trends in 113, 149

testing for non-null 177

testing if null 173

testing range of 164

viewing numeric 29

variables 198
V VARIANCE function 187
vector graphics 53

value axis. See y-axis version parameter 214

value properties (gadgets) 138 Viewer 206

value series 102,117 viewers 4, 8

values See also BIRT Viewer; Interactive Viewer
See also data viewing
averaging 185 AFP output 47
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viewing (continued)

aggregate data 66, 71, 144, 152

banners 212

calculated values 78, 160

charts 127

columns 60

cross tabs 144, 145

data 58, 60,78, 102

detail data only 71

distinct values 201

duplicate values 71,72,73

error messages 215

Excel output 48

filter conditions 95

hidden values 72

legends 119

numeric values 29

PDF output 51

redraw regions 141

report elements 70

report parameters 220

reports 4,12

specific content 14, 86

specific page 12, 14

specific section 12

summary tables 152

table of contents 13, 63, 197

tables 127

tooltips 147, 148

XHTML documents 56
viewing environments 4
viewing parameters. See parameters
viewing restrictions 199
views, switching between 127
visual elements 128

See also Flash charts; Flash gadgets

volume parameter 210
IV servlet 208
VolumeProfile parameter 210

W

wait parameter 217

web browsers
displaying reports and 14, 199
issuing URIs and 210
opening applications and 200
printing reports and 17, 18
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rendering reports and 198
setting cache for 199
web pages
creating banners for 212
web sites 14
web.xml 197
WEEK function 184
weekday formats 184
WEEKDAY function 184
weekdays
adding to date values 81, 160
calculating number of 166
returning number in month 165
returning specific 184
weeks
adding to date values 163
calculating number of 169
returning 184
WEIGHTEDAVE function 187
Width property 135
Word document formats
exporting charts and 127
exporting reports and 44, 54
Word documents 200
workingFolder parameter 213

X

x-axis 117,121

See also axes values
x-axis labels 120, 121
x-axis titles 120
XHTML emitters 56
XHTML formats 44, 56, 127
xls formats 43
xlsx formats 43

Y

y-axis 117,121
See also axes values

y-axis labels 121

y-axis titles 120

YEAR function 185

years
adding to date values 163
calculating number of 170
returning 185
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